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SQL Diagnostic Manager for SQL Server

24x7 SQL performance monitoring, alerting, and diagnostics

« Performance monitoring for physical, virtual, and cloud environments

« Monitor queries and query plans to see the causes of blocks and deadlocks

+ Adaptive & automated alerting with 100+ pre-defined and configurable alerts
+ Capacity planning to see database growth trends and minimize server sprawl
« Monitor application transactions with SQL Workload Analysis add-on

« View expert recommendations from SQL Doctor to optimize performance

+ View summary of top issues and alerts with the web console add-ons
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Access the SQL Diagnostic Manager Release Notes

IDERA SQL Diagnostic Manager provides an unprecedented level of diagnostic information on the health,
performance, and status of SQL Server instances across your environment. You can view, diagnose, and report on
critical performance statistics from a central point of control.

Using a unique agent-less architecture, SQL Diagnostic Manager gathers diagnostic information in real time,
keeping database administrators and managers informed by providing customized alerts. Easy to install and use,
SQL Diagnostic Manager is an indispensable SQL Server management tool that benefits both experienced and
junior database administrators.

To get a glimpse into the newest features, fixed issues, and known issues in this release of SQL Diagnostic Manager,
review the following sections of the Release Notes:

« See new features in this release

« Review issues fixed by this release

» Review previous features and fixed issues
+ See known issues

« See list of recommended IDERA Solutions

To see the summary of the Support Status for SQL Diagnostic Manager click here.
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New features and fixed issues

SQL Diagnostic Manager provides the following new features and fixed issues.

10.5 New Features

+ SQL Diagnostic Manager now includes Prescriptive Analysis improvements (embedded SQL Doctor),
updated user interface that matches SQL Doctor workflows, and updated recommendations (specifically for
Azure SQL and Amazon RDS).

+ This release includes Cloud DBaaS$ user interface improvements that ease the management of Azure SQL
and Amazon RDS management supported metrics.

+ SQL Diagnostic Manager now includes Alerting improvements:

« New alert templates with revised thresholds and ranks.

« New conditions for Alert Responses.

« New Alert filter to avoid false positives from spikes, filter by percentage of time over a period
exceeding threshold.

« PowerShell command to Apply Alert template.

« New Alerts and metrics for Azure SQL and Amazon RDS specifically.

« All alert priority levels were updated for existing alerts and for user customization.

« New alert template reports.

10.5 Fixed Issues

Alerts

_ The Alert Suppression settings for the Availability Group Synchronization Health metric now
functions as expected.

_ Alert Summary for the Blocking Session Wait Time (Seconds) metric is not displaying time using the
local time zone.

_ The alerts "SQL Server Agent unable to monitor" and "WMI service is unavailable" are no longer
triggered when the monitored servers are successfully connected to the WMI service.

Analysis

_ SQL Diagnostic Manager is no longer prompting an error when performing an Analysis, which was
caused by the Prescriptive Service not installing "TracerX.Logger.dlll" file.

_ History Browser is no longer used for Prescriptive Analytics with the revised interface.

_ SQL Diagnostic Manager now successfully completes analysis and the results are displayed as
expected.

Web Console
_ The SQL Diagnostic Manager Web Console correctly displays the statuses of monitored instance.

_ The SQL Diagnostic Manager Web Console now correctly honors the Application Security settings
that is configured in the SQL Diagnostic Manager Desktop Console.

_ The IDERA Dashboard now correctly displays the federation drop down menu.
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Metrics

_ The 'Days since last backup' metric no longer generates alerts for databases that have never been
backed up

_ The PowerShell now correctly works when the $AlertText is used for the Blocked Sessions Wait
Time (Seconds).

_ When configuring the "Oldest Open Transaction" metric, SQL Diagnostic Manager now correctly
saves the exclusion filter value when wildcards are used.

Desktop Console

_ Improved the performance of the SQL Diagnostic Manager Desktop Client when updating
properties of a monitored SQL Server instance.

_ Index rebuilding operation in SQLDM desktop console now correctly works and is no longer
displaying errors.

Reports

_ The Deadlock Report now correctly displays all the information about the deadlocks occurred in
the monitored instances.

_ The error "Failed to enable constraints. One or more rows contain values violating non-null,
unique, or foreign-key constraints" is no longer displaying when running the "Detailed Session Report".

_ The Deadlock Report now correctly shows the total number of deadlocks.
_ The Database Statistics report no longer encounters a timeout error when generating the report.
_ The Detailed Session Report now successfully deploys to SSRS.

Services

_ When monitoring a SQL Server instance using a privilege minimized user, Query Monitor and Wait
Statistics collection will now resume upon a restart of the SQL Diagnostic Manager services.

_ The SQLDM Management Service no longer crashes when a server has been registered as a Linux
instance.

SQL Server supported versions
_ SQL Diagnostic Manager now correctly monitors SQL Server 2000 instances.

_ SQLDM now correctly monitors SQL Server 2005 instances.

_ The error "SQL Agent unable to monitor" is no longer prompting when monitoring instances
running specific SQL Server versions.

Memory
_ SQLDM now correctly shows the OS memory usage on the newly added servers.
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Upgrade

_ The "Error interpreting File Activity Collector: Invalid column name 'unused_size'" error is no longer
displaying after upgrading to SQLDM 10.3.

_ The SQLDM desktop console now correctly works after an upgrade to 10.3.1 version.

Sysadmin Permissions

_ SQL Diagnostic Manager no longer generates an error message indicating that sysadmin rights are
required in order to collect OS Metrics.

Mirroring
_ SQLDM now correctly refreshes the Mirroring history of a database.

Query Waits
_ The refresh error when navigating in the Query Waits screen is no longer displaying.

Azure

S s Diagnostic Manager is no longer generating an error related to Procedure Cache when
monitoring Azure SQL Database.
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Known issues

IDERA strives to ensure our products provide quality solutions for your SQL Server needs. If you need further
assistance with any issue, please contact Customer Support Portal.

In this section you can find information on:

« Issues known in this version.
 Issues known in recent releases.
+ Issues known in releases previous to SQL Diagnostic Manager 10.0

Known issues in version 10.5

Analysis

Workload Category

The Workload Analysis alerts categories are disabled by default to avoid inadvertent load. To run and ad hoc
analysis, scroll down in the Run Analysis window and enable them.

Query Monitor

Estimated plan collection

On-demand estimated plan collection are not working for queries with bind variables.

© Customers on SQL Diagnostic Manager 10.4.2 and 10.4.3 should not attempt to upgrade to 10.5. If you have
attempted to upgrade and encountered a failure, please contact IDERA Technical Support.

(@ Allthe fixes included in 10.4.2 and 10.4.3 have not been integrated in SQL Diagnostic Manager 10.5. These
Fix Versions are included in the upcoming version SQL Diagnostic Manager 10.5.1.

Previous known issues

Known Issues in version 10.4

Query Store

Enabling

Query Store must be enabled on the monitored instance, along with Query Monitor and Query Waits.

IDERA Dashboard

Upgrading

Upgrading the IDERA Dashboard may fail if you have previously upgraded from version 3.8. Please contact
IDERA support when encountering this problem.
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Extended Events

Updates

When using Extended Events for Query Wait collections, updates happen at the snapshot interval. For real
time updates, deselect Extended Event collection for the default of DMV sampling of Query Waits. Then, the
graph will update with real-time collection intervals.

Query Details

Query Plan Diagram

When exporting a Query Plan Diagram you may encounter a Security Alert window with the following message
"Your current security settings do not allow this file to be downloaded". Prevent this alert following these
instructions:

Close SQLDM.

Open Internet Explorer.

In the menu bar, select Internet Options.

The Internet Options window opens, click the Security tab, select Custom Level, search for Downloads, and
enable File Downloads.

5. Click OK.

PN

Known Issues 10.3

Installation

Native client

SQL Diagnostic Manager installation may fail if Microsoft SQL Server Native Client is not installed on the
machine. To avoid the failure, install the SQL Server native client first, and then run SQLDM installer. The
native client installer can be found on the following page: Microsoft® SQL Server® 2012 Native Client - QFE

Privilege Minimization

User configuration

When configuring a privileged minimized user, the collection of WaitStatistics and QueryMonitoringStatistics
could stop after SQLDM restarts.

IDERA Dashboard

Upgrade

In certain upgrades of the IDERA Dashboard, DM registration gets unregister. If users attempt to register the
product manually, it will fail because SQL Diagnostic Manager keeps unregistering on service restart.

Query Waits

Extended Events

When Query Waits is enabled with Extended Events selected, the CPU utilization will increase dramatically. To
prevent this problem, deselect Extended Events for Query Wait collection.
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Known Issues in version 10.2.3

IDERA Dashboard

Upgrade

When you upgrade SQL Diagnostic Manager, the installation wizard shows a message detecting the current
version of your IDERA Dashboard. However, this message may also show that the Dashboard would be
upgraded to an incorrect one.

Known issues in version 10.2.2

Licenses

License Library

The license library has changed. If you encounter problems with your current license, contact Licensing.

Installation and upgrade

Upgrading SQL Diagnostic Manager

When a local user that is not created as an administrator, but later is added to the local administrator group,
runs the upgrade. It results in a restart through the upgrade and a partially completed upgrade.

Prevent this issue by running the upgrade under a user ID created or configured as a local administrator.

Known issues in version 10.2.1

IDERA Dashboard

Dashboard upgrade

After upgrading to SQL Diagnostic Manager 10.2.1 is necessary to stop and restart the SQLDM and the
Dashboard services:

« ldera Dashboard Web Application Service
« |dera Dashboard Core Service

« SQLdm Rest Service

« SQLdm Predictive Analytics Service

+ SQLdm Management Service

« SQLdm Collection Service

Follow the mentioned steps so that the Dashboard works as expected.

IDERA Dashboard

Dashboard Upgrade

IDERA Dashboard is not included in SQL Diagnostic Manager 10.2 upgrade. If you require IDERA Dashboard,
you have three options:

1. Wait for SQLDM 10.2.1. A new release including a new IDERA Dashboard SQLDM interface is coming soon.
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2. Upgrade SQLDM 10.1.4 with SQLDM 10.2 and leave the IDERA Dashboard in place. SQLDM 10.2 upgrade
works with previous IDERA Dashboard integration, but new registrations are not supported.

3. Volunteer for the SQLDM 10.2.1 Beta. This release includes the IDERA Dashboard, but some known bugs may
be present in the SQLDM integration with IDERA Dashboard.

Known issues in version 10.1.4

Installation

Failed installation on SQL Server 2005.

SQLDM is failing to install on SQL Server 2005 version. SQLDM 10.1.4 has encountered this issue when it is
installed on SQL Server 2005 SP4.

WMI

WMI Service

WMI service must be running and be properly configured for disk space alerts to function normally.
Dashboard

Widgets

The instance status widget in the Dashboard is not loading any data.

Known issues in version 10.1.1

Installation

Failed SQLDM installation on Windows 10 or Windows 12.

Installation fails when the .Net 2.0/3.5 feature is not installed on Windows 10 or Windows 12. Therefore, install
the .Net 2.0/3.5 feature before the SQLDM installation, once the installation is complete, the .Net 2.0/3.5
feature can be removed.

Known issues in version 10.1

PowerShell

Instance friendly name is not displayed in the Ul.

The friendly name assigned to an instance through PowerShell is not being automatically refreshed and is not
being displayed in the Desktop Console Ul. Right-click All Servers in the tree pane and select Refresh to
manually refresh the instances information and visualize the assigned friendly name.
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IDERA Dashboard

Unsuccessful registration of SQLDM instances.

Installations of the IDERA Dashboard in 32 bit Operating Systems are unable to successfully register
SQLDM instances hosted on 64 bit Operating Systems.

Known issues in version 10.0

License Manager

The Generate License Keys link fails to direct to License Manager.

SQL Diagnostic Manager version 10.0 is designed to integrate with License Manager 2.0, allowing for a
self-service licensing model. However, an issue in the Generate License Keys link of the License Keys
window fails to direct to License Manager. For additional information on this feature and a workaround,
see Generate a new license key.

IDERA Dashboard and web console

Views with list of instances available take longer to populate in the SQL Diagnostic Manager web console.

Some SQL Diagnostic Manager users may find that it takes approximately a minute for any of their
monitored instances to display in views of the SQL Diagnostic Manager web console where a list of
instances is available.

Known Issues in version 9.x
Known issues in version 9.1

General

The option to collect non-query activities data using Extended Events is incorrectly set by default for SQL Server
2008R2 instances.

SQL Diagnostic Manager is designed to support collection of non-query activities data with Extended
Events only for instances running SQL Server 2012 or higher. In SQL Diagnostic Manager 9.1 for instances
running SQL Server 2008R2 the Use Extended Events radio button is selected by default instead of the
Use SQL Trace radio button.

Clicking the ‘launch SQLdm’ icon takes users to the corresponding instance dashboard screen but sometimes it fails

to highlight the specific instance in the Servers tree.

SQL Diagnostic Manager is designed to allow users access to the SQL Diagnostic Manager Console from
the Thumbnail, Heatmap, and Alerts Detail views. In SQL Diagnostic Manager 9.1 clicking the ‘launch
SQLdm’ icon takes users to the corresponding instance dashboard screen but occasionally fails to clearly
mark the specific instance it refers to in the Servers tree
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Alerting

SQL Diagnostic Manager fails to display one alert response when multiple metric thresholds are breached

SQL Diagnostic Manager version 8.5 and later is designed to trigger an alert response only after multiple
metric thresholds are breached when the “Where all metrics are in specified list” condition is selected.
However, an issue in the “Send a Network Management (SNMP) Trap Message”, “Send an email to
recipient”, and “Run the following SQL Script” actions of the Alert Response Window cause these actions
to execute several times, resulting in multiple alerts.

The action “Run the following program” fails to execute when configuring automated responses to alerts

Users with SQL Diagnostic Manager version 8.0 and later may find that when creating an alert response
with the associated action “Run the following program” in the Alert Response window, the specified
program does not run once the condition is met.

SQL Diagnostic Manager returns PoweredOff alerts for the VM Power State metric when servers are not turned off

Some SQL Diagnostic Manager users may view PoweredOff alerts when reviewing the generated “VM
Power State” alerts for their servers linked to vCenter or Hyper-V host servers. These alerts display even
though the servers are not turned off.

The actions “Write an event to the Windows event log” and “Send an email to recipient” in the Alert Response
Window fail to deliver multiple alert statuses

Users with SQL Diagnostic Manager version 8.5 and later may find that when creating an alert response
with multiple metrics as a condition and associated actions “Write an event to the Windows event log”
and/or “Send an email to recipient” in the Alert Response window, the feature fails to deliver complete
alert information and displays only one alert status when condition is met.

VM Configuration

SQL Diagnostic Manager fails to update fields in the VM Configuration window after the virtualization host server is
edited

Users with SQL Diagnostic Manager version 8.5 and later may find that fields such as the Virtual Machine
name, Type, and Computer Name in the VM Configuration window are not updated correctly after the
virtualization host server is changed.
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Known issues in version 9.0

General
SQL Diagnostic Manager fails to update fields in the VM Configuration window after the virtualization host server is
edited

Users with SQL Diagnostic Manager version 8.5 and later may find that fields such as the Virtual Machine
name, Type, and Computer Name in the VM Configuration window are not updated correctly after the
virtualization host server is changed.

Web Application Service

The IDERA Dashboard's Web Application Service fails to restart after reboot

Users with SQL Diagnostic Manager version 9.0 may find that the IDERA Dashboard's Web Application Service
does not automatically restart after a machine reboot.

Alerting

SQL Diagnostic Manager fails to display one alert response when multiple metric thresholds are breached

SQL Diagnostic Manager version 8.5 and later is designed to trigger an alert response only after multiple
metric thresholds are breached when the “Where all metrics are in specified list” condition is selected.
However, an issue in the “Send a Network Management (SNMP) Trap Message”, “Send an email to recipient”,
and “Run the following SQL Script” actions of the Alert Response Window cause these actions to execute
several times, resulting in multiple alerts.

The action “Run the following program” fails to execute when configuring automated responses to alerts

Users with SQL Diagnostic Manager version 8.0 and later may find that when creating an alert response with
the associated action “Run the following program” in the Alert Response window, the specified program does
not run once the condition is met.

SQL Diagnostic Manager returns PoweredOff alerts for the VM Power State metric when servers are not turned off

Some SQL Diagnostic Manager users may view PoweredOff alerts when reviewing the generated “VM Power
State” alerts for their servers linked to vCenter or Hyper-V host servers. These alerts display even though the
servers are not turned off.

The actions “Write an event to the Windows event log” and “Send an email to recipient” in the Alert Response
Window fail to deliver multiple alert statuses

Users with SQL Diagnostic Manager version 8.5 and later may find that when creating an alert response with
multiple metrics as a condition and associated actions “Write an event to the Windows event log” and/or
“Send an email to recipient” in the Alert Response window, the feature fails to deliver complete alert
information and displays only one alert status when condition is met.

Known Issues in version 8.x
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Known issues in version 8.6

Alerting

SQL Diagnostic Manager fails to update statistics for some monitored SQL servers and triggers a persistent alert
‘Unable To Monitor’ for the same

Users with SQL Diagnostic Manager version 8.0.1 and later may find that some servers are not returning any
statistics due to an issue in the Activity Monitor settings that causes the entire refresh of servers to fail.

SQL Diagnostic Manager fails to display one alert response when multiple metric thresholds are breached

SQL Diagnostic Manager version 8.5 and later is designed to trigger an alert response only after multiple
metric thresholds are breached when the “Where all metrics are in specified list” condition is selected.
However, an issue in the “Send a Network Management (SNMP) Trap Message”, “Send an email to recipient”,
and “Run the following SQL Script” actions of the Alert Response Window cause these actions to execute
several times, resulting in multiple alerts.

The action “Run the following program” fails to execute when configuring automated responses to alerts

Users with SQL Diagnostic Manager version 8.0 and later may find that when creating an alert response with
the associated action “Run the following program” in the Alert Response window, the specified program does
not run once the condition is met.

The actions “Write an event to the Windows event log” and “Send an email to recipient” in the Alert Response
Window fail to deliver multiple alert statuses

Users with SQL Diagnostic Manager version 8.5 and later may find that when creating an alert response with
multiple metrics as a condition and associated actions “Write an event to the Windows event log” and/or
“Send an email to recipient” in the Alert Response window, the feature fails to deliver complete alert
information and displays only one alert status when condition is met.

SQL Diagnostic Manager returns PoweredOff alerts for the VM Power State metric when servers are not turned off

Some SQL Diagnostic Manager users may view PoweredOff alerts when reviewing the generated “VM Power
State” alerts for their servers linked to vCenter or Hyper-V host servers. These alerts display even though the
servers are not turned off.

SQL Diagnostic Manager fails to stop alert generation after the Availability Group Preferred Replica alert is un-
checked

Users with SQL Diagnostic Manager version 8.6 that have the Availability Group Preferred Replica alert
configured may find that when un-checking the alert in the Alert Configuration window to stop raising the
alert, SQL Diagnostic Manager continues to generate the alert which also displays in the Alerts View. Un-
checking the configured database in the Configuration tab of the Alert Configuration window solves this issue.

General
SQL Diagnostic Manager fails to update fields in the VM Configuration window after the virtualization host server is
edited

Users with SQL Diagnostic Manager version 8.5 and later may find that fields such as the Virtual Machine
name, Type, and Computer Name in the VM Configuration window are not updated correctly after the
virtualization host server is changed.
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Known issues in version 8.5

General

The Query Monitor trace in SQL Diagnostic Manager does not return queries in progress

Users with SQL Diagnostic Manager version 8.0 and later may find that when using the Query Monitor
functionality, the queries returned and displayed do not include queries in progress.

SQL Diagnostic Manager fails to update fields in the VM Configuration window after the virtualization host server is
edited

Users with SQL Diagnostic Manager version 8.5 may find that fields such as the Virtual Machine name, Type,
and Computer Name in the VM Configuration window are not updated correctly after the virtualization host
server is changed.

Alerting

SQL Diagnostic Manager returns Blocking Session Wait Time alerts with session 0 and missing information when
blocking-process node is empty

Some users may experience Blocking Session Wait Time alerts with missing information and session 0 when
the blocking-process node is empty in SQL Server. In SQL Diagnostic Manager 8.01 and later versions, this
issue may occur only if the trace that is collecting blocking data doesn’t return a SPID for a blocking process.

SQL Diagnostic Manager fails to display one alert response when multiple metric thresholds are breached.

SQL Diagnostic Manager version 8.5 and later is designed to trigger an alert response only after multiple
metric thresholds are breached when the “Where all metrics are in specified list” condition is selected.
However, an issue in the “Send a Network Management (SNMP) Trap Message”, “Send an email to recipient”,
and “Run the following SQL Script” actions of the Alert Response Window cause these actions to execute
several times, resulting in multiple alerts.

The action “Run the following program” fails to execute when configuring automated responses to alerts.

Users with SQL Diagnostic Manager version 8.0 and later may find that when creating an alert response with
the associated action “Run the following program” in the Alert Response window, the specified program does
not run once the condition is met.

The actions “Write an event to the Windows event log” and “Send an email to recipient” in the Alert Response
Window fail to deliver multiple alert statuses.

Users with SQL Diagnostic Manager version 8.5 and later may find that when creating an alert response with
multiple metrics as a condition and associated actions “Write an event to the Windows event log” and/or
“Send an email to recipient” in the Alert Response window, the feature fails to deliver complete alert
information and displays only one alert status when condition is met.

SQL Diagnostic Manager returns PoweredOff alerts for the VM Power State metric when servers are not turned off.

Some SQL Diagnostic Manager users may view PoweredOff alerts when reviewing the generated “VM Power
State” alerts for their servers linked to vCenter or Hyper-V host servers. These alerts display even though the
servers are not turned off.

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 36


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw

SQL Diagnostic Manager for SQL Server

Known issues in version 8.0

Installation and configuration issues
The SQLdm Setup Wizard is interrupted after selecting the SQL server instance on which you want to install the SQL
Diagnostic Manager Repository

Some users may experience an interruption due to memory corruption in their SQL Diagnostic Manager
installation after selecting the SQL Server instance on which they want to install their SQL Diagnostic Manager
Repository. Note that the SQL Diagnostic Manager installer does not complete on machines where memory
corruption prevents connections to SQL Server. Furthermore, in these types of environments other
applications such as SQL Server Management Studio also do not function.

Negative values received from vCenter as a warning message do not impact VM data collection

Some users may receive negative values from vCenter as a warning message. The message is logged as in the
SQL Diagnostic Manager Services. Note that this does not have any impact in terms of VM data collection and
users are able to view VM and VM Host data.

Console crashes when upgrading to SQL Diagnostic Manager 8.0 while logged in the IDERA Newsfeed account

Users who remain logged in the IDERA Newsfeed account and upgrade to SQL Diagnostic Manager 8.0 may
experience console crashes. Note that an upgrade from SQL Diagnostic Manager 8.0 to 8.0.1 will solve this
issue.

Known Issues in version 7.x
Known issues in version 7.5

General

SQL Diagnostic Manager 7.5 no longer supports Microsoft Windows 2000 or the .Net 2.0 framework

SQL Diagnostic Manager 7.5 does not support Windows 2000 or the .Net 2.0 framework. While SQL Diagnostic
Manager 7.2 and prior versions continue to operate with Windows 2000, SQL Diagnostic Manager 7.5 and later
require the .Net 4.0 Full framework to take advantage of the additional features.

Server Overview

Timeline refresh causes a memory leak

SQL Diagnostic Manager experiences a memory leak when you are viewing the Timeline and click Refresh. To
free the memory, you must restart the SQL Diagnostic Manager Management Console.

Queries

Queries view filter may not properly filter in some situations

In environments with large databases, the Queries view filter may not properly filter if you attempt to change
filter properties during a refresh.
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Resources

File Activity displays an unhelpful error message when WMI credentials are invalid

SQL Diagnostic Manager displays the error message, "An error occurred while refreshing the active view,"
when you attempt with access the Resources > File Activity view if your WMI credentials are invalid. If this
message appears, verify your WMI access credentials and try again.

Installation and configuration considerations

SQL Diagnostic Manager Repository computer must run Microsoft SQL Server 2005 or later

SQL Diagnostic Manager 7.0 and later require Microsoft SQL Server 2005 or later running on the computer that
hosts the SQL Diagnostic Manager Repository database for all installations.

SQL Diagnostic Manager Console only users cannot upgrade to the full version without uninstalling SQL Diagnostic
Manager

Users who have an installation of SQL Diagnostic Manager Console only on a computer can use the upgrade to
update their current version of the desktop client console, but cannot use the upgrade program to install the
full version of SQL Diagnostic Manager.

Registering a SQL Server instance that uses an Alias Name requires an alias on the host computer

When registering a SQL Server instance using the alias name, an alias must first be created on the computer
that hosts the SQLdm Management and Collection Services. If the instance uses Named Pipes, Named Pipes
must be enabled in the SQL Server network configuration of the aliased SQL Server instance.

Management Service does not start when the account permissions are incorrect

If the account you specified for the SQL Diagnostic Manager services does not have System Administrator
privileges on the SQL Server instance hosting the Repository database, the setup program cannot start the
SQLdm Management Service. This issue only occurs during installation.

Some users may receive an error message when opening the SQL Diagnostic Manager stating that there is no valid
license available

To resolve this issue, use the Management Service Configuration wizard to specify credentials for a Windows
account or SQL Server login that has System Administrator privileges on the SQL Server instance hosting the
Repository database. You can start the Management Service Configuration wizard from the Programs menu.

SQL Diagnostic Manager Reporting does not support Microsoft Reporting Services 2000
SQL Diagnostic Manager only supports Microsoft Reporting Services 2005 and later.

SQL Diagnostic Manager requires Predictive Analytics for baseline-related results

SQL Diagnostic Manager 7.5 requires the Predictive Analytics Service in order to display baseline-related
results. During installations and upgrades, SQL Diagnostic Manager installs the Predictive Analytic service with
the other included services. If Predictive Analytics is not detected or is disabled, SQL Diagnostic Manager
cannot generate baseline data for the requested report. The following reports require the Predictive Analysis
Service to include baseline-related results:

+ Baseline Statistics
« CPU Statistics

+ Memory Statistics
» Session Statistics
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« Disk Statistics
« Replication Statistics
Phase out SQL Diagnostic Manager mobile manager

IDERA is announcing end of life for SQL mobile manager (SQLmm). On October 1, 2012, all support for SQLmm
will stop and the SQLmm trial site will be decommissioned. Also, any remaining installations of SQLmm 3.6 or
earlier that use the IDERA redirectors will no longer work.

To continue using a Web-based monitoring solution that is accessible from your smart phones or tablet
devices, upgrade to SQL Diagnostic Manager 7.0 or later, and deploy SQLdm Mobile. IDERA discontinued
distribution of SQL mobile manager in October 2011.

SQLdm Mobile does not support Microsoft IIS Express

SQLdm Mobile requires the standard version of the Microsoft IIS Web Server, version 7.0 or later. For more
information, see the SQLdm Mobile requirements.

SQLdm Mobile & Newsfeed installation cannot be changed or repaired using Add/Remove Programs

To successfully change or repair your SQLdm Mobile & Newsfeed installation, uninstall the application and
components, and then run the setup program to reinstall your deployment.

SQLdm may not properly link to vCenter from some monitored virtual SQL Server instances

The SQLdm VM Configuration window displays a list of your monitored virtual SQL Server instances, but the
link between an instance and the associated vCenter may not work properly. To access this window, click
Tools >VM Configuration.

VM Host Server Change alert not always triggered when a VM moves from one host server to another

Even if the circumstances warrant SQL Diagnostic Manager to trigger the VM Host Server Change alert, users
who have virtual machines running on an ESX host managed by vCenter 5.0 or later may not receive the alert
when they move a VM from one host to another.

Negative values received from vCenter as a warning message do not impact VM data collection

Some users may receive negative values from vCenter as a warning message. The message is logged as in the
SQL Diagnostic Manager Services. Note that this does not have any impact in terms of VM data collection and
users are able to view VM and VM Host data.

Query Monitor disregards filter for SQL Server 2000 users

Some SQL Server 2000 users may notice that SQLdm Query Monitor includes SQL Diagnostic Manager queries
in the results even if the Exclude SQL Diagnostic Manager queries check box is checked in the Advanced Query
Monitor Configuration window.

SQLdm Mobile Server Dashboard charts display “Data not available” error

This error indicates that SQLdm Mobile was not able to collect all the performance metrics tracked by these
charts. This issue is more likely to occur with the 1/0 and Per Read/Write charts on the Disk dashboard. To
correct this issue, use the Microsoft 1S Manager console to restart the SQLdm Mobile Web site (virtual
directory).

Start and Stop service actions not supported for virtual SQL Server instances

The Start and Stop service actions are not supported for virtual SQL Server instances (instances located on a
Windows cluster node). To start or stop a service on a virtual SQL Server 2008 instance, use the Microsoft
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Failover Cluster Management tool. For SQL Server 2005 or earlier, use the Microsoft Cluster Administrator tool
to manage services.

Gaps between the real-time view and back-filled historical data can be seen on the CPU view

This occurs only when the CPU view is accessed via the Server tree. To view the information, without any gaps,
access the CPU view via the ribbon.

Free disk space reported as zero on databases with special characters

For servers and path names that include special characters such as % or #, SQL Diagnostic Manager may
incorrectly report the remaining disk space as zero.

Known Issues in versions previous to 7.5

Known issues in versions previous to 7.5

General
SQL Diagnostic Manager displays a refresh error when a user attempts to view data for an instance to which he does
not have admin rights

SQL Diagnostic Manager displays a refresh error message when a user tries to view data for a monitored SQL
Server instance to which the user does not have administrative rights. The message states that, "An error
occurred while refreshing the active view."

SQL Diagnostic Manager displays an error when a user attempts to configure disk collection for an instance to which
he does not have admin rights

SQL Diagnostic Manager displays an error message on the Server Properties Disk Drives window if a user's
collection service credentials do not have administrative access to the monitored SQL Server instance, and
the user attempts to view the list of attached disk drives on that instance. Note that WMI credentials are not
used to retrieve disk drive information on this page.

Drives may not appear in the Resources Disk view when you switch to direct WMI collection

Users who select to collect OS metrics using direct WMI collection may notice mounted drives appearing in
some areas of SQL Diagnostic Manager but not on the Resources Disk view. To refresh this list, you must
restart the SQL Diagnostic Manager Management Console.

Dashboard

Custom Counters dashboard panel does not return to default after deleting all counters

The Custom Counters dashboard panel includes a drop-down list to allow you to select from the available
counters. If you delete all counters, the panel does not return to the default title and continues to display one
of the counter names.

Resources

Disk Filter Columns does not work on a blank chart

The Filter Columns selection does not work in the Resources > Disk view if you receive a blank chart due to
your WMI credentials being invalid.
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Alerts

OS Disk Time (Percent) and OS Disk Time Per Disk (Percent) alerts may not trigger for some users

Users with Windows Server 2008 SP1 and SQL Server 2000 SP4, and who select direct WMI collection for their
OS metrics may experience an issue preventing OS Disk Time (Percent) and OS Disk Time Per Disk (Percent)
alerts from triggering. If this issue occurs, switch to using OLE automation.

Virtualization-related alerts occasionally raise more than once

In some circumstances, SQL Diagnostic Manager may repeatedly raise virtualization-related alerts when there
is no change in the status.

Custom Counters

SQL Diagnostic Manager does not automatically add unassociated custom counters to an alert template created
from an instance

If you use alert templates and create a custom counter, SQL Diagnostic Manager automatically adds the new
counter to your existing alert templates. However, if you create a custom counter not associated with an
instance, and then create an alert template based on the alert configuration of one of your monitored
instances, SQL Diagnostic Manager does not add the new counter to your alert template nor can you manually
add the counter.

To avoid this issue, add the missing custom counter to any SQL Server instance, create an alert template from
that instance, and then clear any undesired custom counters from that instance.

SQLdm Mobile

SQLdm Mobile My Servers view filter does not work

The filter on this view will consistently display the message, “You have no favored or followed servers or
the servers list has not been cached yet,” regardless of the filter option you choose. This issue occurs
even when you are following servers or have marked servers as favorites.
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Recommended IDERA Solutions

IDERA strives to ensure our products provide quality solutions for your database needs. The following IDERA
Solutions have been recently added to the knowledge base at the Customer Service Portal.

ID Number

4337

4287

4281

4088

3511

2286

2109

2102

Title
SQLDM alert, "Session 0 has been blocking other sessions..."
Disk Full Percent fires at or near 100% for a disk that still has plenty of space.

A SQL Diagnostic Manager with wait type MSQL XP uses constant CPU resources and
never finishes on a monitored server.

Disk Busy per Disk counter reports 100% when the disk is known to be idle.
SQLDM always shows "The SQLDM Collection Service has too many outstanding
connections" in the overview pane for a specific server, and SPIDs stall on the audited

server.

When Upgrading SQL Diagnostic Manager, you receive the error message "The
repository is an invalid version."

CPU Used, Memory Paging and Disk Queue Length show question marks in the
Summary view.

What alerting Event Codes are used in SQLDM 5.0 or later?
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Get started

SQL Diagnostic Manager (SQLDM) is a database management system (DBMS) solution designed exclusively for
Microsoft SQL Server diagnosis and performance tuning. SQL Diagnostic Manager lets you discover potential and
existing problems, analyze the state of your SQL Server enterprise, and generate reports.
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Upgrade to this release

Upgrading SQL Diagnostic Manager to the most recent version allows you to take advantage of the new features
available. An up-to-date list of new features and fixed issues is available in the SQL Diagnostic Manager Release

Notes.

Upgrade from SQL Diagnostic Manager 5.x or higher to SQL Diagnostic Manager 10.4
checklist

To successfully upgrade your Microsoft SQL Server environment to this build, complete the steps included in the
following table:

@ Follow these steps ...
Back up your SQL Diagnostic Manager Repository prior to upgrading.

Make sure that your environment meets the product requirements for the newer version of SQL Diagnostic
Manager.

Verify that no SQL Diagnostic Manager desktop clients are running.

Upgrade your environment to the latest version of SQL Diagnostic Manager on the computer where the
SQL Diagnostic Manager services reside. Note that SQL Diagnostic Manager 10.0 and later versions
integrate with the IDERA Dashboard.

Test your new SQL Diagnostic Manager deployment and setup.

Upgrade your IDERA Newsfeed and SQLdm Mobile installations or deploy a new IDERA Newsfeed and
SQLdm Mobile installation.

& Upgrade to SQLDM 9.0 or higher versions

Customers upgrading from previous SQL Diagnostic Manager versions to SQL Diagnostic Manager 9.0 or
higher versions, need a new license key or it is not possible to continue with the upgrade process. Users
can access the IDERA Customer Portal at the moment of upgrade from the license management window in
SQL Diagnostic Manager (Help > Manage Licenses) or directly at https://idera.secure.force.com.
Information necessary to generate a new license key is provided in the license management screen or the
portal.
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Upgrade SQL Diagnostic Manager in a clustered environment

Use the following steps to upgrade your SQL Diagnostic Manager installation in a clustered environment.

@ SQL Diagnostic Manager 10.0 and later requires Microsoft SQL Server 2005 running on the computer that
hosts the SQL Diagnostic Manager Repository database for all installations.

Upgrade in a Microsoft Windows Server 2003 Clustered Environment
To upgrade SQL Diagnostic Manager in a clustered environment:

1. Logon to the cluster node using the Administrator account.
2. In Cluster Administrator, select the resource group that contains the SQL Diagnostic Manager services.
3. Take the SQLDM Management and Collection services off line.

Perform the following steps on each node, starting with the active node:

1. Upgrade SQL Diagnostic Manager components previously deployed to the node.

2. In Windows Services, stop the SQLDM Collection, SQLDM Management, and SQLDM Predictive Analytics
services.

3. Setthe SQLDM services to manually start, and then restart the services.

Once the previous steps are complete, perform the following steps on each cluster node:

1. In Cluster Administrator, bring the SQLDM Management Service on line.

2. Use the Management Service Configuration wizard to force the services to re-register on the active node.

Upgrade in a Microsoft Windows Server 2008 Clustered Environment
To upgrade SQL Diagnostic Manager in a clustered environment:

1. Logon to the cluster node using the Administrator account.

2. Inthe Failover Cluster Management tool, select the resource group that contains the SQL Diagnostic
Manager services.

3. Take the SQLdm Management and Collection services offline.

Perform the following steps on each node, starting with the active node:

1. Upgrade SQL Diagnostic Manager components previously deployed to the node.

2. In Windows Services, stop the SQLDM Collection, SQLDM Management, and SQLDM Predictive Analytics
services.

3. Set the SQL Diagnostic Manager services to manually start, and then restart the services.

Once the previous steps are complete, perform the following steps on each cluster node:

1. Bring the SQLdm Management Service on line.

2. Use the Management Service Configuration wizard to force the services to re-register on the active node.
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Perform a standard upgrade

Use the following procedures to upgrade a distributed SQL Diagnostic Manager environment.

Upgrade your SQLDM Repository and/or SQLDM Services

Install the SQLDM Repository database on a SQL Server instance that meets the product requirements. You do not
need to install your Repository in the same domain as the SQLDM Console, but a two-way trust between the target
domains must exist. You can install the SQLDM services on the Repository computer (recommended) or a different
computer.

@ sSQL Diagnostic Manager 10.1 and later requires Microsoft SQL Server 2005 running on the computer that

hosts the SQLdm Repository database for all installations.

To upgrade the SQLDM Repository and/or Services:

1.

Use an administrator account to log on to the computer on which you want to upgrade the SQLDM
Repository database and/or Services.

Run Setup.exe in the root of the installation kit.

On the IDERA SQL Diagnostic Manager Quick Start window, click SQL Diagnostic Manager under the Install
heading.

Read the Upgrade Wizard Welcome window, and then click Next.

Upgrade your Repository by verifying the authentication method and connection credentials, and then click
Next.

Upgrade your Service account by specifying the account credentials that you want the SQLDM services to
use to connect to the SQLDM Repository and the monitored SQL Server instances, and then click Next. This
account must belong to the sysadmin role on the Repository database and each instance you plan to
monitor.

Click Upgrade to begin your upgrade.

Click Finish to exit the upgrade program.

Upgrade your SQLDM Console

© You must have a full installation of SQL Diagnostic Manager already running in your environment before

attempting to upgrade the SQLDM desktop client console.

To upgrade the SQLdm Console:

N

o

Use an administrator account to log on to the computer on which you want to upgrade the SQLDM Console.
Navigate to the location where the SQLDM Console file resides in the distribution media.

If you use an x64 operating system, run SQLDiagnosticManager-x64_c.exe. If you use an x86 0S, run
SQLDiagnosticManager_c.exe.

On the Welcome window of the setup program, click Next.

Click Upgrade to begin your upgrade.

Click Finish to exit the upgrade program.
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Upgrade SQLDM console only

SQL Diagnostic Manager allows users to install a full version, which includes the SQL Diagnostic Manager
Repository, Management Service, and Management Console, or you can install the SQLDM desktop client console
by itself when you already have a full version of SQL Diagnostic Manager installed in your environment.

Users who have an installation of SQLDM Console only on a computer can use the upgrade to update their current
version of the desktop client console, but cannot use the upgrade program to install the full version of SQL

Diagnostic Manager.
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Test your deployment

To test your upgrade, you can immediately begin collecting and alerting on performance data. Verify that you are
able to monitor the target SQL Server instances and that the data you are retrieving is valid.
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Welcome to SQL Diagnostic Manager

SQL Diagnostic Manager is a powerful performance monitoring and diagnostics solution that proactively alerts
administrators to health, performance and availability problems within the SQL Server environment. SQL
Diagnostic Manager now integrates with the IDERA Dashboard, a common technology framework, designed to
support the IDERA product suite. Users are able to obtain an overview of the status of their SQL Servers and hosted
databases all in a consolidated view and navigate to individual product dashboards for details. The IDERA
Dashboard provides a central set of services for managing users, product registry, instance registry, aggregated
alerts across IDERA applications, a central web server, and tags for grouping instances. For additional information,
see Navigate the IDERA Dashboard.

To get started, see the following topics for more information:

» Upgrade to this build of SQL Diagnostic Manager
» Configure SQL Diagnostic Manager
+ Migrate your SQL Diagnostic Manager installation

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 49


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw
http://wiki.idera.com/x/pgDKAg
http://wiki.idera.com/x/pgDKAg
http://wiki.idera.com/x/pgDKAg
http://wiki.idera.com/x/pgDKAg

SQL Diagnostic Manager for SQL Server

What is SQL Diagnostic Manager?

SQL Diagnostic Manager provides an unprecedented level of diagnostic information on the health, performance,
and status of SQL Server instances across your environment. You can view, diagnose, and report on critical
performance statistics from a central point of control. Using a unique agentless architecture, SQL Diagnostic
Manager gathers diagnostic information in real time, keeping database administrators and managers informed by
providing customized alerts. Easy to install and use, SQL Diagnostic Manager is an indispensable SQL Server
management tool that benefits both experienced and junior database administrators.

What is the IDERA Dashboard?

The IDERA Dashboard is a common technology framework designed to support the entire IDERA product suite. The
IDERA Dashboard allows users to get an overview of the status of their SQL Servers and hosted databases all in a
consolidated view, while providing users the means to drill into individual product dashboards for details. The
IDERA Dashboard supports multiple copies of SQL Diagnostic Manager installations.

The SQL Diagnostic Manager web console is integrated with the IDERA Dashboard. It is designed to provide quick
access to the overall status of your SQL Server environment to help diagnose any issues. The web console provides
key information simply through dashboards and high-level views to a large user base such as IT, helpdesk, and
DBAs. You can access the web console from any connected browser and grant access as you need. To learn more
about the SQL Diagnostic Manager web console, visit Navigate the web console dashboard.

What is SQL Diagnostic Manager Mobile?

SQL Diagnostic Manager Mobile is a Web application that displays real-time SQL Server performance dashboards on
a variety of mobile devices, including iPhone, iPad, Android, and Blackberry. SQL Diagnostic Manager Mobile
includes the IDERA Newsfeed technology. The IDERA Newsfeed is a revolutionary new way for DBAs and managers
to collaborate, share knowledge, and keep close tabs on their most critical SQL Server issues.

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 50


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw
http://wiki.idera.com/x/pgDKAg
http://wiki.idera.com/x/pgDKAg
http://wiki.idera.com/x/lADKAg
http://wiki.idera.com/x/lADKAg
http://wiki.idera.com/x/lADKAg
http://wiki.idera.com/x/lADKAg
http://wiki.idera.com/x/lADKAg

SQL Diagnostic Manager for SQL Server

How does SQL Diagnostic Manager help me?

Whether you need immediate diagnostic information or want to gather data for long-term capacity planning, you
can use SQL Diagnostic Manager to help:

« Increase SQL Server availability

« Provide a comprehensive view of current performance

+ Provide continuous, unattended monitoring

«+ Store data in the centralized SQLdm Repository database

« Improve the productivity of both skilled and novice database administrators

With clear, easy-to-understand charts and reports, you can track standard SQL Server performance metrics, trend
historical performance data over time, and proactively identify potential performance problems.
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Use the SQL Diagnostic Manager interface

SQL Diagnostic Manager uses a graphically enhanced user interface to display the current state of your SQL Server
instances. A mixture of graphs, charts, and color coding makes problem identification quick and easy, allowing you
to resolve issues before they reach critical levels.
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Navigation pane

The Navigation pane displays on the left side of the SQLDM Console as shown in the following image.
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The options available on the Navigation pane change depending on the currently selected feature. You can hide the
Navigation pane by selecting View > Navigation Pane > Off. The following features are available in the Navigation

pane:

Servers

Contains a My Views section that helps you organize your SQL Server instances by status and includes
any custom views you have set up. The Tags section allows you to manage tags or key words that you
can use to quickly find the appropriate monitored SQL Server instances, custom counters, and
permissions. The Servers section lists the SQL Server instances contained in the currently selected view.
To view all registered instances, select All Servers from the My Views list.

Alerts

Contains filter options for organizing your alerts and links to configure alert templates, actions, and
responses.

Newsfeed

If installed, the IDERA Newsfeed provides collaboration regarding your most critical SQL Server issues. If
the IDERA Newsfeed is not installed, this page guides you to where you can get additional information
regarding the IDERA Newsfeed.

Reports

Allows you to select the report you want to generate. SQL Diagnostic Manager provides reports for
monitoring, analyzing, and planning how to best use the SQL Server instances within your environment.
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Administration

Allows you to control access to SQL Diagnostic Manager, add custom counters for monitoring, and keep
track of key actions performed in your SQL Diagnostic Manager environment.
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View SQLDM Today

The SQLDM Today page provides a current overview of all the monitored SQL Server instances in your environment
and offers you shortcuts to the following options:

« Five most critical servers

« Five servers you recently monitored

« All active alerts in your SQL Server environment

« The most recent server status updates and coworker posts from the IDERA Newsfeed
« Access to the SQL Diagnostic Manager web console

Access the SQLDM Today page

You can open the SQLDM Today page from the SQLDM Console menu by clicking the SQLDM Today button as
shown in the following image.
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Use SQLDM Today to view the general health of your environment

SQL Diagnostic Manager gives you a quick glance at the overall health of your environment in the Status section of
the SQLDM Today page. The main categories of data shown in this view include the following areas:

Status Summary

The Status Summary section displays the number and type of active alerts for all of your SQL Server
instances. SQL Diagnostic Manager displays a large icon that shows you at a glance the current highest
level of severity of your servers accompanied by the number of your servers in that state.

Most Critical Servers

SQL Diagnostic Manager provides a list of up to five of your most critical servers so you can quickly
access that SQL Server instance and review the issue.

Recent Servers

The SQLDM Today page provides a list of your five recently-accessed SQL Server instances, with the most
recent visit appearing at the top of the list.
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Get the most from SQL Diagnostic Manager

The Get Started tab of the SQLDM Today page provides links for you to access content in the SQL Diagnostic
Manager Trial Center including video tours that cover important features and SQLDM navigation. You can also find
Webcasts, white papers, and the SQL Server Performance Blog for additional information that you may find useful
when using SQL Diagnostic Manager.

View your recent active alerts

SQL Diagnostic Manager displays a list of your most recent active alerts on the SQLDM Today page Active Alerts tab.
While this view displays alerts for all your monitored SQL Server instances, you can view additional alert
information for a specific server instance by using the right-click context menu. This additional information includes
a real-time view and a shortcut to configure your alerts.

If you are aware of an alert and do not want to see it in your list or have it impact the associated server, you can
"snooze" or temporarily postpone the alert from appearing for a set number of minutes. When you snooze an alert,
SQL Diagnostic Manager clears the alert which no longer impacts the state of the monitored server until the snooze
period expires. To snooze an alert, right-click the specific alert, and then select Snooze Alert. Select the appropriate
number of minutes you want to alert to snooze, and then click OK.

To snooze an alert on the Active Alerts tab:

1. On the Active Alerts tab of the SQLDM Today page, right-click anywhere on the row containing the alert you
no longer want to view.

2. Select Snooze Alert.

3. Type or scroll to select the number of minutes you want the alert to snooze, and then click OK.

Use the Web Console

The SQL Diagnostic Manager web console is a web application designed to provide read-only access to the overall
status of your SQL Server environment to help diagnose any issues. The web console provides key information
simply through dashboards and high level views to a large user base such as IT, helpdesk, and DBAs. You can access
the web console from any connected browser and grant access as you deem necessary. The SQLDM Today page
provides the URL to launch the web console.

The SQL Diagnostic Manager web console is integrated with the IDERA Dashboard.

Use IDERA Newsfeed to track your SQL Server issues

The IDERA Newsfeed is a new way for you to share knowledge with other DBAs and managers regarding critical and
current SQL Server issues. To learn how to set up and use the IDERA Newsfeed.
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Refresh and pause views

To let you control the information refresh on a particular view, the SQLDM Toolbar includes the Refresh and Pause
buttons as shown in the following image.
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You can edit the scheduled refresh of your views for more current information. SQL Diagnostic Manager offers the
following refresh controls:

Refresh button

The Refresh button tells SQL Diagnostic Manager to immediately collect data and refresh the current
Console view. Depending on the view, the refresh could take several seconds to complete. SQL
Diagnostic Manager displays the current refresh status in the lower-right corner of the SQLDM Console.

Pause button

The Pause button tells SQL Diagnostic Manager to stop refreshing the console. If you click Pause during
a refresh, the pause occurs after the refresh completes. To continue refreshing, click Pause again.
Pausing the refresh allows you to maintain the currently-monitored state so you can see what is
happening on your SQL Server instance without incoming information overwriting the data. This feature
also gives you time to export or print the displayed statistics before retrieving the next data set.
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Filter views

On a number of views, SQL Diagnostic Manager includes filtering options ranging from ribbons allowing you to
select items shown on the view, to a Filter Settings window that provides a variety of options to customize how
SQL Diagnostic Manager presents your view.

Use the Filter options to customize your view

The Filter box contains the filtering options available for that view, meaning that the available options are not
consistent across views because of the data displayed in each view. You can select the options you want displayed
in the menu by using the Filter Settings window. Click the Filter icon in the ribbon to display the Filter Settings
window.

Every Filter Settings window in SQL Diagnostic Manager provides specific options for the current view. These
options can include true or false fields that allow you to decide whether to show a particular item, filtering fields
where you can enter an item name or even use a wildcard (%), dates and time ranges, and interval periods.

Each field in the Filter Settings window includes a description that displays at the bottom of the window when you
select the field.
Use the Group By feature to organize your view

The Group By feature allows you to group the information shown in your views. To group your information by a
column, check the Group By Box option, and then drag one or more column headings into the provided area as
shown in the following image.
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When you group data by multiple columns, be sure to select the headings in the hierarchy in which you want SQL
Diagnostic Manager to display the results. After selecting the Group By Box check box, click, hold, and drag the first
column heading (first order of grouping) into the grouping area. Next, click, hold, and drag the second column
heading (second order of grouping) into the grouping area. Continue this process until you have the data hierarchy
you want. Click the column headings to toggle sort order between ascending and descending.

You can remove a column from the grouping area by performing a click, hold, and drag of the column back into the
grid area or by right-clicking the heading, and then selecting Remove This Column.
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Charts

Charts are populated from the point at which you navigate to the window with the chart. This allows you to view
real-time charts for the data point selected. Real-time viewing is dependent on your refresh interval. Once
populated, you can manipulate the type of chart you want to display and export the chart or copy it to the clipboard
to paste into other programs.

@ Inthe Server Details view, click the Maximize button on the upper-right corner of a chart to display a large
version of the chart. The Restore button returns the chart to the default view.

All time charts in the web console and desktop console have time-range drill down functionality modeled after SQL
Workload Analysis.

1. Click onyour preferred graph and hold left mouse button.
2. Drag to the left or to the right.
3. Release mouse button.

The time range selected with the previous steps is the new display history range on all the graphs displayed on
different tabs.

Understanding your chart data and refresh interval

SQL Diagnostic Manager charts provide data whether collected in real time or as part of a scheduled collection
event. When you open a view, SQL Diagnostic Manager begins populating the chart with real-time data collected on
the interval specified in the Server View Refresh field on the Console Options window (Tools > Console Options).

If you pause or leave this view and then return during the same Console session, SQL Diagnostic Manager displays
the real-time data points as previously viewed, followed by a period of data points from any scheduled collections
that occurred while you were away. The chart then returns to populating with new real-time data points, as shown
in the following image.
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The amount of time displayed in your charts is set according to the time entered in the Show data for the last field
on the Console Options window. In addition, the time entered in the Keep data for the last field is the amount of
historical data that you can scroll back to in your charts.

Customize your charts

SQL Diagnostic Manager contains charts that are populated by selecting the appropriate data items collected. Once
populated, you can manipulate the type of chart you want to display and export the chart or copy it to the clipboard
to paste into other programs.
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You can personalize charts by right-clicking anywhere inside the chart and selecting Toolbar from the menu. The

chart toolbar contains the following options:

Copy To Clipboard
The Copy To Clipboard button allows you to copy the chart to your Windows clipboard in various
formats.

Print

The Print button allows you to print the chart.

Gallery
The Gallery menu includes a number of options that allow you to change the type of chart used to
represent your data.

Anti-Aliasing

The Anti-Aliasing button smooths the lines between your data points to more easily view your data.

Palette Selector
The Palette Selector menu includes a number of color choices for you to change color scheme of your
chart.

3D/2D

The 3D/2D toggle lets you choose to view your results in three- or two-dimensional plots. Additional
options become active based on your choice and allow you to rotate your view or cluster your results on
the z-axis.

Axes Settings

The Axes Settings menu lets you choose how to view each axis, whether to display labels, and additional
properties for your view.

Point Labels

The Point Labels toggle lets you choose to view the actual data at each point.

Data Grid
The Data Grid toggle places a table below your chart that displays the data included in your chart.

Legend Box

The Legend Box toggle lets you choose to view a legend for your displayed data.

Zoom

The Zoom button allows you to zoom in on a point in your chart.

Properties

The Properties button displays additional properties for further customization of your chart.
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Monitor multiple SQL Server instances

My Views allows you to group servers to provide a high-level, global view of multiple monitored servers. This view
includes basic statistics about your registered SQL Server instances and quick links to more detailed information. A

monitor displays statistics for each SQL Server instance included in the group.

Access My Views

My Views is available at all times as part of the Navigation pane as shown in the following image.
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Use the group list

SQL Diagnostic Manager updates the data shown in the thumbnails view of the group list according to the interval
entered in the Status and Alerts Refresh field on the Console Options window, accessed by clicking Tools >

Console Options. This information is collected from the last data point stored in the SQLdm Repository.

By default, the group list displays basic statistics for each of the SQL Server instances monitored by SQL Diagnostic

Manager. This information includes the following statistics for each instance:

Response Time

Refers to the time it takes for a query to go from the SQLDM Console to the SQL Server instance and back.

User Sessions

Refers to the total number of SQL Server user sessions.
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SQL CPU Usage
Refers to average percentage of SQL Server processor usage on the computer hosting the SQL Server
instance.

SQL Memory Usage/Allocated

Refers to amount of memory in use by the monitored SQL Server instance.

SQL Disk 1/0
Refers to the number of physical reads and physical writes made by the SQL Server instance between
refreshes. If you see a high percentage of physical reads, you can improve performance by allocating
more memory to the SQL data cache.
Customize the monitors in your group list

SQL Diagnostic Manager allows you to customize the monitors displayed in group lists so that you display only
those key statistics and charts that are most important to you.

To customize a monitor:

1. Right-click a SQL Server instance in the view.
2. Select Thumbnail and select the information type you want to display on your monitor.

Instead of listing statistics for the server, SQL Diagnostic Manager displays the individual chart of the data item you
selected. To revert back, select Summary from the Thumbnail list.
Use the Server Thumbnails, Details, or Configuration Properties window

SQL Diagnostic Manager allows you to monitor multiple instances using different views, such as thumbnails of mini-
monitors, a list of instances and their important details, or a list of instances and their server properties. SQL
Diagnostic Manager defaults to the thumbnails view. To access a different view, click the appropriate button in the
upper-right corner of the window as shown in the following image.

fli.lp- Visit the Trial CQ;‘;'{%&}} Show Thumbnails
Show Details

Show Server Configuration
Froperties

© Ifany of the metrics are missing from this view, you may need to enable OS metrics collection.

These views list all the data collected at the last refresh for all your monitored SQL Server instances. The Details and
Server Configuration Properties views can assist you with comparing the status of a specific metric or property
between two or more of your SQL Server instances.
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Add a custom view

You may want to add a custom view to the My Views list to organize your SQL Server instances into specific groups
for monitoring purposes. This is especially important if you are monitoring a large number of SQL Server instances
and want information for a specific group of SQL Server instances. If you create views before adding your

SQL Server instances to SQL Diagnostic Manager for monitoring, you can have these new instances added to your
views by selecting the new view you create and then adding the SQL Server instances.

To add a new view:

1.

ol wnN

If you want to create a new view from the File menu, click File > Create View. If you want to create a new
view from My Views, right-click within the My Views section, and then select Create View.

Type a name for the view.

Select the monitored SQL Server instances you want to include in this view.

Click Add > to move the selected instances from Monitored Instances to View Instances.

Click Create to create your new view.
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Server Configuration Properties

The Server Configuration Properties view provides the current configuration settings for each of your monitored
SQL Server instances and allows for some changes directly in this window rather than leaving this view to access
the properties page. The grid layout allows you to quickly scroll down in the column for a specific setting, and verify
that the setting is correct in all of your instances.

You can sort your results in ascending or descending order for each column by clicking the column header. Right-
click a column header to select other column options, including grouping by the selected column, hiding a column,
or opening the Group By box for additional options.

Access the Server Configuration Properties view

SQL Diagnostic Manager provides two paths to access the Server Configuration Properties view. The first access
path is by clicking All Servers, and then clicking the Show Server Configuration Properties icon on the far right.
The second access path is by right-clicking All Servers, and then clicking View All Server Properties. By default,
the All Servers view displays your monitored SQL Server instances in the thumbnail view.
Performing general tasks in this view
The Server Configuration Properties view provides the following actions by right-clicking a row, and then selecting
the task you want to perform:

Open

Opens the Dashboard view for the selected monitored SQL Server instance.

Refresh Alerts

Gathers the alert status and refreshes the tree view information for the selected monitored SQL Server
instance.

Delete

Allows you to delete the SQL Server instance from your SQLDM installation. When you select Delete, SQL
Diagnostic Manager displays a message asking whether you want to retain the collected data for the
SQL Server instance, and it also allows you to cancel out of the deletion process.

@ You cannot retrieve collected data once it is deleted from the SQLdm Repository. Use the Delete option
with care.

Collapse All Groups

Allows you to collapse the contents of a group of monitored SQL Server instances.

Expand All Groups

Allows you to expand the contents of a group of monitored SQL Server instances.

Print

Allows you to print the grid of your monitored SQL Server instances and their configured properties.
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Export To Excel

Allows you to export the grid of your monitored SQL Server instances and their configured properties to
Microsoft Excel.

Properties

Opens the Monitored SQL Server Properties window for the selected instance.

Server Configuration Properties view contents

When you select the Server Configuration Properties view, SQL Diagnostic Manager displays a grid containing each
of the settings for all of your monitored SQL Server instances. This information is updated each time the SQLdm
Collection Service runs. Some cells allow you to make changes on this view while others are managed in other areas
in SQL Diagnostic Manager, which are accessible by double-clicking the cell you want to change. SQL Diagnostic
Manager displays the Change icon in the Changed? column for the row in which you made the change. Make sure
you click Save Changes once you made the necessary change. Click Reset Changes to revert all unsaved changes
you made on this view. The Change icon helps remind you to save your changes as shown in the following image.

H All Servers

Changed? Server Mame SQL Version SQL Edition Authentication Mode * Check Server Accessibility  Alert Refresh Database Statistics Refresh Maintenance Mode
- | SIDROCTSTO\SOL2014 | 50l Server 2014 RTM | Enterprise Edition (64-bit) | SOL Authentication:sa | 00:00:50 | 00:04:00 > | 01:00:00 > | Notset
SIDROCTSTONSQL2014 | S0L Server 2014 RTM | Enterprise Edition (64-bit)| SOL Authentication:sa | 00:00:30 I | 00:06:00 s | 01:00:00 >~ Motset

The Server Configuration Properties view contains the following properties:

Active Cluster Node

Displays the name of the active cluster node on this monitored SQL Server instance. For more
information about this setting, see Configure cluster settings.

Alert Refresh

Displays the interval (in hours, minutes, and seconds) between times when the service collects
diagnostic data and raises the associated alerts. Use a value between 30 seconds and 30 minutes. Lower
values result in a faster triggered alert, but also cause more frequent refreshes, which may increase
monitoring overhead. You can modify this setting directly in this view. Click in the appropriate field,
make your change, and then click Save Changes. For more information about this setting, see Set
general server options.

Authentication Mode

Displays the authentication mode used by the SQLdm Collection Service to collect diagnostic data from
the monitored SQL Server instance. For more information about this setting, see Set general server
options.

Activity Monitor Enabled

Displays whether monitoring of non-query activities is enabled. The monitoring of non-query activities
captures autogrow events, deadlocks, and blocks. For more information about this setting, see Set
activity monitor options.

Baseline Date Range

Displays the period of time over which the server baseline is calculated. For more information about this
setting, see Set server baseline options.
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Baseline Time Period

Displays the date range over which the server baseline is calculated. For more information about this
setting, see Set server baseline options.

Changed?

Displays an edit icon to indicate that this row includes a change from the last time the data was saved.
Click Save Changes to retain any changes made in this view. Click Reset Changes to revert to the most-
recently saved server configuration properties.

Check Server Accessibility

Displays the interval (in hours, minutes, and seconds) between times when the server availability is
verified. Use a value between 30 seconds and 10 minutes. If a select 1 query cannot execute in this
timeframe, then the server is considered unresponsive. Setting your server availability check to a very
low value may result in false positive alerts. You can modify this setting directly in this view. Click in the
appropriate field, make your change, and then click Save Changes. For more information about this
setting, see Set general server options.

Database Statistics Refresh

Displays the interval (in hours, minutes, and seconds) between times when the database space-related
data is collected and associated alerts are raised. Use a value between one minute and 24 hours. Setting
your database statistics refresh to a low value may result in false positive alerts. A low setting also causes
refreshes to occur more often, which increases the monitoring overhead. In environments with a large
number of databases whose sizes do not change rapidly, setting this refresh to a long interval can greatly
reduce your monitoring footprint. You can modify this setting directly in this view. Click in the
appropriate field, make your change, and then click Save Changes. For more information about this
setting, see Set general server options.

Deadlock Monitoring

Displays the current state of deadlock monitoring, which raises alerts for deadlocked sessions on your
monitored SQL Server instance. Deadlock monitoring is supported on monitored servers running SQL
Server 2005 or greater and is dependent on enabling the monitoring of non-query activities in the Activity
Monitor window. For more information about this setting, see Set activity monitor options.

Disk Collection Settings
Displays whether the connected disk drives are discovered automatically. For more information about
this setting, see Customize disk statistics.

Error Log Alerting Enabled

Displays whether error log alerting is enabled, causing a specific error log collector to run. Error log
alerting is considered enabled if either the SQL Server Agent Log or SQL Server Error Log alert is enabled.
Note that these collectors may negatively affect performance. You can reduce the impact of error log
reading by regularly cycling the server error logs. For more information about error log alerting, see
Configure alerts.

Fragmentation Min. Table Size (KB)

Displays the minimum size, in kilobytes, a table must meet before fragmentation statistics are collected.
Use a value between 0 KB and 999999 KB. Fragmentation statistics are only gathered on tables with
clustered indexes. You can modify this setting directly in this view. Click in the appropriate field, make
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your change, and then click Save Changes. For more information about this setting, see Edit table
statistics options.

InputBuffer Limiter

Displays the limit of the executions performed by the DBCC Inputbuffer. This command retrieves the
actual input command for the Session Details view, among others. Note that on busy servers, limiting
this value can reduce monitoring impact. For more information about this setting, see Set general server
options.

Job Alerting Enabled

Displays whether job alerting is enabled, causing a specific job alerts collector to run. Job alerting is
considered enabled if one of the following alerts is enabled:

+ SQL Server Agent Job Completion

+ SQL Server Agent Job Failure

» SQL Server Agent Long Running Job (Minutes)
+ SQL Server Agent Long Running Job (Percent)

For more information about job alerting, see Configure alerts.

Last Fragmentation Collection

Displays the date and time of the most recent, successful table fragmentation collection. This timestamp
is local to the monitored SQL Server instance. For more information about this setting, see Edit table
statistics options.

Last Table Growth Collection

Displays the date and time of the most recent, successful table statistics collection. This timestamp is
local to the monitored SQL Server instance. For more information about this setting, see Edit table
statistics options.

Linked Custom Counters (Count)

Displays the total number of custom counters monitored on this SQL Server instance. For more
information about this setting, see Link or tag custom counters.

Linked Custom Counters (List)

Displays the name for each custom counter monitored on this SQL Server instance. For more information
about this setting, see Link or tag custom counters.

Maintenance Mode

Displays the occasions when this server is in maintenance mode. Options include Never, Until further
notice, Recurring every week at the specified time, and Occurring once at the specified time. For
more information about this setting, see Schedule maintenance mode.

OS Metrics Collection

Displays whether SQL Diagnostic Manager uses OLE automation or a direct connection to Windows
Management Interface (WMI) to collect operating system and disk statistics. Disabling this setting
prevents the collection of certain metrics in SQL Diagnostic Manager, but may lessen the monitoring
overhead. For more information about this setting, see Configure OS metrics.
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Preferred Cluster Node

Displays the name of the preferred cluster node on this monitored SQL Server instance. You can modify
this setting directly in this view. Click in the appropriate field, make your change, and then click Save
Changes. For more information about this setting, see Configure cluster settings.

Query Monitor Enabled

Displays whether query monitoring is enabled. The Query Monitor collects poorly-performing queries
such as SQL batches, statements, stored procedures, and triggers. Low thresholds for query monitoring
may impact performance. For more information about this setting, see Set Query Monitor options.

Query Monitor Thresholds

Displays the various threshold types for query monitoring. Note that low thresholds for the query
monitoring impacts performance. For more information about these settings, see Set Query Monitor
options.

Query Waits

Displays the date and time when the query-level wait statistics are collected or whether they are
collected indefinitely. By default, these statistics are available only when the Query Waits view is open.
Collection of query waits is a performance-intensive operation. For more information about this setting,
see Configure wait monitoring.

Query Waits Filters

Displays the filter configuration of the query-level wait statistics for this monitored SQL Server instance,
including which applications, databases, and SQL text you want to exclude from the query wait statistics
collection. Collection of query waits is a performance-intensive operation and excluding unnecessary
data can reduce the monitoring footprint. For more information about this setting, see Configure
advanced query wait options.

Replication Monitoring Disabled

Displays whether replication statistics collection is disabled. Replication monitoring can cause excess
monitoring overhead in some environments and is not necessary for all servers. You can modify this
setting directly in this view. Click in the appropriate field to make your change, and then click Save
Changes. For more information about this setting, see Disable replication statistics collection.

Server Name

Displays the name of the monitored SQL Server instance.

Session History Browser Collection Disabled

Displays whether extended session data collection is disabled, including collection of session details,
locks, and blocks. Collection of this data allows you to view past session detail, lock, and block
information, but incurs extra monitoring overhead to provide this data. This data also requires extra
space in the SQLdm Repository. You can modify this setting directly in this view. Click in the appropriate
field to make your change, and then click Save Changes. For more information about this setting, see
Set general server options.

SQL Edition

Displays the edition of SQL Server software used in this instance.
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SQL Server ID

Displays the identification number of the monitored SQL Server as used internally by SQL Diagnostic
Manager. You cannot modify this value.

SQL Version

Displays the version of SQL Server software used in this instance.

Table Fragmentation Collection

Displays the days of the week and time of day when an attempt at table statistics collection occurs. For
more information about this setting, see Edit table statistics options.

Table Growth Collection

Displays the days of the week and time of day when an attempt at table statistics collection occurs. For
more information about this setting, see Edit table statistics options.

Table Statistics Excluded Databases (Count)

Displays the total number of databases excluded from table statistic collection. For more information
about this setting, see Edit table statistics options.

Table Statistics Excluded Databases (List)

Displays the name of each database excluded from table statistic collection. For more information about
this setting, see Edit table statistics options.

Virtualization Host Name

Displays the name of the host server on which this monitored SQL Server instance is running. This field
applies only to SQL Server instances running on a virtual machine. For more information about
virtualization configuration, see Configure virtualization.

VM Name

Displays the name of the virtual machine on which this monitored SQL Server instance is running. This
field applies only to SQL Server instances running on a virtual machine. For more information about
virtualization configuration, see Configure virtualization.
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Use the SQL Diagnostic Manager web console

The SQL Diagnostic Manager web console helps users identify and diagnose problems quickly in their SQL Server
environment. The SQL Diagnostic Manager web console provides key overview information simply through
dashboards and high level views.

«+ Access the overall status of your SQL Server environment from any connected browser. No SQL Diagnostic
Manager Desktop Console required.

« Provide an easy to use web console without giving access to the entire management console.

+ Quickly view status of a single instance or instance groups (tags) and drill down for details.

« View all active alerts in your SQL Server environment and access detailed information.

+ Select different sub-views to diagnose performance issues faster.

« Monitor overall health of queries and drill down through advanced query views for details.

« View your top values for selected metrics.
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Find answers

This documentation set includes a comprehensive online Help system as well as additional resources that support
you as you install and use the product. You can also search IDERA Solutions, available at the IDERA Customer
Service portal

View help topics
SQL Diagnostic Manager Help supports the following web browser minimum requirements:

« Internet Explorer IE 9.x+
+ Google Chrome

+ Mozilla Firefox

+ Edge Browser

Print help topics

You can print a help topic by selecting the topic in the table of contents, and then clicking the Print this topic icon
on the right side of the Help window.

Use the PDF if you want to print more than a single topic. To print, click the PDF tab, and then click the Print file
button. In the Print dialog box, select the pages you want to print before clicking Print.
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Customer support portal

The IDERA Customer Support Portal offers 24x7 worldwide support to all customers who hold a current
maintenance contract with IDERA and provides an easy and convenient way to:

« Submit or track technical support cases.

+ Search the IDERA Knowledge Base.

« Download the latest version of your IDERA products.

« Access information about your support plan and licenses.

«+ Access IDERA resources such as the community site, blog, product videos, and white papers.

Access the IDERA Customer Support Portal
IDERA SQL product customers can click this link to enter the portal: https://idera.secure.force.com/

For any questions regarding access to the Customer Support Portal, contact your IDERA Sales representative.
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Support Status
For Support Status, please see the SQL Tools Supported Versions page.
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Copy of Support Status

The table below provides a summary of the support status for SQL Diagnostic Manager. Please contact IDERA
Customer Support for further information.

Version Full Limited End of Life Release Limited EOL Date
Support Support Support

10.2 (v] June, 2017

10.1 (v] October, 2016 12/31/2017 12/31/201
8

10.0 (v] December, 2015 12/31/2017 12/31/201
8

9.1 (v) May, 2015

9.0 (v) February, 2015

8.6 (v) October, 2014 12/31/2017 6/6/2018

8.5 (v) August, 2014 12/31/2017 6/6/2018

8.0 (v] October, 2013 12/31/2017 6/6/2018

7.5 (v] October, 2012 6/1/2016 12/30/201
6

7.2 (v] March, 2012 6/1/2016 12/30/201
6

7.1 (v) January, 2012 6/1/2016 12/30/201
6

7.0 (v) October, 2011 6/1/2016 12/30/201
6

6.6 (v) February, 2011 6/1/2016 12/30/201
6

6.5 (v) November, 2010 6/1/2016 12/30/201
6

6.2 (v) August, 2010

6.1 (v] December, 2009

6.0 (v] May, 2009
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Version Full Limited End of Life Release Limited EOL Date
Support Support Support
5.7 0 January, 2009
5.6 (v) November, 2008
5.5 (v) May, 2008
5.0 (v) September,
2007
Pre-5.0 0
Definitions

« Full Support. Includes access to IDERA’s SQLDM customer support website with online resources such as an
extensive knowledge-base, product documentation, technical support via phone and online case tracking,
software downloads, end of life, and product alerts. Service Packs, patches, and hotfixes are delivered for
each fully supported version of software. Licensee may have to upgrade to the latest generally available
release in order to receive the above resolution mechanisms. Please note, the forgoing is a general
representation of IDERA’s support terms and is to be used only for informational purposes.

« Limited Support. Includes access to IDERA’s SQLDM customer support website with online resources such
as an extensive knowledge-base, product documentation, technical support via phone and online case
tracking, software downloads, end of life, product alerts, and access to existing product Service Packs,
patches and hotfixes. No new Service Packs, patches, or hotfixes will be provided for versions that are listed
under Limited Support. Licensees who have paid all applicable Support and Maintenance fees are eligible for
upgrading to the latest release. Please note, the forgoing is a general representation of IDERA’s support
terms and is to be used only for informational purposes.

+ End of Life. The process of retiring a product release. A product will reach its end of life either by subsequent
newer release (obsolescence) or IDERA Product Management has decided to discontinue a product and no
later version with the same functionality is commercially available from IDERA. Access to the latest release is
provided to a Licensee with a current Support and Maintenance contract, but no support is provided for End
of Life products.
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Installation and deployment

You can install SQL Diagnostic Manager and SQLDM Mobile in an environment of any size.

(® Toinstall the Trial for SQL Diagnostic Manager, review the guide in the Trial installation instructions.

Get ready for your SQL Diagnostic Manager and IDERA Dashboard deployment

« Check the supported installation scenarios

« Learn about the components and architecture
« Review system requirements

« View the installation instructions

Get ready for your SQLDM Mobile or IDERA Newsfeed deployment

« Check the supported installation scenarios

+ Learn about the components and architecture
« Review system requirements

« View the installation instructions

Get ready for your SQL Diagnostic Manager Console only deployment

« Check the supported installation scenarios

« Learn about the components and architecture
« Review system requirements

« View the installation instructions
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Supported installation scenarios

You can install and deploy SQL Diagnostic Manager, SQLDM Mobile, and the IDERA Newsfeed to meet your unique
SQL Server environment needs. SQL Diagnostic Manager also offers a SQL Diagnostic Manager Console-only
installation in environments that already have SQL Diagnostic Manager fully installed. For additional information
about this type of installation, see deploy SQL Diagnostic Manager Console only.

The following installation scenario descriptions assume you are deploying SQL Diagnostic Manager, SQLDM Mobile,
and IDERA Newsfeed in your environment.

@ In larger environments that contain more than one SQL Diagnostic Manager installation, consider
dedicating a SQLDM Mobile deployment per each SQL Diagnostic Manager application.

@ sQL Diagnostic Manager supports monitoring virtual SQL Server instances, such as those using VMware or
other virtualization software. For additional information about how SQL Diagnostic Manager works with
virtualization, see How SQL Diagnostic Manager works with a virtual environment.

(® SQL Diagnostic Manager supports running from Amazon EC2 or Azure laa$ environments.

Typical environment
This configuration includes the following installations:

+ SQL Diagnostic Manager Console on your workstation

+ SQLDM Mobile Web site on a Web Server for smartphone access

+ SQLDM Mobile and Newsfeed Service on the same computer that hosts the SQL Diagnostic Manager services
+ SQLDM Mobile Repository and SQL Diagnostic Manager Repository on the same SQL Server instance

Clustered environment

You can install and configure SQL Diagnostic Manager to monitor virtual SQL Servers. A virtual SQL Server is a SQL
Server running on a Microsoft failover cluster managed by Microsoft Cluster Services.

For SQL Diagnostic Manager to monitor virtual SQL Servers, you need to point SQLDM at the "Virtual" SQL Server
rather than the individual members of the cluster.

You can install and configure SQL Diagnostic Manager with its core services and repository databases on a Microsoft
failover cluster managed by Microsoft Cluster Services. For more information, review Deploy SQL Diagnostic
Manager in a clustered environment.

Web farm environment

You can install SQLDM Mobile in a Web farm to make sure this site remains accessible during a failover situation.
This configuration includes the following installations:

+ SQLDM Mobile on a Web Server in the farm

+ Typical SQL Diagnostic Manager installation

+ SQLDM Mobile and Newsfeed Service on the same computer that hosts the SQL Diagnostic Manager services
+ SQLDM Mobile Repository and SQL Diagnostic Manager Repository on the same SQL Server instance
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Non-trusted environment

You can install and configure SQL Diagnostic Manager and SQLDM Mobile to monitor SQL Server instances running
in non-trusted domains or workgroups.

This configuration includes the following installations:

+ SQL Diagnostic Manager Console on your workstation in a trusted or non-trusted domain

+ SQLDM Mobile Web site on a Web Server for smartphone access

+ SQLDM Mobile & Newsfeed Service on the same computer that hosts the SQL Diagnostic Manager services, in
a trusted or non-trusted domain

+ SQLDM Mobile Repository and SQL Diagnostic Manager Repository on the same SQL Server instance, in a
trusted or non-trusted domain
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Choose your deployment strategy
Before you begin installing SQL Diagnostic Manager, it is important to consider your deployment choices.

@ You can deploy SQLDM Mobile after you have installed SQL Diagnostic Manager. For more information,
review the SQLDM Mobile architecture and components, as well as requirements.

Trial deployment

A trial deployment installs each SQL Diagnostic Manager component on a separate, dedicated computer. The IDERA
evaluation license is fully functional and monitors up to 15 SQL Server instances anywhere on your network for a
period of 15 days. For more information, review the Trial installation instructions.

Production deployment

A production deployment installs each SQL Diagnostic Manager component on a separate, dedicated computer.
This deployment supports stable performance and availability as your environment grows and your monitoring
needs change.
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How SQL Diagnostic Manager works with a virtual environment

Virtual environments, such as those provided by Hyper-V or VMware, allow you to run multiple instances of
computers or "virtual machines" on a single, physical host server. These VMs create a virtual environment that
enables IT shops to more fully utilize the hardware they already have, allowing administrators to maintain fewer
physical servers which then consume less power, take up less real estate, and generate less heat.

While there are many advantages to using a virtual environment, there are some disadvantages. One is that a virtual
machine currently is not as fast or efficient as a standalone physical machine. Administrators must closely monitor
and manage their virtual environments because over-utilized hardware can quickly and severely impact the
performance of their servers, which are constantly waiting for physical resources to become available to process
their workloads.

SQL Diagnostic Manager includes VM monitoring to allow administrators to get a glimpse of what is going on inside
the virtual environment in which their SQL Servers are running, to make sure that their VMs and their host machines
are running at peak efficiency. This topic is a general outline of how SQL Diagnostic Manager works in a virtual
environment and includes links to other areas where you can find additional VM-specific information.

Using the hypervisor to manage resources

On the physical server hosting a virtual environment, there is a process called the hypervisor or virtualization
manager running in the background. The hypervisor manages the interactions between the virtual machines and
the physical hardware, manages resources, and then distributes the physical resources as required by each of the
VMs it is hosting.

An administrator can intentionally over commit resources on a physical host with the idea that it is unlikely that all
of the VMs need to utilize all of the resources on the host at the same time. The hypervisor is also affected by this
shift, and manages any occasion when all of the active VMs need more physical resources than is available from the
host. Note that there are ramifications for the extra processing that is occurring when the hypervisor is taxed. This
additional processing is the overhead for a virtual environment and consumes CPU, memory, and network
resources.

How SQL Diagnostic Manager collects and presents metrics involving a virtual environment

The guest operating system on a VM operates no differently than it does when running on a physical machine with
full access to all of the resources at its disposal. But the machine hosting the VM operates differently because of the
virtual environment. The physical resources of the host are shared with the other VMs on the host. Due to the
additional overhead of virtualization, and the hypervisor managing contention for resources, the metrics that the
guest OS reads as utilization of its resources are not entirely accurate as they do not take into account that
virtualization overhead, nor does it measure that it is waiting on physical resources to process its workload.

The image below shows a typical virtualized environment with VMware. In this environment, the ESX/ESXi
hypervisor on each individual host server collects the performance statistics and reports the data back to a central
vCenter Server. SQL Diagnostic Manager then collects that information from the vCenter Server in order to show
those statistics along with the other SQL related performance information.
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‘SQL diagnostic manager™

vCenter Server

ESX/ESXi Hypervisar ESX/ESKi Hypervisor ESX/ESXi Hypervisor

ESX/ESXi Hypervisor

VM VM VM VM VM VM VM VM VM VM ¥ VM

In virtualized environment with Hyper-V, the process of how SQL Diagnostic Manager collects and presents metrics
is slightly different from that of a VMware setup. In this environment, SQL Diagnostic Manager collects all the
required performance statistics from the Hyper-V host server and virtual machines using the WMI interface. See
Hyper-V user requirements for information on how to successfully collect host and VM metrics.
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e SQL diagnostic manager ™

Hyper-V Host Hyper-V Host Hyper-V Host Hyper-V Host
Server Server Server Server
VM VWM WM VM VM VM VWw VW VM VM VM VM

SQL Diagnostic Manager displays virtual machine and host metrics as collected from the perspective of the physical
host. In other words, these are the “true” physical metrics. Whereas, the metrics that SQL Diagnostic Manager
displays for the OS on a virtualized machine are what Microsoft Windows calculates as using without regard to any
overhead. For example, SQL Diagnostic Manager displays the OS CPU Usage at 35%, but metric displayed for the VM
CPU Usage is 38%. This discrepancy results from the additional overhead within the hypervisor used to run the VM,
and the VM is charged for the additional processing.

Link a monitored virtual SQL Server instance to the vCenter Server or Hyper-V host server

To link a monitored virtual SQL Server instance to the host server that manages your VMs, click Tools
> VM Configuration to access the VM Configuration window. SQL Diagnostic Manager displays the current
relationships between your available virtualization host servers and your monitored SQL Server instances. For more
information about linking a monitored virtual SQL Server instance to a vCenter Server or Hyper-V host server, see
Configure your virtual machine connections.

VM data collection

The VM collector connects to your virtualization host server (vCenter Server or Hyper-V host server) during the
scheduled refresh for each of your monitored virtual SQL Server instances. If the SQL Diagnostic Manager
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Management Console is open to the Overview Dashboard or any Resources view for a specific instance, data is also
collected based on the Server View Refresh setting in the Console Options page. In this situation, it is possible that
the collector connects to the virtualization host server and virtual machines every few seconds.

You can adjust the scheduled refresh rate for a monitored virtual SQL Server instance by right-clicking the instance
name, and then selecting Properties.

Differences in statistics

You may notice some difference in your statistics, such as SQL Diagnostic Manager displaying a higher
0S CPU usage than your VM CPU usage. While the hypervisor manages resources efficiently, it is possible that the
demand for physical resources is greater than what is available. For example, a guest OS on a virtual machine
submits a batch of work to a CPU. However, all of the physical CPUs are committed to other work, so there is no
physical CPU available on the host to process the work. In this situation, the VM waits for a CPU to become available
to process its work. While it is waiting, the guest OS is unaware of the wait and assumes that it is simply taking
longer for the CPU to process this batch of work, and the OS thinks it is using more CPU power than it is actually
using.

Remember that SQL Diagnostic Manager uses the additional overhead of the hypervisor to calculate the VM metrics.
In this situation, the hypervisor knows the VM is just waiting for a CPU, so it does not charge the VM for CPU
processing power while it is waiting. The result is that the guest OS reports that it is using the additional processing
power, however the hypervisor simply reports what is actually used. In this situation, your CPU usage metrics that
are reported by Windows are higher than what is reported by VMware or Hyper-V for that VM.

Available metrics related to your VMs

A monitored virtual SQL Server instance appears in the Servers pane in the same way as a monitored physical
SQL Server instances. Click the appropriate virtual instance, and SQL Diagnostic Manager displays the same
dashboard panels as for a monitored physical SQL Server instance, but also include specific metrics for the VM and
host server.

The following dashboard panels include VM- or host-related information:

+ CPU panel - Includes VM and Host usage metrics. The information available in this panel comes from the
Server Details and Resources Summary views.

« Memory panel - Includes the VM Memory Usage and Host Memory Usage charts. The information available in
this panel comes from the Server Details and Resources Summary views.

+ Network panel - Includes the VM Network Usage Throughput and Host Network Usage Throughput charts.
The information available in this panel comes from the Server Details and Resources Summary views.

« VM Disk Usage panel - Includes the amount of data read from and written to disk for this VM during the
sample interval. The information available in this panel comes from the Resources Disk view.

+ Host Disk Usage panel - Includes the amount of data read from and written to disk for this host server during
the sample interval. The information available in this panel comes from the Resources Disk view.

« Virtualization panel - Includes the Virtual Memory Usage and Virtual Disk Usage charts plus the CPU Ready
Wait Time gauge. The information available in this panel comes from the Server Details view.

Use the available virtualization alerts and VM-related reports to get the most information regarding your monitored
virtual SQL Server instances and host servers.

Available VM-related reports

« Virtualization Statistics Report
« Virtualization Summary Report
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Available virtualization alerts

» Host CPU Usage Alert

» Host Memory Swap Detected alert

» Host Memory Usage Alert

» Host Power State Alert

« VM CPU Ready Wait Time Alert

» VM CPU Usage Alert

+ VM Host Server Change Alert

« VM Memory Swap Delay Detected Alert
+ VM Memory Usage Alert

» VM Power State Alert

« VM Reclaimed Ballooned Memory Alert
» VM Resource Configuration Change Alert
» VM Resource Limits Detected Alert
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Hyper-V user requirements

In virtualized environment with Hyper-V, the process of how SQL Diagnostic Manager collects and presents metrics
is slightly different from that of a VMware setup. To successfully collect Hyper-V host metrics, the user needs access
to the WMI credentials on the host server. These credentials are established on the Virtualization Host
Configuration window (Tools >VM Configuration >New or Tools >VM Configuration >View/Edit)

In addition, to successfully collect VM metrics, the user needs access to the WMI credentials on the VM. These
credentials are established under on the OS Metrics tab of the Monitored SQL Server Properties window (right-
click on the monitored instance name and select Properties).
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Trial installation instructions

This procedure guides you through SQL Diagnostic Manager Trial installation.

& The Trial does not include the IDERA Dashboard. If you wish to try it contact IDERA Sales.

Start your Trial SQL Diagnostic Manager installation

You can install SQL Diagnostic Manager on any computer that meets or exceeds the product requirements.

To start installing SQL Diagnostic Manager:

1. Run Setup.exeinthe root of the Trial installation kit.
2. Click Install SQL Diagnostic Manager on the Quick Start window.
3. Onthe Welcome window of the setup program, click Next.

Welcome to the 5QL Diagnostic Manager Setup wizard

The SQL Diagnostic Manager setup wizard helps you install or upgrade
IDERA SQL Diagnostic Manager.

This trial does not include the IDERA Web Dashboard. Fora
demonstration of SGQL Diagnostic Manager with IDERA \web Dashboard,
please send email to sales@idera.com or contact vour IDERA account
Manager.

WARMING: This program is protected by copyright law and internations
treaties

. Back |[ Nex |[ cancel |

4. Review the license agreement. To accept this license agreement, click | accept the terms and conditions of
this License Agreement, and click Next.
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End-User License Agreement

Please read carefully the following License Agreement

SOFTWARE LICENSE AGREEMENT
Idera, Inc.
2850 North Loop Freeway West
Suite 700
Houston, Texas 77052
Phone; (713) 362-5250; Fax: {713} B62-5210

BY PROCEEDING TO DOVWHNLOAD, INSTALL OR USE THE SOFTWARE
IH WHICH THIS AGREEMENT 15 ELECTRONICALLY EMBEDDED OR BY
OBTAINING A LICENSE KEY FOR THIS SOFTWARE, YOU HEREBY
ACKNOWLEDGE AND AGREE TO BE BOUND BY THE FOLLOWING
TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THESE
TERMS AND CONDITIONS, THEN CLICK “DO NOT ACCEPT." DO NOT
INSTALL OR USE THE SOFTWARE AND DELETE THE 50FTWARE
FROM YOUR COMPUTER 5YSTEM. BY INSTALLING OR USING THE
SOFTWARE OR BY CLICKING ON “ACCEPT" YOU ACKNOWLEDGE

AR A STVET TIIAT ML PICIEA R T A SEmimm Tl A BRI T RATRE ST

[#] | accept the terms and conditions of this License Agreement

Back || Next || Cancel |

5. Choose the components you want to install by selecting the respective check boxes. By default, the setup
program installs SQLDM Console, and SQLDM Repository and Services, allowing you to immediately begin
monitoring your SQL Server environment, and click Next.
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Customize your SQLdm setup

Flease select the SCLdm components you want to install.

[ SGLDM Console

[« SQLOM Services and Fepository

| Back || Next |[ cancel |
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6. On the Service Account window, type the appropriate credentials in the provided fields. Click Next.

Service Account

Specify the service account for SGL Diagnostic Manager. The service
accourts will be used to collect information and to log into the applications.

Senvice Account for SQLDM

Domain \ UserName: | W12R2\Administrator
Password: |'----*-|
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7. On the SQL Diagnostic Manager Repository Database screen, specify SQL Server instance and the name of
the SQLDM Repository database you want to use.

SQL Diagnostic Manager Repository Database

Please provide the 5GL Server instance and the name of the Repositony
database for SGL Diagnostic Manager.

SQL Server Instance: |[@H
Database Name: |SGLdeEpusitur';

Connection Credentials: By default, the setup program uses the Windows
credentials you provided to create the repositony.

[ ] Use Microsoft SGL Server Authentication | Change |

if you want the SQLDM Management Service to use SGL Server
authentication to connect to the SGLOM Repasitany, select the following
check box:

[] Use Microsoft SGIL Server Authentication

& When your SQL Server environment uses SQL Server Authentication, select the respective check
box, and click Change to enter SQL Server credentials. And, if you use Microsoft SQL Server
Authentication, a new window displays where you can type the respective SQL Server login and
password.

8. You can use the default install location or specify a different path. For your first install, we recommend using
the default location. Click Next to continue with the installation.
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Choose a destination folder

Please provide us the destination folder where you want to install the componentis):

S0L DM: C\Program Filesldera®ldera SGL diagnostic mana|

Install this application far:

®) Anyone who uses this computer (all users)
) Oy for me ([Cument User)

| Back || Nemt || cancel |

9. Click Install to indicate that you are ready to complete your installation with the configurations you
specified. Click Back, if you want to review or change your installation settings.
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Ready to Install

Ready to install IDERA SGL Diagnostic Manager.

Setup will grant this account access to IDERA 5GL Diagnostic Manager :

SGL DM Service Account: WI12R2\Administrator

Click: Install to begin the installation process. Click Back to review or change your
installation settings. Click Cancel to exit the wizard.

| Back || Install || Cancel |

10. Click Finish to exit the IDERA SQL Diagnostic Manager Setup.
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Deploy the IDERA Dashboard and SQL Diagnostic Manager
Use the following links to prepare for your IDERA Dashboard and SQL Diagnostic Manager deployment:

« Check the supported installation scenarios

« Learn about the components and architecture

+ Review system requirements for the IDERA Dashboard and SQL Diagnostic Manager
« View the installation instructions

+ Loginthe IDERA Dashboard and SQL Diagnostic Manager web console
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Product components and architecture

The IDERA Dashboard and SQL Diagnostic Manager consist of a light, unobtrusive architecture that easily runs in
your SQL Server environment with minimal configuration. All components run outside and separate from SQL
Server processes.

« Learn about the components and architecture of the IDERA Dashboard.
« Learn about the components and architecture of the SQL Diagnostic Manager.
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IDERA Dashboard components and architecture

The IDERA Dashboard provides web and back end services, shared across multiple IDERA products. To learn more
about what the IDERA Dashboard is and how it works, see Navigate the IDERA Dashboard.

The IDERA Dashboard consists of the following components:

« Web Application Service
» Core Service
« Core Repository

IDERA Dashboard

Web Application Service SQlLdm SQLdm
Manager Plug-in Manager Plug-in

Care Views

i Views & Views &
Widget
i Widgets Widgets {{  Web Console
; ~ S 7
Core Senvice Rt e >
Core ) SQLdm SQLdm
Module Add-in Module Add-in Moduls
~
N
2t ~
. S ~
Core Repository
——
* Service + Service

- Repository - Repository

Web Application Service

The Web Application Service is a Windows service that wraps Apache Tomcat server. The Web Application Service
serves up dashboard (IDERA Dashboard) and SQLdm views and widgets that are displayed in the web console. The
Web Application Service requires three ports:

« Standard HTTP port (by default 9290)
+ Monitor port (9094)
« SSL port (9291)
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Core Service

The Core Service is a C# (.NET 4.0 Framework) based Windows service that hosts dashboard and SQLDM REST APIs
that are used by the Web Application Service to configure and retrieve data. In addition, the Core Service handles
product registration, security, configuration, product data, and event aggregation.

The Core Service uses two ports, one for REST APl and the other for .NET remoting:
« Core Service REST API port (by default 9292)
+ .NET remoting port (by default 9293)

Core Repository

The Core Repository is a database where all dashboard configuration and aggregated data is stored. The Core
Repository database is hosted on a SQL Server instance and is accessed by the Core Service to retrieve data.
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SQL Diagnostic Manager components and architecture

SQL Diagnostic Manager consists of a light, unobtrusive architecture that easily runs in your SQL Server
environment with minimal configuration. All SQL Diagnostic Manager components run outside and separate from
SQL Server processes.

SQL Diagnostic Manager Console

Use the SQL Diagnostic Manager Console to:

+ View real-time status

« Configure alert notifications on specific metric thresholds at the server and database levels
« View historical reports

+ Perform administrative functions

The SQL Diagnostic Manager Console retrieves historical information directly from the SQL Diagnostic Manager
Repository. All real-time requests use the SQL Diagnostic Manager services to poll the monitored SQL Server.
SQL Diagnostic Manager Services

SQL Diagnostic Manager has four centralized services, the Management Service, the Collection Service, the
Predictive Service, and Rest Service. These four services reside on the same computer.

The Management Service
The Management Service performs the following primary functions:

+ Provides real-time data to the SQL Diagnostic Manager Console
+ Receives historical data from the Collection Service for storage in the Repository
+ Raises alerts and sends alert notifications

The Collection Service
The Collection Service performs on-demand and scheduled collection from the monitored SQL Servers.

The Predictive Service
The Predictive Service is used for Alert Forecasting and performs the following primary functions:

+ Calculates the Alert Forecast every hour
« Builds a forecasting model once a day

The Rest Service

SQL Diagnostic Manager Plug-in

When SQL Diagnostic Manager is registered with the IDERA Dashboard, the product plug-in module is deployed. The
SQL Diagnostic Manager plug-in consists of web views and widgets and a.NET based add-in module (SQL
Diagnostic Manager add-in). The web views and widgets are deployed in the Web Application Service of the IDERA
Dashboard, and the SQL Diagnostic Manager add-in in the Core Service of the same.

The Web Application Service dynamically loads in SQL Diagnostic Manager's views and widgets and makes them
available to web console users. The views and widgets use the SQL Diagnostic Manager add-in REST APIs to retrieve
data. Likewise, the SQL Diagnostic Manager add-in retries data from the product services and Repository.

SQL Diagnostic Manager Repository

The SQL Diagnostic Manager Repository is a centralized SQL Server database that stores collected metrics on a
scheduled basis, historical data, and alerts information. The SQL Diagnostic Manager Repository also stores
configuration information, such as the credentials used to monitor a registered SQL Server instance.
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@ SQL Diagnostic Manager 10.1 and later requires Microsoft SQL Server 2005 or above running on the
computer that hosts the SQL Diagnostic Manager Repository database for all installations.

Authentication in SQL Diagnostic Manager

SQL Diagnostic Manager uses the same types of authentication available in the SQL Server security model. When
specifying account credentials for the SQL Diagnostic Manager services, you can use Windows Authentication or
SQL Server Authentication.

When considering which authentication to use, keep in mind that SQL Server Authentication is required when no
domain trust exists between the SQL Diagnostic Manager Services computer and the computers hosting the
monitored SQL Server instances. For example, if the monitored SQL Server instances are located in an untrusted
domain or behind a firewall, you must use SQL Server Authentication to successfully deploy SQL Diagnostic

Manager. In this case, you must use the sa account or a SQL Server login that has System Administrator
permissions.

For more information about these authentication types and the SQL Server security model, see the Microsoft
document, Authentication in SQL Server.
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Product requirements

The IDERA Dashboard and SQL Diagnostic Manager consist of a light, unobtrusive architecture that easily runs in
your SQL Server environment with minimal configuration. Review system requirements for the IDERA Dashboard

and SQL Diagnostic Manager.

« Learn about the IDERA Dashboard requirements.
+ Learn about the SQL Diagnostic Manager requirements.
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IDERA Dashboard and web console requirements

To successfully install the IDERA Dashboard and SQL Diagnostic Manager web console you need to comply with the
requirements described in the Software Requirements page for the IDERA Dashboard.

© The IDERA Dashboard Web Application service comes with SSL already set up. For more information on
running the IDERA Dashboard over SSL, see Run the Idera Dashboard over SSL (HTTPS).
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SQL Diagnostic Manager requirements

There are three types of SQL Diagnostic Manager installation (Trial, General, and Production). Refer to the following
list of requirements for each type of installation.

@ QL Diagnostic Manager 10.5 requires Microsoft SQL Server 2005 or above running on the computer that
hosts the SQL Diagnostic Manager Repository database for all installations.

& Tempdb monitoring is supported on SQL Server 2005 and above servers only.

@ Torun PowerShell scripts, upgrade to PowerShell 3.0 or higher. This upgrade is required to use the
PowerShell snap-in.

Trial requirements

Consider the following requirements when installing all SQL Diagnostic Manager components on one computer.

Type Requirement

SQL Server Standard or Enterprise Edition « SQL Server 2005 SP1 or later

« SQL Server 2008 or later

« SQL Server 2008 R2

« SQL Server 2012

« SQL Server 2014

« SQL Server 2016

o SQL Server 2017

« SQL Server 2019

Hard Disk Space 200 MB for all SQL Diagnostic Manager components

Windows Permissions Your Windows Logon account includes local Administrator
permissions

SQL Server Privileges Either a Windows user account or SQL Server login that

includes System Administrator privileges on the monitored
SQL Server instances

General requirements

The following requirements apply for all SQL Diagnostic Manager components.

Type Requirement

CPU 2.0 GHz or higher
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Type Requirement

Memory 1GB

Operating System « Windows Server 2008 SP1+
« Windows Server 2008 R2
« Windows 7
« Windows Server 2012
« Windows 8
« Windows Server 2012 R2
« Windows 10
« Windows Server 2016
« Windows 2019

Port Access 5166,5167,5169

Client Browser Internet Explorer 7.0 or later

Production requirements

Consider the following requirements when installing SQL Diagnostic Manager in an environment where the
components are on separate computers.

SQL Diagnostic Manager Console

Type Requirement

Disk Space 40 MB

SQL Server Permissions Your Windows login account includes Read Access to the SQL Diagnostic Manager
Repository. You can specify a SQL Server login instead.

Monitor Resolution 1280 x 1024 with small text for the best viewing of the SQL Diagnostic Manager
Dashboard

SQL Diagnostic Manager Services

Type Requirement

Disk Space 50 MB

Collection Service Permissions For more information, review the User Creation Scripts.
Management Service Permissions Sysadmin fixed server role on SQL Diagnostic Manager

Repository instance
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Type
Linux - SQL Server Server 2017 (Monitored SQL

Instances only)

Windows Runtime Components

SQL Diagnostic Manager Repository

SQL Diagnostic Manager for SQL Server

Requirement

+ Red hat Enterprise 7.3 or Higher
« SUSE Enterprise v12 SP2 or Higher
« Ubuntu 16.04LTS and 16.10 or Higher

« Microsoft .NET 4.0 SP2 (Minimum)
« Microsoft .NET 4.6.2+ (Recommended)
« MDAC2.8

@ SQL Diagnostic Manager 7.2 and later includes a repository autogrow setting at 32 MB, which is sufficient
for trial and small environments in production. Environments with larger, multi-server installations should
change the repository autogrow setting to 250 MB or higher to prevent frequent data file autogrow, which
can cause performance problems. Using percentage-based autogrow is not recommended.

Type

Disk Space

SQL Server Express, Standard, or Enterprise Edition

Cloud Deployment

Monitored SQL Server Instances

Requirement

1GB to 3GB for one year of data per monitored SQL
Server instance

« SQL Server 2005

« SQL Server 2008 or later

« SQL Server 2008 R2

« SQL Server 2012

« SQL Server 2014

« SQL Server 2016

« SQL Server 2017 (Windows & Linux)
« SQL Server 2019

« AzurelaaS VM Linux (SQL Server 2017)
« Amazon AWS laaS VM Windows
« Amazon AWS laaS Linux (SQL Server 2017)
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Type

SQL Server Express, Standard, or Enterprise
Edition

Cloud Deployment

@ Aws

SQL Diagnostic Manager for SQL Server

Requirement

SQL Server 2000 SP4 or later
SQL Server 2005 SP1 or later
SQL Server 2008 SP1

SQL Server 2008 R2

SQL Server 2012

SQL Server 2014

SQL Server 2016

SQL Server 2019

SQL Server 2017 (Windows & Linux)
SQL Server Express 2008
SQL Server Express 2008 R2
SQL Server Express 2012
SQL Server Express 2014
SQL Server Express 2016
SQL Server Express 2017
SQL Server Express 2019
SQL Azure

Amazon RDS

Azure DB: Single, Elastic Pool, Managed Instance.

Amazon RDS SQL: SQL Server 2008, SQL Server2008 R2,
SQL Server 2012, SQL Server 2016, SQL Server 2017

Azure laaS VM Windows (All SQL Versions)
Azure laaS VM Linux (All SQL Versions)
Amazon AWS laaS VM Linux (SQL Server 2017)

Review the Minimum permissions to monitor an Amazon RDS instance with SQL Diagnostic Manager.

This topic provides the minimum requirements for installing SQL Diagnostic Manager. For more information about
installation requirements, view SQL Diagnostic Manager Hardware Sizing guidelines.

SQL Diagnostic Manager Management Pack and SCOM support requirements

The IDERA SQL Diagnostic Manager Management Pack for integration with SCOM is designed for System Center
Operations Manager 2007 R2 and above. For more information about SQL Diagnostic Manager MP and SCOM
installation, see Install and configure the SQL Diagnostic Manager Management Pack for SCOM.
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Minimum permissions to monitor an Amazon RDS instance

To monitor an Amazon RDS instance using SQL Diagnostic Manager, you have to create a SQL Server user on the
instance with the following minimum permissions:

Server Roles:
public, processadmin, setupadmin
Databases:

public on TempDB
sysadmin server role equivalent privileges for monitored databases

Securables:

Server Object:
Alter any connection
Alter any linked server
Alter any login
Alter any server role
Alter server state
Alter trace
Connect SQL
Create any database
Create server role
View any database
View any definition

View server state
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SQL Diagnostic Manager Hardware Sizing guidelines

The following guidelines provide an estimation of the hardware resources required to deploy SQL Diagnostic
Manager depending on the number of servers you want to monitor with SQLDM.

Installs under 20 servers

Single-server deployment - Includes the SQL Diagnostic Manager Services and the SQL Server hosting the SQLdm
Repository (clustered for redundancy).

Type

Operating System

Memory
CPU
SQLdm Repository size

SQL Server version

Requirement

Windows Server 2008R2

Windows Server 2012

Windows Server 2016

8GB

Intel® Xeon® E5-2430 2.20GHz (6 Core)
Approximately 50GB

SQL Server 2008R2 standard edition or higher

(® The expected repository growth is approximately 1.5-3 GB per monitored instance for a year worth of
collected data. Monitoring 15 instances could gather approximately 45 GB over the course of a year.

Installs 20-50 servers

Single-server deployment - Includes the SQL Diagnostic Manager Services and the SQL Server hosting the SQLdm
Repository (virtualized/clustered for redundancy).

Type

Operating System

Memory
CPU
SQLdm Repository size

SQL Server version

Requirement

Windows Server 2008R2

Windows Server 2012

Windows Server 2016

16 GB

Intel® Xeon® E5-2430 2.20GHz (6 Core)
Approximately 150GB

SQL Server 2008R2 standard edition or higher

® The expected repository growth is approximately 1.5-3 GB per monitored instance for a year worth of
collected data. Monitoring 30 instances could gather approximately 90 GB over the course of a year.

Installs 51-200 servers
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Dual-server deployment - First server hosts the SQL Diagnostic Manager Services and second server hosts the SQL
Server and the SQLdm Repository database.

» Machine 1 - Hosting the SQL Diagnostic Manager services (virtualized/clustered for redundancy)
Type Requirement

Operating System  Windows Server 2008R2
Windows Server 2012
Windows Server 2016

Memory 8-16 GB

CPU Intel® Xeon® E5-2430 2.20GHz (6 Core)
« Machine 2 - Hosting the SQL Server and the SQLdm Repository (clustered for redundancy)

Type Requirement
Operating System Microsoft Windows Server 2008R2
Windows Server 2012
Windows Server 2016
Memory 16 GB
CPU Intel® Xeon® E5-2430 2.20GHz (6 Core)
SQLdm Repository size  200-600GB

SQL Server version SQL Server 2008R2 standard edition or higher

Installs 201-300 servers
Dual-server deployment - First server hosts the SQL Diagnostic Manager Services and second server hosts the SQL
Server and the SQLdm Repository database.

« Machine 1 - Hosting the SQL Diagnostic Manager services (virtualized/clustered for redundancy)
Type Requirement

Operating System  Windows Server 2008R2
Windows Server 2012
Windows Server 2016

Memory 16 GB

CPU Intel® Xeon® E5-2450 2.10GHz (8 Core)
+ Machine 2 - Hosting the SQL Server and the SQLdm Repository (clustered for redundancy)
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Type Requirement
Operating System Windows Server 2008R2
Windows Server 2012
Windows Server 2016
Memory 32GB
CPU Intel® Xeon® E5-2450 2.10GHz (8 Core)
SQLdm Repository size 600 GB or more

SQL Server version SQL Server 2008R2 standard edition or higher

Installs over 300 servers
Dual-server deployment - First server hosts the SQL Diagnostic Manager Services and second server hosts the SQL
Server and the SQLdm Repository database.

« Machine 1 - Hosting the SQL Diagnostic Manager services (virtualized/clustered for redundancy)
Type Requirement

Operating System  Windows Server 2008R2
Windows Server 2012
Windows Server 2016

Memory 32GB

CPU Intel® Xeon® E5-2450 2.10GHz (8 Core)
+ Machine 2- Hosting the SQL Server and the SQLdm Repository (virtualized/clustered for redundancy)

Type Requirement
Operating System Windows Server 2008R2
Windows Server 2012
Windows Server 2016
Memory 32GB
CPU Intel® Xeon® E5-2450 2.10GHz (8 Core)
SQLdm Repository size 900 GB or more

SQL Server version SQL Server 2008R2 standard/enterprise edition

Sample installations in large environments
See the following sample customer installations for users with large environments:
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Installs 51-100 servers
Type

Number of monitored servers

Services and Repository installed on same machine

SQL Diagnostic Manager for SQL Server

In-House Use

52

Hyper-V

+ 4 quad core processors
+ 14 GB of memory
» Windows Server 2008 R2 Enterprise

Data storage and grooming options + Repository size: 120 GB

+ Retain 60 days of history

Monitoring features Monitor Windows and SQL Server performance and

error log monitoring

Type In-House Use
Number of monitored servers 90
Services machine « 2vCPU
+ 8 GB of memory
« Windows Server 2008 R2 Enterprise
Services machine « 2vCPU

+ 8 GB of memory
« Windows 2008 R2 Enterprise
« Repository: SQL Server 2008 R2

Data storage and grooming options » Repository size: 100 GB
+ Retain 60 days of history

Monitoring features Monitor Windows and SQL Server performance

Installs 201- 300 servers

Type In-House Use

Number of monitored servers 234

Services and Repository installed on same + Dell2950

machine + 2 quad core processors

+ 16 GB of memory
« Windows Server 2003
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Type In-House Use

Data storage and grooming options + Repository size: 140 GB
« Retain 30 days of history

Monitoring features Monitor Windows and SQL Server performance and use
Query Waits for specific periods of diagnostics

Integrations Send alerts to HP Open View via a command line program
(opcmsg)

Type In-House Use

Number of monitored servers 274

Services and Repository installed on same machine + 4 quad core processors
+ 128 GB of memory
« Windows Server 2008 R2

Data storage and grooming options + Repository size: 1.5 TB
« Retain 365 days of history

Monitoring features Monitor Windows and SQL Server performance
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Install SQL Diagnostic Manager in silent mode

In addition to the Setup Wizard, SQL Diagnostic Manager allows you to use the Microsoft installer in silent or quiet
mode and to simplify SQL Diagnostic Manager deployment.

To run silent installation using Windows Authentication, type the following command-line in the Command Prompt
window:

"path_to_exe_file" /v"/Lxv C:\test.log
INSTANCE="SQLServerInstanceName"
REPOSITORY="SilentSLQdmDatabase"
SETUPTYPE="Typ1ical"
SERVICEUSERNAME="domain\username"
SERVICEPASSWORD="password"
SQLSERVER_AUTHENTICATION="0"
SERVICE_SQLAUTHENTICATION="Q" /quiet"

To run silent installation using SQL Authentication, type the following command-line in the Command Prompt
window:

"path_to_exe_file" /v"/Lxv C:\test.log
INSTANCE="SQLServerInstanceName"
REPOSITORY="SilentSLQdmDatabase"
SETUPTYPE="Typ1ical"
SERVICEUSERNAME="domain\username"
SERVICEPASSWORD="password"
SQLSERVER_AUTHENTICATION="1"
SQLSERVER_USERNAME="username”
SQLSERVER_PASSWORD="password”
SERVICE_SQLAUTHENTICATION="0"
SERVICE_SQL_USERNAME=”SQLServerUserName”
SERVICE_SQL_PASSWORD="SQLServerpassword” /quiet"

Select a setup type for your installation

You can choose which setup type to run by specifying Typical, Console, or Services in the SETUPTYPE field.

« The Typical setup type, the recommended option, installs the console, the SQL Diagnostic Manager services,
and the repository.

« The Console setup type installs only the console.

« The Services setup type installs the SQL Diagnostic Manager services and the repository.
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How to install the IDERA Dashboard and SQL Diagnostic Manager
This procedure guides you through the installation of the IDERA Dashboard and SQL Diagnostic Manager.

& To perform a silent mode installation, see Install SQL Diagnostic Manager in silent mode.

Start your IDERA SQL Diagnostic Manager installation

You can install the IDERA Dashboard and SQL Diagnostic Manager on any computer that meets or exceeds the
product requirements.

To start installing the IDERA Dashboard and SQL Diagnostic Manager:

Log on with an administrator account to the computer on which you want to install SQL Diagnostic Manager.
Run Setup.exe in the root of the installation kit.

Click Install SQL Diagnostic Manager on the Quick Start window.

On the Welcome window of the setup program, click Next.

" IDERA 50L Diagnostic Manager Setup (version 10.5) >

Ll N S

Welcome to the SQL Diagnostic Manager Setup wizard

The S4L Diagnostic Manager Setup Wizard sllows you to
install/upgrade SGL Diagnostic Manager and the IDERA
Dashboard.

The IDERA Dashboard provides a common web console for

muttiple IDERA products in a conscolidated view to help you
simplify your administration tasks.

If you need assistance during the instsllation process, click
here for installation instructions.

WARMING: This program is protected by copyright law and
international treaties.

Back Cancel |
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5. Review the license agreement. To accept this license agreement, click | accept the terms and conditions of
this License Agreement and then click Next.

£ IDERA 50L Diagnostic Manager Setup .

End-User License Agreement

Please read carefully the following License Agreement

SOFTWARE LICENSE AGREEMENT -
Idera, Inc.
2850 North Loop Freeway West
Suite 700
Houston, Texas Y7052
Phone; (713) 862-5250; Fax: (713) 862-5210

BY PROCEEDING TO DOWNLOAD, INSTALL OR USE THE 5O0FTWARE
IN WHICH THIS AGREEMENT 15 ELECTRONICALLY EMBEDDED OR BY
OBTAINING A LICENSE KEY FOR THIS SOFTWARE, YOU HEREBY
ACKNOWLEDGE AND AGREE TO BE BOUND BY THE FOLLOWING
TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THESE
TERMS AND CONDITIONS, THEN CLICK “DO NOT ACCEPT," DO HOT
INSTALL OR USE THE SOFTWARE AND DELETE THE SOFTWARE
FROM YOUR COMPUTER SYSTEM. BY INSTALLING OR USING THE
SOFTWARE OR BY CLICKING ON “ACCEPT" YOU ACKNOWLEDGE

AN &S IVET TR AT S FICILA T O WO T A BT RS TR AT ST T

W

| acoept the terms and conditions of this License Agreement

sade | =

6. Choose the components you want to install by selecting the respective check boxes. By default, the setup
program installs SQL Diagnostic Manager Windows Console and SQL Diagnostic Manager Services and
Repository, allowing you to immediately begin monitoring your SQL Server environment. Select the IDERA
Dashboard checkbox if you want a complete installation, by default the Web Console is not selected.
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£ IDERA 50L Diagnostic Manager Setup >

SQL Diagnostic Manager Components

Please select the SGL Diagnostic Manager components that you wish to
install/upgrade.

S5GQL Diagnostic Manager Windows Console
The 50L Diagnostic Manager Windows Consale allows you to
view./setup/corfigure the information that has been collected by SGL
Diagnostic Manager.

[~] SAQL Diagnostic Manager Services and Repository
The S0L Diagnostic Manager Services are used to gather information
from vaour servers and report them in the SQL Diagnostic Manager
Windows Console. The SQL Diagnostic Manager Repositary is the SGL
Server Database that holds the data that has been collected by the SGL
Diagnostic Manager Services.

] IDERA Dashboard (Web Console)

Similar ta the SQL Diagnostic Manager Windows Console, the
|DERA Dashboard is the web portal that allows youto
view./setup/corfigure the information that has been collected by
S0L Diagnostic Manager.

| Back  Cancel

(@ Bydefault, the Management Service, Collection Service, Predictive Service, and Rest Service are
installed on the local computer where you are running the setup program.

7. Click Next.

Select a Windows user account to use for the service account

SQL Diagnostic Manager uses the service account to communicate between the monitored SQL Server instance and
the SQL Diagnostic Manager Repository. The IDERA Dashboard uses this account to connect, discover, and gather
configuration information from SQL Servers in your Business environment. The installer grants the "Logon as a
Service" right to the account that you specify.

To specify a service account:

1. On the Service Account window, type appropriate credentials in the provided fields under which the services
run.
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£ |dera SOL Diagnostic Manager Setup >

Service Account

Specify the service accounts) for IDERA Dashboard and SGL Diagnostic
Manager. The service accounts will be used to collect information and to log
into the applications. You can log into the |IDERA Dashboard to create
additional users.

[] Use the same account for IDERA Dashboard and SGL DM

Comain % UserMame: |W12H.2“.ﬁdminist|7:|tur |

Password: |

2. Click Next. SQL Diagnostic Manager verifies the connection before continuing.

Select service ports to use for the IDERA Dashboard

The IDERA Dashboard uses ports 9292, 9290, 9094, and 9291 for the web application and dashboard services
respectively. However, you can specify different service ports.

To specify a service port:
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1. On the Service Ports window, specify the ports you want the web application and dashboard services to use.
. IDERA SOL Diagnostic Manager Setup >

Service Ports
Specify the ports to be used by the IDERA Dashboard services.

IDERA Dashboard Core Services Port

|IDERA Dashboard Web Application Service Port

IDERA Dashboard Web Application Monitor Port

CRLRC

IDERA Dashboard Web Application 551 Port 3231

ff Firewall is enabled make sure it allows TCP traffic through these parts.

| Back | _ Cancel |

2. Click Next.

(@ Verify that the Firewall allows TCP (Transmission Control Protocol) traffic through your specified ports.

Select a SQL Server instance to use for the IDERA Dashboard Repository database

The IDERA Dashboard Repository database is where the collected data, alert information, and alert configuration
settings are stored.

To specify the SQL Server instance to install the Repository database on:
1. On the Repository Database screen, specify the host SQL Server instance you want to use for the IDERA
Dashboard Repository database.
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2. Type the name for the IDERA Dashboard Repository database.
£ IDERA 50L Diagnostic Manager Setup =

IDERA Dashboard Repository Database

Please provide the 50L Server instance and the name of the Repositony
database for the IDERA Dashboard.

SQL Server Instance: | |
Database Name: |IdaaDashbnardHepos'rtmjr |

Connection Credentials: By default, the setup program uses the Windows
credentials you provided to create the repository.

[] Use Microsoft SGL Server Authentication Change

. Back | [ Next ]| Cancel

3. If your SQL Server environment uses SQL Server Authentication, select the respective check box and click
Change to enter SQL Server credentials. By default, the IDERA Dashboard uses your Windows credentials
when connecting to the Repository database.

@ Ifyou use Microsoft SQL Server Authentication, a new window displays where you can type the
respective SQL Server login and password.

4. Click Next.

Select a SQL Server instance to use for the SQL Diagnostic Manager Repository database

The SQL Diagnostic Manager Repository is where the collected data, alert information, and alert configuration
settings are stored.

To specify the SQL Server instance to install the SQL Diagnostic Manager Repository on:

1. Type the host name and instance in the space provided.

2. If your SQL Server environment uses SQL Server Authentication, select the respective check box and click
Change to enter SQL Server credentials. By default, SQL Diagnostic Manager uses your Windows credentials
when connecting to the Repository.

3. If want the SQL Diagnostic Management Service to use SQL Server Authentication , select the respective
check box and click Change to enter SQL Server credentials. By default, SQL Diagnostic Manager uses your
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Windows credentials when connecting to the Repository.
’f; IDERA S0L Diagnostic Manager Setup >

SQL Diagnostic Manager Repository
Create 50L Diagnostic Manager Repositony

SGL Server Instance:  |[[FEel] |
Database Name: |SG LdmRepository |

Connection Credentials: By default, the setup program uses the Windows
credentials you provided to create the repository,

[] Use Microzoft SGL Server Authentication Changs
If you want the SGL Diagnoestic Manager Management Service to use

SGL Server authentication to connect to the SQLOM Repository, select
the following check bow:

[] Use Microscft SQL Server Authentication Change

| Back || Next | Cancel

4. Click Next.

Select an installation location and type a display name for your instance

You can use the default install location or specify a different path. For your first install, we recommend using the
default location. On the Display Name text box, type a unique name for your SQLDM instance. The display name
helps you to distinguish different instances of the same product. Click Next to continue with the installation.
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. IDERA 5QL Diagnostic Manager Setup >

Choose a destination folder

Please provide us the destination folder where you want to install the componentis):

IDERA Dashboard: | C\Program Files\lders"\Dashboard |

SGL DM: |C:\F‘mg|am Files\Ideraldera SGL diagnostic mana|

Install this application far:

(®) Anyone who uses this computer (&l users)
() Onby for me {Cument User)

Provide a unigue name for the SGL DM instance

Type a unique name far vour SGL Diagnostic Manager instance to be
displaved in the IDERA Dashboard, then click "Chech Availability™. I the
name is available, click Mext and proceed with installation.

Diisplay Mame: 0 |

Mote: Display name is available | Check Availability |

Back = Next  Cancel |

© Display name

Provide a unique display name for the registered SQL Diagnostic Manager instance on the IDERA

Display Name is available.

Dashboard or the installation process does not complete. Use the Check Availability option to verify the

Complete the install

The setup will grant the provided accounts access to SQL Diagnostic Manager and the IDERA Dashboard. The user
that installs the IDERA Dashboard has access to this application by default as a Dashboard Administrator. You can

choose whether you want other users to have access to the IDERA Dashboard in the Administration view.

1. Click Install to indicate that you are ready to complete your installation with the configurations you
specified. If you want to review or change any of your settings, click Back.
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¢ IDERA 50 Diagnostic Manager Setup >

Ready to Install

Ready to install IDERA Dashboard and SGL Diagnostic Manager.

Setup will grant these accourts access to IDERA Dashboard and SGL Diagnostic
Manager :

IDERA Dashboard Service Account:IDERAINFODEV whemosa
|se this account to log into the |dera Dashboard and grant other users access
from the Idera Dashboard Administration tab.

SGL DM Service Accourt: IDERAINFODEVwWhemaosa

Click Install to begin the installation process. Click Back to review or change your
installation settings. Click Cancel to exit the wizard.

Back | [ Install | | Cancel |

2. Click Finish to exit the IDERA Dashboard Setup Wizard.
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(" IDERA 5QL Diagnostic Manager Setup >

Setup wizard completed

Congratulations! |DERA Dashbeard and IDERA 501 Diagnostic Manager have
been successfully installed.

To launch the SQL Diagnostic Manager;
* Go to Start Menu, Select Idera -» Idere SGL Diagnostic Manager Application

To launch the IDERA Dashboard:
* Open the ud - hitps: A Aocalhost 5297, from your browser

Launch ldera SGL Diagnostic Manager

When you finish the installation, the Welcome window opens allowing you to Visit the IDERA Trial Center, Add
New Servers (Recommended), Configure Default Alert Thresholds, or Start the Desktop Console.
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IDERA SOL Diagnostic Manager T *

Welcome to IDERA SGL diagnostic manager

SGL Diagnostic Manager minimizes costly server downtime by proactively alering administrators to
problems and enabling rapid diagnosis and resolution.

Choose an option to configure SCL Diagnostic Manager now. These options are also available from the application
menu i you would like to configure later.

Visit the IDERA Trial Center

Wisit the SQL Diagnostic Manager Trial Center to view product videos, schedule a personalized demo,
@ chat with IDERA engineers orto take advantage of a host of additional resources that will ensure you
get the most from your SQL diagnostic manager trial,

Add New Servers (Recommended)

@ Add new SGL Servers that should be monitored by SGL Diagnostic Manager.

Configure Default Alert Thresholds

s Configure the default alert threshelds that should be applied to new monitored SCL Servers. These
thresholds govem notfications such as email and task creation. In addition, the desktop client
*  provides visual cues when metrics cross defined thresholds.

Start Consaole

To access the IDERA Dashboard and the SQL Diagnostic Manager web console, see Log in the IDERA Dashboard and
web console.

© Uninstalling the IDERA Dashboard

If you wish to uninstall the IDERA Dashboard, make sure to unregister all products by clicking the Manage
Products link of the Products widget in the Administration view. For additional information, see Managing
products in the IDERA Dashboard.

Decide whether you want to deploy SQLDM Mobile

SQLDM Mobile includes the IDERA Newsfeed and several dashboard views that define your server health and expose
critical alerts. You can access the SQLDM Mobile Web application from most smartphones and mobile devices. The
IDERA Newsfeed is a revolutionary new way for DBAs and managers to collaborate, share knowledge, and keep
close tabs on your most critical SQL Server issues. With the IDERA Newsfeed, you can quickly share information to
stay informed, be more productive and shorten the time to problem resolution. For more information, review the
SQLDM Mobile architecture and components, as well as its requirements.
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Log in the IDERA Dashboard and web console

Once you have installed and configured your IDERA Dashboard and SQL Diagnostic Manager deployments, you can
login to the web console by doing the following:

1. Open your selected Browser, make sure it is compatible with the IDERA Dashboard console requirements.

2. Type the IDERA Dashboard product URL: http://<machinename>:<port> where <machinename> is the
name of your host or machine, and <port> is the port specified during installation. The default URL is
https://<localhost>:9291 or https://<machinename>:9291.

@ The port 9290 is used for http protocol, while the port 9291 is used for https protocol.

3. When the IDERA Dashboard web console launches on your browser, use your Windows user account
<domain\user> with the respective password to log into the product.

Login

Log in using Windows Credentials

eatn bdore

I
|
:

© The IDERA Dashboard Web Application service comes with SSL already set up. For more information on
running the IDERA Dashboard over SSL, see Run the IDERA Dashboard over SSL (HTTPS)
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Deploy SQLDM Mobile or IDERA Newsfeed

SQLDM Mobile is a Web-based application that includes the IDERA Newsfeed technology and several dashboard
views that define your server health and expose critical alerts. You can access the SQLdm Mobile Web site from
most smart phones and mobile devices. The IDERA Newsfeed is available quickly as a tab on the SQLDM Today
page.

Use the following links to prepare for your SQLDM Mobile or IDERA Newsfeed deployment:

« Check the supported installation scenarios

« Learn about the components and architecture
« Review system requirements

« View the installation instructions
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SQLDM Mobile components and architecture including IDERA Newsfeed

SQLDM Mobile is an easy-to-use, Web-based application that seamlessly integrates into your existing diagnostic and
monitoring workflow. The SQLDM Mobile Web site includes many metrics and alerts panels that let you quickly
ascertain performance issues in your environment.

SQLDM Mobile also includes the IDERA Newsfeed technology. The Newsfeed provides an easy-to-use, social-media-
based collaboration tool you can use to solve issues faster while keeping your team appraised of changing server
statuses.

Whether you are tied to your desktop, on the go, or managing remote servers, these features can fit your unique
monitoring needs.

The SQLDM Mobile architecture easily runs in your SQL Server environment with minimal configuration. All
components run outside and separate from SQL Server processes, and do not add to or modify any of your native
SQL Server files or services.

Components

IDERA Newsfeed for SQL Diagnostic Manager

The IDERA Newsfeed is a user interface that seamlessly integrates with the SQL Diagnostic Manager
Console, letting you monitor your instances and collaborate with coworkers at the same time, in real
time.

IDERA Newsfeed Platform
The IDERA Newsfeed Platform consists of the SQLDM Mobile Repository database and the SQLDM Mobile
and Newsfeed Service.

SQLDM Mobile Repository database

The SQLDM Mobile Repository (Mobile Repository) is a central database that stores your configuration
settings, comments and other activity on stories, as well as notifications. Consider deploying the Mobile
Repository to the same computer that hosts your SQL Diagnostic Manager Repository.

SQLDM Mobile and Newsfeed Service

The SQLDM Mobile and Newsfeed Service facilitates communications between the SQLDM Mobile
Repository and your SQL Diagnostic Manager application. By default, this service is installed on the same
computer where you run the SQLDM Mobile and Newsfeed setup program. Consider SQLDM Mobile and
Newsfeed Service to the same computer that hosts your SQL Diagnostic Manager services, such as the
SQLDM Management Service.

Action Provider

The IDERA Newsfeed Action Provider converts SQL Diagnostic Manager alerts about a server status and
performance metrics into notification emails that SQLDM Mobile & Newsfeed Service can send to the
appropriate people. The setup program installs the action provider on the computer hosting your SQL
Diagnostic Manager Repository.

Authentication Provider

The IDERA Newsfeed Authentication Provider is the SQL Diagnostic Manager application that the IDERA
Newsfeed Platform uses to authenticate a user when he or she signs up or logs on. The IDERA Newsfeed
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Platform leverages the application security settings as defined in SQL Diagnostic Manager, determining
which monitored SQL Server instances a given user can access.

SQLDM Mobile Web application

The SQLDM Mobile website provides access to the same monitoring and collaboration features of the
IDERA Newsfeed technology via a mobile device, such as a smartphone or iPad. The SQLDM Mobile
website also includes SQL Diagnostic Manager panels so you can quickly check server performance when
you are away from your desk.

Architecture

SAL diagnostic manager Deployment : Network Firewall
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SQLDM Mobile and IDERA Newsfeed requirements

You can easily install SQLDM Mobile on any computer that meets or exceeds the following requirements. The
SQLDM Mobile installation includes the IDERA Newsfeed technology and these related components:

+ SQLDM Mobile Web application
+ SQLDM Mobile & Newsfeed Service
+ SQLDM Mobile Repository

For more information, review all the SQLDM Mobile components and architecture.

General requirements for all components

All SQLDM Mobile components require Microsoft .NET Framework version 4.0 or later.

Permission requirements

The SQLDM Mobile and Newsfeed Service account requires the following permissions. By default, setup program
assigns the Local System account to the SQLDM Mobile and Newsfeed Service. During install, you can input
credentials for a Windows user account or SQL Server login.

Permission Why it's required

Log on as Service Allows the SQLDM Mobile and Newsfeed Service account to
run as a service.

Read and write privileges on the SQLDM Mobile Allows the SQLDM Mobile and Newsfeed Service to receive
Repository database and maintain performance and configuration data in the
SQLDM Mobile Repository.

Port requirements

By default, the SQLDM Mobile components use the following ports.

Port Number Where Which component Why
uses it

25 Mail Server SQLDM Mobile and Allows the SQLDM Mobile and
Newsfeed Service Newsfeed Service to send

notification emails.
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Port Number Where Which component Why
uses it
80 Web Server hosting the SQLDM SQLDM Mobile Web Allows access to the SQLDM
Mobile Website application Mobile screens via a mobile

device inside or outside your
corporate firewall. By default, IIS
uses port 80 for the local virtual
directory, so check your Web
Server settings to pick an
appropriate port for SQLDM
Mobile. You can specify a
different port during install or
later when you need to change
this configuration.

5166, 5167 Computer running the SQL SQL Diagnostic Allow communications between
Diagnostic Manger services Manager services SQL Diagnostic Manager and the
IDERA Newsfeed Platform for

signup and login authentication.

5168 Computer running the SQLDM SQLDM Mobile and Allows communications between
Mobile and Newsfeed Service Newsfeed Service the IDERA Newsfeed and SQL
Diagnostic Manager for server
status updates.

Mobile device requirements

You can access SQLDM Mobile on any smart phone or other mobile device that meets these minimum operating
system requirements:

« Android version 2.1 or later

« i0Sversion 3.2 or later

« RIM (BlackBerry OS) version 6.0 or later
« Windows Phone 7

You can run the SQLDM Mobile Web application in a native browser that supports HTML 5, such as Google Chrome,
Mozilla Firefox, or Edge Browser. SQLDM Mobile does not support Microsoft Internet Explorer 10+ or earlier.

@ Ifyouplan to use IE 9 or later to access the SQLDM Mobile Web site, make sure that you disable the Display
intranet sites in Compatibility View setting. To change this setting, click Compatibility View Settings on
the Tools menu in the IE browser window.

Web server requirements

The SQLDM Mobile Web application requires the following Web Server configuration and Services:

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 130


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw

SQL Diagnostic Manager for SQL Server

Type of requirement Minimum value
CPU 2.0GHz
Memory 1GB

Disk space 21 MB

Microsoft Internet Information Services (IIS)  Version 8.0

1S 7.2 or later

Operating System + Windows Server 2008
« Windows 7
« Windows 2008 R2
« Windows 8
« Windows 10
« Windows 2012
« Windows 2016

@ 7o successfully run the SQLDM Mobile Web application, make sure that Microsoft .NET Framework version
4.0 or later is installed. Also, verify the following service roles in 1IS are enabled:

+ Management Tools
+ |IS Management Console

« Web Server
+ Application Development
« ASP.NET (4.0 or later)
« ISAPI Extensions
« ISAPI Filters
« .NET Extensibility (4.0 or later)

« Common HTTP Features
« Default Document
+ Directory Browsing
o« HTTP Errors
« Static Content

«+ Health and Diagnostics
« HTTP Logging

+ Performance
« Static Content Compression

« Security
« Request Filtering

Repository requirements

You can install the SQLDM Mobile Repository on a computer running the following versions of SQL Server software:
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« SQL Server 2005 SP1+
« SQL Server 2008

o SQL Server 2008 R2

o SQL Server 2012

« SQL Server 2014

o SQL Server 2016

o SQL Server 2017

o SQL Server 2019

Keep in mind that the Repository database and corresponding SQLDM Mobile & Newsfeed Service require 19 MB of
disk space.
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How to install SQLDM Mobile and IDERA Newsfeed

This procedure guides you through the installation of SQLDM Mobile and Newsfeed. Before installation, review the
associated architecture and components. Although you can install different components on different computers,
this procedure recommends the following deployments:

« Install the Mobile and Newsfeed components on the same computer where your SQL Diagnostic Manager
services reside
« Install the Mobile web components on your corporate Web Server

@ Inlarger environments that contain more than one SQL Diagnostic Manager installation, consider
dedicating a SQLDM Mobile deployment per each SQL Diagnostic Manager application.

@ Ifyou areinterested in installing only the IDERA Newsfeed without the additional components used with
SQLDM Mobile, see How to install IDERA Newsfeed only.

Install or upgrade to SQL Diagnostic Manager 10.4

SQLDM Mobile and the IDERA Newsfeed technology are supported by SQL Diagnostic Manager 7.0 or later versions.
To successfully install and deploy SQLDM Mobile, Install or upgrade first to SQL Diagnostic Manager 10.3

Start your SQLDM Mobile and Newsfeed install

You can install the SQLDM Mobile components on any computer that meets or exceeds the product requirements.
By default, the SQLDM Mobile and Newsfeed setup program installs the SQLDM Mobile and Newsfeed Service to the
local computer.

To start installing SQLDM Mobile and Newsfeed:

1. Logon with an administrator account to the computer on which you want to install the SQLDM Mobile
and Newsfeed Service. We recommend that you install this service on the same computer that already
hosts your SQL Diagnostic Manager services.

Run Setup.exe in the root of the SQL Diagnostic Manager installation kit.

Click SQLDM Mobile and Newsfeed on the Quick Start window.

On the Welcome window of the setup program, click Next.

Review the license agreement. To accept this license agreement, click I accept the terms in the
license agreement and then click Next.

ol wn

Begin configuring your install

We recommend installing the Mobile and Newsfeed components in your SQL Diagnostic Manager environment, and
then re-running the setup program to install the SQLDM Mobile Web application on your Web Server.

You can use the default install location or specify a different path. For your first install, we recommend using the
default location. By default, the SQLDM Mobile and Newsfeed Service is also installed in the same location.

On the Custom Setup window, choose the Mobile and Newsfeed components, and then click Next.

Add the Windows credentials to use for the SQLDM Mobile and Newsfeed Service account

You can specify the Local System account or a Windows user account. Make sure that the specified account includes
the required permissions.

To specify a service account:
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1. Select the Local System account or type the appropriate credentials in the provided fields.
2. Click Test Credentials to validate the account.
3. Click Next.

Select the SQL Server instance to use for the Repository database

Store the published status updates and other configuration settings in the SQLDM Mobile Repository.

@ SQLDM Mobile requires Microsoft SQL Server 2005 or above running on the computer that hosts the Mobile
Repository database.

To specify on which SQL Server instance you want to install the SQL Diagnostic Manager Repository:

1. Select the SQL Server instance you want to use. The SQL Server menu lists SQL Server instances
provided by your domain controller. If you do not see your SQL Server instance in the list , type the
host name and instance in the space provided.

2. Click Next.

Add the authentication credentials to create the Repository database

You can use either Windows or SQL Authentication to create the Mobile Repository database. Make sure the
specified Windows account includes the required permissions.

To specify a service account:

1. Choose the authentication that you want to use, and then type the appropriate credentials in the
provided fields.
2. Click Test Connection to validate the account can connect to the specified SQL Server instance.
3. Click Next.
Add the authentication credentials to connect to the Repository database at run time

You can use either Windows or SQL Authentication to connect to the Mobile Repository database. Make sure the
specified Windows account includes the required permissions.

To specify a service account:

1. Choose the authentication that you want to use, and then type the appropriate credentials in the
provided fields.
2. Click Test Connection to validate the account can connect to the specified SQL Server instance.
3. Click Next.
Select a location for the SQLDM Management Service

SQLDM Mobile uses its own Authentication Provider to enforce application security across your SQL Diagnostic
Manager and SQLDM Mobile deployments.

On the Authentication Provider window, specify the computer that hosts the SQLDM Management Service, and
then click Next.

Complete the Mobile & Newsfeed components install

Click Install to indicate that you are ready to complete your install with the configurations you specified.

Begin the SQLDM Mobile Web components install

We recommend installing the SQLDM Mobile Web components on your corporate Web Server. Make sure your Web
Server meets the software and port requirements.
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To start installing the SQLDM Mobile Web application:

1. Logon with an administrator account to the computer on which you want to install the SQL Diagnostic
Manager Web application. We recommend that you install this application on the same Web Server that
already hosts your corporate Web site.
2. Restart the SQLDM Mobile and Newsfeed setup program and navigate to the Custom Setup window.
3. Choose the Mobile Web components, and then click Next.
Select the Web Server settings you want the SQLDM Mobile Web application to use

The setup program installs the SQLDM Mobile Web application in a unique virtual directory on your Web Server
computer. You can install the SQLDM Mobile Web application as a new Web site or add it to an existing Web site,
such as your corporate intranet.

Specify the name of the computer that hosts the SQLDM Mobile and Newsfeed Service so that you can send
communications between the SQLD< Mobile components and SQLDM.

Make sure your Web Server meets the SQLDM Mobile requirements.
To configure the Web Server settings:

1. Choose whether to install the SQLDM Mobile Web application as a new Web site.
2. Specify the name of the computer on which you installed the SQLDM Mobile and Newsfeed Service.
3. Click Next.

Complete the Mobile Web components install

Click Install to indicate that you are ready to complete your install with the configurations you specified.
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How to install IDERA Newsfeed only

This procedure guides you through the installation of IDERA Newsfeed only and none of the additional components
used with SQLDM Mobile. Use this solution in a larger environment where your SQL Server team or environment is
spread across multiple locations and you need an easier, more streamlined way to troubleshoot issues. The IDERA
Newsfeed can help you capture or bookmark the team resolutions for future reference. You can implement this
option without need to allot the additional hardware and IIS resources necessary to deploy a complete, mobile-
available solution.

Before installing Newsfeed, review the associated architecture and components.

Install or upgrade to SQL Diagnostic Manager 10.4

The IDERA Newsfeed technology is supported by SQL Diagnostic Manager 7.0 and above versions. To successfully
install and deploy IDERA Newsfeed, first install or upgrade to SQL Diagnostic Manager 10.4.

Start your IDERA Newsfeed install

Before installing Newsfeed, review the associated architecture and components. You can install the IDERA
Newsfeed on any computer that meets or exceeds the product requirements. By default, the SQLDM Mobile
and Newsfeed setup program installs the SQLDM Mobile and Newsfeed Service to the local computer.

To start installing IDERA Newsfeed:

1. Logon with an administrator account to the computer on which you want to install the SQLDM Mobile
and Newsfeed Service.

Run Setup.exe in the root of the SQL Diagnostic Manager installation kit.

Click SQLDM Mobile and Newsfeed on the Quick Start window.

On the Welcome window of the SQLDM Mobile and Newsfeed setup program, click Next.

Review the license agreement. To accept this license agreement, click I accept the terms in the
license agreement, and then click Next.

ok wnN

Begin configuring your install

You can use the default install location or specify a different path. For your first install, we recommend using the
default location. By default, the SQLDM Mobile and Newsfeed Service is also installed in the same location.

On the Custom Setup window, choose the Mobile and Newsfeed components, and then click Next.

Add the Windows credentials to use for the SQLDM Mobile and Newsfeed Service account

You can specify the Local System account or a Windows user account. Make sure the specified account includes the
required permissions.

To specify a service account:

1. Select the Local System account or type the appropriate credentials in the provided fields.
2. Click Test Credentials to validate the account.
3. Click Next.

Select the SQL Server instance to use for the Repository database

The IDERA Newsfeed Repository is where the published status updates and other configuration settings are stored.

© sQLdm Mobile requires Microsoft SQL Server 2005 or above running on the computer that hosts the
Newsfeed Repository database.
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To specify the SQL Server instance to install the SQL Diagnostic Manager Repository on:

1. Select the SQL Server instance you want to use. The SQL Server menu lists SQL Server instances
provided by your domain controller. If you do not see your SQL Server instance in the list , type the
host name and instance in the space provided.

2. Click Next.

Add the authentication credentials to create the Repository database

You can use either Windows or SQL Authentication to create the Newsfeed Repository database. Make sure the
specified Windows account includes the required permissions.

To specify a service account:

1. Choose the authentication that you want to use, and then type the appropriate credentials in the
provided fields.
2. Click Test Connection to validate the account can connect to the specified SQL Server instance.
3. Click Next.
Add the authentication credentials to connect to the Repository database at run time

You can use either Windows or SQL Authentication to connect to the Newsfeed Repository database. Make sure the
specified Windows account includes the required permissions.

To specify a service account:

1. Choose the authentication that you want to use, and then type the appropriate credentials in the
provided fields.
2. Click Test Connection to validate the account can connect to the specified SQL Server instance.
3. Click Next.
Select a location for the SQLDM Management Service

SQLDM Mobile uses its own Authentication Provider to enforce application security across your SQL Diagnostic
Manager and IDERA Newsfeed deployments.

On the Authentication Provider window, specify the computer that hosts the SQLDM Management Service, and
then click Next.

Complete the Newsfeed install

Click Install to indicate that you are ready to complete your install with the configurations you specified.
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How to install SQL Diagnostic Manager Console only

This procedure guides you through the installation of the SQL Diagnostic Manager Console only.

@ You must have a full installation of SQL Diagnostic Manager already running in your environment before
attempting to install the SQL Diagnostic Manager desktop client console.

Perform your install

You can install SQL Diagnostic Manager desktop client console on any computer that meets or exceeds the product
requirements.

To install SQL Diagnostic Manager Console only:

1. Logon with an administrator account to the computer on which you want to install the SQL Diagnostic
Manager desktop client console.
2. Navigate to the location where the SQL Diagnostic Manager Console file resides in the distribution
media.
3. Ifyou use an x64 operating system, run SQLDiagnosticManager-x64_c.exe. Ifyou use an x86 0S,
run SQLDiagnosticManager_c.exe.
On the Welcome window of the setup program, click Next.
5. Review the license agreement. To accept this license agreement, click | accept the terms in the
license agreement, and then click Next.
6. Select the default installation location or specify a different path.
7. Choose whether you want any user or only the current user to access this application, and then click
Next.
8. Verify that SQL Diagnostic Manager displays Console Only as selected, and then click Next.
9. Click Install to indicate that you are ready to complete your install with the configurations you
specified.
10. Click Finish to exit the setup program.

>

Complete the post-installation steps

When you first open the SQL Diagnostic Manager desktop client console, you must complete the fields necessary to
connect to your existing SQL Diagnostic Manager Repository. It is important that you have the information
available to connect to the proper SQL Server instance and SQL Diagnostic Manager Repository database using the
proper authentication credentials.
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Deploy SQL Diagnostic Manager in a high availability group

This procedure guides you through the installation of SQL Diagnostic Manager in a high availability group. SQL
Diagnostic Manager does not support direct installations under this scenario; however, you can deploy the SQL
Diagnostic Manager Repository in one of the nodes that belongs to a specific availability group and configure an
availability group listener that serves as a global link between nodes.

@ Make sure to restart the SQL Diagnostic Manager services, apply the newly-generated license using the
Manage Licenses button before attempting to apply the license directly using the Management Console or
you may encounter issues.

1. Deploy the SQL Diagnostic Manager Repository targeting a node that is part of an availability group. For
example, Node 1\Instance A.

2. Move the SQL Diagnostic Manager Repository to an availability group in the primary replica with Listener Y
and port 300 (as example). To review how to create an availability group, see Microsoft document Creating
and Configuring a New Availability Group.

3. Anew license key for Listener Y, Port 300 is required. See Capturing an availability group's listener name and
port designation to send your request to IDERA Sales.

4. Using the SQLdm Management Service Configuration wizard modify the target repository to ListenerY, port
300.

¥ IDERA 501Ldm Management Service Configuration Wizard E3

Specify SQLdm Repository

Specify the location and credentialz uzed by the Management Service to connect to the
Repositony.

" The information you provide below iz uzed by the Management Service to connect
| _.-' to the Repository. The Management Service wiites configuration and scheduled
= collection data ko the Repositary.

— Repozitan
Server: lMyDNSSDLDM,EﬂE
[ratabaze; ISI]Lu:ImFI epozitaryF ordG

Led L Lo

Authentication: l S0L Server Authentication

Izer Mame: Isa

Paszward: I’“"‘““’“"1

Test | @ Succesziully connected ta the Bepoziton

< Back I Mest = I Canicel

5. Save changes, and then restart the SQL Diagnostic Manager services. This process takes approximately 5
minutes.
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6. Upon opening the SQL Diagnostic Manager Console, the system recognizes that you are trying to access the
selected node without the proper license and throws an error message.

7. Click the Manage Licenses button of the error message and type the new license for ListenerY, Port 300.
Open the SQL Diagnostic Manager Console, go to Help > Manage Licenses in the Toolbar menu, and the
License Keys window displays. Type the new license key in the available space, and then click Enter.
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AlwaysOn availability group listener name and port designation

This procedure guides you through the necessary steps to capture an availability group's listener name and port
designation. This information is essential for IDERA Sales to generate a special license that allows you to host the
SQL Diagnostic Manager Repository in an availability group. As a pre-requisite the SQL Diagnostic Manager
Repository needs to be hosted in an availability group within the primary replica.

1. Within SSMS, go to node that contains the availability group that hosts the SQL Diagnostic Manager
Repository and is the primary replica.

Cibject Explorer > X
Connect~ 3d 3J @ “F [#] ,'_3
= (b DM-WIN2012-NT\SQL20125P1_CS (SQL Server 1

Lﬁ Databases
[ Security

[ Server Objects
[ Replication

[ Managerment
[ Integration Services Catalogs

2. Expand the AlwaysOn High Availability folder and then the Availability Groups Folder.

Object Explorer - ¥

Connect~ 3 3 m 7 [#] L5 }
= [B DhA-WMZ 0 2-MTVEOL20T25PT_C5 (SO0 Serve
[ Databases
[0 Security
[ Server Objects
Feplication

AlnraysOn High Availahbility
3 &wailability Groups

_ Managerment

[ Integration Services Catalogs
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3. Expand the availability group that is the primary replica.

Dbject Explarer w7

Connect~ 3 & m "7 [&] g
=) LB Db - 20T 2- MWL 20T 25P1_CS {501 Ser
[ Databases

[ Security
[ Server Ohjects

[ Replication

AlivaysOn High Svailability
= [ &wsailability Groups
5 AG-MIAMI (Secondany)

|E| 0 S0Ldrr143 (Priranyd I
1 Awvailability Replicas
[ Awailability Databases
[ Awailability Graup Listeners
O Test1AGCE (Secondary)
[ Management
[ Integration Services Catalogs

4, Expand the Availability Group Listeners Folder.

Dibject Explorer i
Connect~ &) 4] m [ (2] .§
=0 DM-NANZ0 2-NTNSOL20T2EPT_CS (SOL Serve
% _d Databases
& T Securiby
% 3l Server Objects
4 _d Replication
SRR | AhwaysOn High Svailability
= 4 Availability Groups
H G AG-MIAMI (Secandary)
= (57 SOLdr 143 (Primanyd
[+ | fvailabiliby Replicas
# 4 fwailability Databases
l'-: [ Availability Group Listeners J
L) MiySlistener
5 0 Test1AGCE (Secandany)
% _d Management
% i Integration Sepvices Catalogs
+ [F SOL Server Agent

5. Right-click the listener, select Properties, and the Availability Group Listener Properties dialog Displays.
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Send IDERA Sales the Listener DNS Name and Port designation information to obtain a new license to host

the SQL Diagnostic Manager Repository in an availability group.
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Configure your deployment

After initially installing SQL Diagnostic Manager, use the following configuration tasks to help you get the most out
of SQL Diagnostic Manager:

« Add your SQL Server instances

+ Configure console options

« Connectto a SQL Diagnostic Manager Repository

+ Set your Repository grooming schedule

« Use tags to organize your monitoring environment
+ Use custom counters to track metrics
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Connect to the SQL Diagnostic Manager Repository

The first time you open the SQL Diagnostic Manager Management Console, SQL Diagnostic Manager displays the
Connect to SQL Diagnostic Manager Repository window. Use this window to select the SQL Server instance, SQL
Diagnostic Manager Repository database name, and enter the authentication details the SQL Diagnostic Manager
Console uses to communicate with the SQL Diagnostic Manager Repository.

The SQL Diagnostic Manager Console requires Read Access on the SQL Diagnostic Manager Repository database.
You can use either Windows Authentication or SQL Server Authentication for this connection.

Access the Connect to SQL Diagnostic Manager Repository window

You can open the Connect to SQL Diagnostic Manager Repository window from the SQL Diagnostic Manager
Console menu bar by selecting File > Connect to SQLDM Repository. The ability to connect to another Repository
is important in disaster recovery situations where you need to change the location of your SQL Diagnostic Manager
Repository.
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Add your SQL Server instances

The Add Servers wizard allows you to add the SQL Server instances you want to monitor. The Add Servers wizard
also allows you to configure all the common options you use for monitoring SQL Server collection settings and
alerts, and apply an alert template.

@ Ifyou are adding several SQL Server instances and you want to configure the same alert thresholds on
each instance, consider setting up an alert template before adding any of your SQL Server instances.

Access the Add Servers wizard

You can open the Add Servers wizard from the SQL Diagnostic Manager Console menu by selecting File > Manage
Servers, and then clicking Add in the Manage Servers window.

Other configurations that need attention when adding a virtualized SQL Server instance

If the monitored SQL Server instance you want to add resides on a virtual machine, add the instance using the Add
Servers wizard, and then access the VM configuration window to associate the instance with the correct virtual
machine and host.

@ IDERA recommends that you register individual instances in the Add Servers wizard when looking to
monitor availability replicas. Note that registering an Availability Group Listener may result in misleading
data due to the failovers between availability replicas.

About alert templates

SQL Diagnostic Manager allows you to configure generic alert settings as a template that you can apply to servers
and groups of servers in your organization. Click Tools > Alert Configuration Template and complete the required
fields to configure an alert template.

Delete a SQL Server instance

You can easily delete a SQL Server instance at any time by right-clicking the appropriate instance, and then
selecting Delete. SQL Diagnostic Manager displays a confirmation message that asks, "Would you like to retain the
data collected for the selected instance?" Click Yes and SQL Diagnostic Manager retains data for the instance and
includes it in some reports, such as the Server Inventory report. Click No and SQL Diagnostic Manager deletes the
SQL Server instance and all related data.
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Configure authentication

The Configure Authentication window of the Add Servers wizard allows you to select the authentication credentials
SQL Diagnostic Manager uses when collecting performance and statistics information from your SQL Server
instances. You can also set encryption to secure the connection.

After selecting a connection type and encryption, click Next to continue.

Access the Add Servers wizard

You can open the Add Servers wizard from the SQL Diagnostic Manager Console menu by selecting File > Manage
Servers, and then clicking Add in the Manage Servers window.

Select a connection type

Windows Authentication is the recommended collection type as SQL Diagnostic Manager uses a number of SQL
trace statements that require a trusted connection. When you select and use Windows Authentication, the
account the SQLdm Collection Service is running as is used to connect to the SQL Server instance.

Select encryption

SQL Diagnostic Manager allows you to designate encryption methods used to encrypt data between the SQLdm
Collection Service and the monitored SQL Server instance. The options include SSL (Secure Sockets Layer) or SSL
with Trust Service Certificate.

Encrypt Connection (SSL)

The Encrypt Connection (SSL) option adds a flag in the connection properties that triggers SSL use
when the SQLdm Collection Service connects to a monitored server that uses SSL to encrypt the data
transfer. For this option to work correctly, you must configure the monitored SQL Server instance to use
SSL encryption.

Trust Server Certificate (Bypass Certificate Validation)

The Trust Server Certificate (bypass certificate validation) option is available only after you select
Encrypt Connection (SSL). This option allows you to skip certificate validation when a SQL Server
instance establishes a connection. If SSL on the monitored SQL Server instance is not configured to use a
certificate that the collection service trusts, then the connection is rejected unless you select the Trust
Server Certificate option.

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 148


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw

SQL Diagnostic Manager for SQL Server

Select instances to monitor

The Select Servers to Monitor window of the Add Servers wizard allows you to select one or more of the SQL Server
instances you want to monitor using SQL Diagnostic Manager. If the name of the SQL Server instance you want to
monitor does not appear in the list, type the instance name in the space provided in the Available Servers area. You
can also designate specific ports for your SQL Server instances by entering a comma between the instance name
and port number, for example domain\instance name,port.

The Available Licenses field shows you the number of instances your current license permits SQL Diagnostic
Manager to monitor.

@ The Select Servers to Monitor window lists all the SQL Server instances provided by your domain
controller. This list can include unsupported SQL Server instances. Be sure to select only SQL Server
instances that are supported by SQL Diagnostic Manager.

Access the Add Servers wizard

You can open the Add Servers wizard from the SQL Diagnostic Manager Console menu by selecting File > Manage
Servers, and then clicking Add in the Manage Servers window.
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Select cloud or Linux provider

Configure the type of server (Amazon RDS SQL Server, Azure SQL Database, Linux, or Windows) for each of the
added SQL Server instances.

& Add Servers Wizard ? =
Select the server type for the added servers
Corfigure the type of server for each of the added SCGL Serverinstances. l ‘
Server Name Server Type AWS RDS Access Key AWS RDS Secret Ke

WIN-TL1I5EGS2... | Windows iv

Amazon RDS 50L Server (RDS 500
Micrasoft Azure SCL Database (AzursDE}
Lirw:

Windows

q | 1]

< Back Mest = Cancel

The select cloud providers for the added servers window allows you to choose a cloud provider for your monitored
SQL Server instances that are hosted on the cloud (PaaS). SQL Diagnostic Manager supports Amazon RDS and
Microsoft SQL Azure (SQL Azure Database, elastic pool, and managed instances).

® Aws

Review the Minimum permissions to monitor an Amazon RDS instance with SQL Diagnostic Manager.
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& naddition, SQLDM supports monitoring of images hosted on virtualized or cloud laaS environments such
as SQL Server on Azure virtual machines and Amazon EC2. Monitoring a virtualized instance requires no
cloud-specific configuration. Select "Not a cloud instance" for a virtualized or cloud laa$ instance.

Access the Add Servers wizard

You can open the Add Servers wizard from the SQL Diagnostic Manager Console menu by selecting File > Manage
Servers, and then clicking Add in the Manage Servers window.
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Metric availability for instances hosted on the cloud

SQL Diagnostic Manager allows you to view a wide range of information collected for your PaaS monitored
instances hosted on Amazon RDS and Microsoft SQL Azure (Azure SQL Database, elastic pool and managed
instances).

& n addition, SQLDM supports monitoring of images hosted on virtualized or cloud laaS environments such
as SQL Server on Azure virtual machines and Amazon EC2. Monitoring a virtualized instance requires no
cloud-specific configuration.

O soL Diagnostic Manager has new DBaaS metrics and alerts, for more information review the Metric Alerts.

To have more information on the metrics data that are available for cloud instances, select your preferred option:

« Available metrics for Amazon RDS and Microsoft SQL Azure in SQL Diagnostic Manager.
« Unavailable metrics for Amazon RDS and Microsoft SQL Azure in SQL Diagnostic Manager.

Available metrics for Amazon RDS and Microsoft SQL Azure in SQL Diagnostic Manager
For monitored SQL Server instances hosted on Amazon RDS

SQL Diagnostic Manager Area Collected Metrics by Amazon RDS
Overview — Details Batches
Batches Per Second
Blocked Sessions
Buffer Cache Hit Ratio
Buffer Cache Size
Checkpoint Writes
Checkpoint Writes Per Second
Client Computers
Connections
Connections Per Second
Data File Count
Data File Space Allocated
Database Count

Full Scans
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Full Scans Per Second
Lazy Writer Writes

Lazy Writer Writes Per Second
Lead Blockers

Lock Waits

Lock Waits Per Second
Log File Count

Log File Space Allocated
Log File Space Used

Log Flushes

Log Flushes Per Second
Maintenance Mode

OLE Automation Status
Open Transactions

OS Metrics Availability
Packet Errors

Packet Errors Per Second
Packets Received

Packets Received Per Second
Packets Sent

Packets Sent Per Second
Page Life Expectancy
Page Lookups

Page Lookups Per Second

Page Reads
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Page Reads Per Second

Page Splits

Page Splits Per Second

Page Writes

Page Writes Per Second
Procedure Cache Hit Ratio
Read Ahead Pages

Read Ahead Pages Per Seconds
Read Write Errors

Response Time

Running Since

Server Version

Sql Compilations

Sql Compilations Per Second
Sql Memory Allocated

Sql Memory Used

Sql Recompilations

Sql Recompilations Per Second
System Processes

System Processes Consuming CPU
User Connections Percent

User Processes

User Processes Consuming CPU
WMI Service Status

Workfiles Created
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Sessions . Summary

Sessions — Details

Workfiles Created Per Second
Worktables Created
Worktables Created Per Second
Response Time

Sessions

Blocked Sessions

Lock Statistics — Average Wait Time
Lock Statistics — Deadlocks
Lock Statistics - Requests
Lock Statistics — Timeouts
Lock Statistics — Waits

Lock Statistics — Wait Time
Connection

User Session

Status

Host

Net Library

Network Address

User

Application

Database

Transaction Isolation Level
Usage

Login Time

Last Activity

SQL Diagnostic Manager for SQL Server
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Physical I/0

CPU (ms)

Memory (kb)

Open Transactions

Lock Information

Wait Time (ms)

Blocking

Blocking Count

Tempdb Usage

Version Store Elapsed Seconds
Space Used in kb (Alloc / Dealloc)
Session User Space

Task User Space

Session Internal Space

Task Internal Space

Last Command

For monitored SQL Server instances hosted on Microsoft SQL Azure

SQL Diagnostic Manager Area
Overview - Details

Sessions . Summary

Sessions — Details

SQL Diagnostic Manager for SQL Server

Collected Metrics by Microsoft SQL Azure

Response Time
Response Time
Sessions

Blocked Sessions
Connection

User Session
Status

Host
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User

Execution Context
Application

Database

Transaction Isolation Level
Usage

Login Time

Last Activity

Physical I/O

CPU (ms)

Memory (kb)

Lock Information

Wait Time (ms)

Resource

Blocking

Blocking Count

Tempdb Usage

Version Store Elapsed Seconds
Space Used in kb (Alloc / Dealloc)
Session User Space

Task User Space

Session Internal Space
Task Internal Space

Last Command
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Unavailable metrics for Amazon RDS and Microsoft SQL Azure in SQL Diagnostic Manager

SQL Diagnostic Manager allows you to view a wide range of information collected for your monitored SQL Server
instances hosted on Amazon RDS and Microsoft SQL Azure. However, the following information and metric data are
not available yet:

For monitored SQL Server instances hosted on Amazon RDS

SQL Diagnostic Manager area Information and metric data not collected by Amazon RDS

Overview - Details Available Memory

Data File Space used

Disk Queue Length

Disk Time (Percent)

OS CPU Privileged Activity

OS CPU User Time

OS Total Processor Activity

Pages Per Second

Physical Memory

Procedure Cache Size

Processor Queue Length

Sql CPU Activity

Sql Memory Used Percent

Used Memory (Percent)

Sessions — Details Connection
Execution Context
Usage

Lock Information
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Lock Information
Wait Type

Resource
For monitored SQL Server instances hosted on Microsoft SQL Azure

SQL Diagnostic Manager area Information and metric data not collected by Microsoft SQL Azure
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Overview - Details Available Memory
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Batches
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Batches Per Second

Blocked Sessions

Buffer Cache Hit Ratio

Buffer Cache Size

Checkpoint Writes

Checkpoint Writes Per Second

Client Computers

Connections

Connections Per Second

Data File Count

Data File Space Allocated

Data File Space used

Database Count

Disk Queue Length

Disk Time (Percent)

Full Scans

Full Scans Per Second

Lazy Writer Writes

Lazy Writer Writes Per Second

Lead Blockers
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Lock Waits

Lock Waits Per Second

Log File Count

Log File Space Allocated

Log File Space Used

Log Flushes

Log Flushes Per Second

Maintenance Mode

OLE Automation Status

Open Transactions

OS CPU Privileged Activity

OS CPU User Time

OS Metrics Availability

OS Total Processor Activity

Packet Errors

Packet Errors Per Second

Packets Received

Packets Received Per Second

Packets Sent

Packets Sent Per Second

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 163


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw

SQL Diagnostic Manager for SQL Server

Page Life Expectancy

Page Lookups Per Second

Page Reads

Page Reads Per Second

Page Splits

Page Splits Per Second

Page Writes

Page Writes Per Second

Pages Per Second

Physical Memory

Procedure Cache Hit ratio

Procedure Cache Size

Processor Queue Length

Read Ahead Pages

Read Ahead Pages Per Second

Read Write Errors

Running Since

Server Version

Sql Compilations

Sql Compilations Per Second
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Sessions - Summary

SQL Diagnostic Manager for SQL Server

Sql CPU Activity

Sql Memory Allocated

Sql Memory Used

Sql Memory Used Percent

Sqgl Recompilations

Sql Recompilations Per Second

System Processes

System processes Consuming CPU

Used Memory(Percent)

User Connections Percent

User Processes

User Processes Consuming CPU

WMI Service Status

Workfiles Created

Workfiles Created Per Second

Worktables Created

Worktables Created Per Second

Lock Statistics — Average Wait Time

Lock Statistics — Deadlocks

Lock Statitstics — Requests
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Lock Statistics - Timeouts

Lock Statistics — Waits

Lock Statistics — Wait Time

Sessions — Details Connection

Net library

Network Address
Usage

Open Transaction
Lock Information

Wait Type
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User Permissions for Azure

Recommended permissions for Azure

SQL Diagnostic Manager now includes a SQL Script to create a new user for Azure SQL Database Standard and Basic
Tier with the minimum and necessary permissions for the product to function. Also, includes additional permissions
that are required for trace and xevent manipulation.

1. Use the Find/Replace function to locate and replace all references to 'SQLdmConsoleUser' with the name of

your SQLdm User.
2. Connect to the SQL Server that is hosting your SQLdm Repository database and execute the script found
under the name of RecommendedPermissionsAzure.sql in the following path:
C:\Program Files\Idera\ldera SQL diagnostic manager\User Creation Scripts

Recommended permissions Azure replication mirroring

Also, itincludes a SQL Script to create new user for Azure SQL Database Standard and Basic Tier with minimum and
necessary permissions for the product to function. This script has additional permissions required for trace, xevent
manipulation, mirror, and replication.

1. Use the Find/Replace function to locate and replace all references to 'SQLdmConsoleUser' with the name of
your SQLdm User.
2. Connect to the SQL Server that is hosting your SQLdm Repository database and execute this script.
You can find this script under the name of RecommendedPermissionsAzureReplicationMirroring.sqgl in the
following path:
C:\Program Files\Idera\ldera SQL diagnostic manager\User Creation Scripts

() For more information about the characteristics of the Server admin and Azure Active Directory admin
accounts, review Controlling and granting database access to SQL Database and SQL Data Warehouse.
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Configure data collection

The Configure SQL Diagnostic Manager Collection window of the All Servers wizard allows you to set the interval at
which you want to collect diagnostic data and raise alerts, and whether you want to enable query monitoring.

The collection interval you specify refers to the time SQL Diagnostic Manager waits to collect statistical information
on your SQL Server instance. This data includes the resource, session, database and tables, query, and service
information.

The Query Monitor is a standard SQL Server trace that collects events occurring on your SQL Server instance over a
period of time.

& Enabling the Query Monitor can cause SQL Server performance degradation while it runs. Enable the
Query Monitor only when diagnosing specific query issues.

After making any changes to the collection interval or enabling the Query Monitor, click Next to continue.

Access the Add Servers wizard

You can open the Add Servers wizard from the SQL Diagnostic Manager Console menu by selecting File > Manage
Servers, and then clicking Add in the Manage Servers window.

Select a collection interval

Choosing the appropriate interval depends on your specific monitoring needs. When your SQL Server instance
performs poorly, you can decrease the collection interval so that you can track changes more often. When
monitoring a SQL Server instance that has a very heavy client load and a large number of databases, you can
increase the time period between collections to reduce the possibility of the frequent collections causing a
performance impact on your clients.

Monitoring your environment by collecting query activities

When you experience query timeouts or other performance issues, you can collect query-related activities through
the Query Monitor. Note that enabling these options can degrade performance on the monitored SQL Server
instance because of the additional data collection and storage. To help alleviate degradation, SQL Diagnostic
Manager allows you to select only those types of queries you want to monitor such as batches, statements,
procedures, and triggers. Additional threshold fields allow you to set the levels at which you consider a query as
performing poorly.

@ itisimportant to remember that once you complete your problem diagnosis, you can disable the Query
Monitor on the Monitored SQL Server Properties window by selecting the Query Monitor tab and then
clearing the Enable the Query Monitor check box.

Using advanced Query Monitor options

Query Monitor includes advanced options that allow you to filter applications, databases, and SQL text from
collection. Use semicolons (;) to separate multiple entries. You can also use the percent character (%) as a wildcard.

You can access this window by clicking the Advanced button in the Query Monitor tab of the monitored SQL Server
Properties window.
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Configure OS metric collection

The Configure OS Metric Collection window of the Add Servers wizard lets you select which type of operating system
metrics collection you want to use or whether you do not want to collect any OS metrics from a SQL Server
instance:

« Do not collect Operating System data

+ Collect Operating System data using OLE Automation

+ Collect Operating System data using direct WMI (selected by default when adding a new SQL Server
instance)

SQL Diagnostic Manager uses OLE automation or a direct connection to the Windows Management Interface (WMI)
when collecting OS metrics and service status data on clustered SQL Servers. For additional information about
OS metrics collection, see Configure OS metrics monitoring.

@ SQL Diagnostic Manager retains your previous settings upon upgrade if OLE automation is the default for
your monitored SQL Server instance.

After selecting your method for OS metrics collection, click Next to continue.

Access the Add Servers wizard

You can open the Add Servers wizard from the SQL Diagnostic Manager Console menu by selecting File > Manage
Servers, and then clicking Add in the Manage Servers window.

Disabling OS metric collection

SQL Diagnostic Manager does not require OS metrics collection. However, if you disable this feature, SQL Diagnostic
Manager ceases to collect OS metrics and does not raise any previously-associated alerts. You can easily enable OS
metric collection at any time if you decide that you want to continue collecting these metrics.

Permissions for direct WMI collection

It is preferred that the WMI user is a local administrator on the monitored SQL Server instance. However, if you do
not want to grant administrator access, use the following steps to configure remote WMl access in Microsoft
Windows:

1. Add the user account to the Performance Log Users and Distributed COM users groups.
2. Grant privileges to WMI.

You also may need to add the WMI user account to the following policies:

+ Act as part of the operating system
+ Logon asabatch job

+ Logon asaservice

« Replace a process level token

For more information about using a direct WMI connection, see the Microsoft document, Securing a Remote WMI
Connection.
Using direct WMI when the collection service is on a different domain than the SQL Server

In environments where cross-domain trust security is enforced, data from asynchronous collection is not returned
from an untrusted domain to a trusted domain. As a result, the collection service does not receive the data.
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If you select Collect Operating System data using direct WMI and the machine used for your collection service is
in a different domain than your monitored SQL Server instance, you must make some configuration changes on
your collection service machine. If you do not make these changes, change your OS metrics collection to Collect
Operating System data using OLE automation if you want OS and disk statistics plus the auto discovery of mount

points.
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Select an alert template and tags

The Select Alert Template and Tags window lets you assign an alert template and tags while you add an instance.
Alert templates allow you to configure generic alert settings to apply to your servers or groups of servers. Tags are
labels that help you organize server instances into meaningful groups.

To apply an alert template, select the appropriate template from the list. If you do not have an existing custom alert
template, you can create an alert template after you add your SQL Server instance, and then apply the template to
your server. You may select one or more existing tags from the list, or create new tags by clicking Add Tag.

If you create an instance before creating any custom alert templates, SQL Diagnostic Manager applies the default
alert template automatically. You can then create an alert template and apply it to the server once the new
template is available.

After selecting your baseline collection, click Next to continue.

Access the Add Servers wizard

You can open the Add Servers wizard from the SQL Diagnostic Manager Console menu by selecting File > Manage
Servers, and then clicking Add in the Manage Servers window.

Using tags

Tags are customizable to suit your needs. For example, you may want to view only server instances used by a
particular department (like Accounting), in a specific location, or by some other method (like SQL Server version).

You can assign multiple tags to each instance so that the instance appears in several different groups.
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Configure your virtual machine connections

The VM Configuration window allows you to associate your monitored virtual SQL Server instances with the
virtualization host server that manages your VMs and the VM on which the monitored SQL Server instance is
running.

Virtual machines appearing in the list are based on the permissions for the user account typed into the
Virtualization Host Configuration dialog box. To view a specific VM, you must have the View permission on all
parent folders.

@ Remember to renew your link after changing the name of a virtual machine. Once the name change is
complete, simply open the VM Configuration window and wait until after SQL Diagnostic Manager is done
contacting the vCenter server or Hyper-V Host server to get a list of your VM names. Note that your
updated VM name already appears in the list. Click OK to save the new name to the list of VMs. If you do
not update the name, this action occurs again the next time you access the VM Configuration window.

Access the VM Configuration window

To open the VM Configuration window, select Tools > VM Configuration, or click VM Configuration from the
Manage Servers window. You can also access this window from the Virtualization tab of the Server Properties
window by clicking the VM Configuration button.

Add a host server

SQL Diagnostic Manager allows you to add a new vCenter Server through the VM Configuration window, follow
these steps to add one:

1. Click New.
2. Inthe Virtualization Host Configuration window fill in the blanks as follows:
a. Server: The vCenter server that has to be written as the IP or vCenter Server name:443 (Default
port #443).
b. Name: Use a friendly name to distinguish your server from other vCenters.
c. User and password: Use the domain account that is running the SQLDM Services that has read
access to vCenter.

3. Click Test to test the configuration data.
4. Click OK to add the vCenter Server to the list of Virtualization Host Servers.
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© Hyper-V and metrics collection

See Hyper-V user requirements for information on how to successfully collect Hyper-V host and VM

metrics.

Verify your connection to the host server

Associate a monitored SQL Server instance to a VM
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You can test the connection to your listed host servers by selecting the appropriate server from the list, and then
clicking Test.

SQL Diagnostic Manager displays an icon with your current connection status. If the connection fails, click View/
Edit and verify your connection details. Make the necessary changes to access your host server, click Test, and then
click OK to save your changes after a successful test.

Once you add your SQL Server instances to SQL Diagnostic Manager for monitoring, you must associate them with
their host server and virtual machine.
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To associate a monitored SQL Server instance to a virtual machine:

. Verify that the instance you want to associate to the host appears in the list.

. Click the Virtualization column for the appropriate virtual instance, and then select the associated host
server from the drop-down list.

. Click the Virtual Machine column, and then select the name of the virtual machine where this instance
resides. SQL Diagnostic Manager populates this drop-down list based on the servers on the selected host
server.

. Click Link Instances to VMs.

. Click OK to save your changes and close this window.
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Configure your VM host server connection

The vCenter Connection Configuration window allows you to add or update connection details for your virtual
machine host servers. Complete the access information for the server, and the click Test to make sure you typed
the correct access credentials. Click OK after a successful test.

Occasionally, a connection test fails. Make sure you typed accurate information in the appropriate fields, and then
click Test. If the test fails again, there may be an issue with the server to which you are trying to connect.
Access the vCenter Connection Configuration window

To access the vCenter Connection Configuration window, first access the VM Configuration window by selecting
Tools > VM Configuration, or by clicking VM Configuration from the Manage Servers window. You can also access
this window from the Virtualization tab of the Server Properties window. Once in the VM Configuration window,
click New.

vCenter Server port requirements

The vCenter Server requires that you open the ports included in the following table. For the most current list of
ports, see the VMware Knowledge Base article regarding network port requirements.

Port Description

80 Required for direct HTTP connections. Note that this port redirects requests
to HTTPS Port 443.

389 Active Directory Services for the vCenter Server group.

443 Listens for connection from the vSphere Client, vSphere Web Access Client,
and other SDL clients.

636 SSL port of the local instance for vCenter Linked Mode.

902 (UDP) Used to send data to managed hosts.

902/903 Used by the vSphere Client to display virtual machine consoles.

5989 (TCP) CIM transaction traffic (Hardware Status).

8080 vCenter Management Webservices HTTP.

8443 Secure connection for vCenter Management Webservices HTTPS.

60099 Used to stream inventory object changes to SDK clients. Firewall rules for

this port on the vCenter Server can be set to block all, except from and to
localhosts if the clients are installed on the same host as the vCenter Server
service.
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Configure console options

You can specify a number of console options in the Console Options window that affect overall product behavior.
To access the Console Options window, select Tools > Console Options from the SQL Diagnostic Manager Console

toolbar.

The following tabs are available on the Console Options window:

Console Options

General . .
@ Configure console alert notifications.
Alerts

Motifications

Wwhen would you like to display conscle alert notifications?

() Aways show conzole alet notfications

(® Only show console alert notfications when a state transition occurs

(") Mever show console alert notifications
‘What alert statuses do you want to display?

(® Show all alert statuses
() Show Waming and Critical alerts
() Show Critical alerts only

When should SQLOM play sounds?

(® Foral console notifications

() Only for critical notifications

Preview

QK Cancel

General

The General tab allows you to set how often the console refreshes data, hide the Console when
minimized, select how SQL Diagnostic Manager manages chart data, choose what colors you want SQL

Diagnostic Manager to use, and enable the Baseline view.
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Alerts

The Alerts tab allows you to limit the number of historical alerts displayed in the Alerts view, which can
improve the performance of the view when there is a large number of alerts.

Notifications

The Notifications tab allows you to configure how SQL Diagnostic Manager notifies you when alert data
crosses a threshold.
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Define common properties

The options on the General tab represent the most common properties users can change in the SQL Diagnostic
Manager Console.

Access the Console Options window General tab

You can open the General tab of the Console Options window from the SQL Diagnostic Manager Console by
selecting Tools > Console Options. The General tab is available by default.

Set your refresh intervals

The Refresh Interval refers to the amount of time the SQL Diagnostic Manager Console waits before gathering data
from the SQL Diagnostic Manager Repository. There are two types of refreshes. Each type is associated with
different SQL Console components:

Server View Refresh

Refers to the amount of time the SQL Diagnostic Manager Console waits before refreshing the currently
active view. When you first open a view, the view is refreshed with the latest data SQL Diagnostic
Manager has collected directly from the monitored SQL Server instance. You may want to lower the
amount of time between refreshes if you are trying to diagnose a specific problem that requires a shorter
interval. The interval for this field is between one and 300 seconds.

Status and Alerts Refresh

Refers to the amount of time the SQL Diagnostic Manager Console waits before polling every monitored
SQL Server instance and displaying notification pop-ups, updating the monitored SQL Server instance
tree with status changes, and updating the SQLDM Today view with status changes. The interval for this
field is between one and 60 minutes.

Hide the desktop client

The Hide when minimized toggle determines whether SQL Diagnostic Manager displays as an active application in
your Windows taskbar. When you want to open your SQL Diagnostic Manager Console again, double-click the IDERA
SQL Diagnostic Manager icon in your taskbar. Enabling or disabling this option has no effect on data collection or
the refresh rate of your currently active view.

Use chart options
Chart options allow you to determine how much data is shown in your real-time charts. The entry in the Keep data
for the last field is always greater than the entry in the Show data for the last field.

Keep data for the last

Determines the length of time data is stored in the SQL Diagnostic Manager Repository.

Show data for the last

Determines the time period displayed in real-time charts.

Use a color scheme

The Color scheme field allows you to select the background color you prefer for the SQL Diagnostic Manager
Management Console. By default, the scheme is set to Black.
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Configure the Alerts view

The Alerts tab of the Console Options window allows you to enter the number of rows you want displayed in the
historical Alerts view. While this restriction limits the historical view, there is no limit to the number of rows used for
your active alerts. The default entry is 0, which does not limit the number of rows in your historical view.

Access the Console Options window Alerts tab

You can open the Alerts tab of the Console Options window from the SQLDM Console by selecting Tools > Console
Options, and then selecting the Alerts tab.
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Configure notification settings

The Notifications tab of the Console Options window allows you to configure when and how the SQL Diagnostic
Manager Console displays alert notifications. When you select an option to show notifications, SQL Diagnostic
Manager displays a pop-up notification in your task bar each time it reaches a threshold.

To see an example of a console alert, click Preview, and the alert pop-up appears as shown in the following image.

Console Options ? *

General

@ Configure console alert notifications.
Alerts

Maotifications

When would you like to display conscle alert notifications?

() AMways show console alert notifications
(®) Only show console alert notfications when a state transition occurs

() Never show console alert notifications
\what alert statuses do you want to display™

(®) Show all alert statuses
() Show Waming and Critical alerts
() Show Critical alets only

‘when should SQLOM play sounds?

(® Forall console notifications

() Only for critical notfications

Preview

QK Cancel

Access the Console Options window Notifications tab

You can open the Notifications tab of the Console Options window from the SQL Diagnostic Manager Console by
selecting Tools > Console Options, and then selecting the Notifications tab.

Selecting visual notifications

SQL Diagnostic Manager allows you to select when and for which alert states you receive alert notifications. You can
select from the following options regarding when you want SQL Diagnostic Manager to display notifications:
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Always show console alert notifications
Provides alert notifications occur after every refresh.

Only show console alert notifications when a state transition occurs
Limits the alert notifications you receive on refreshes to only those that change states.

Never show console alert notifications
Prevents the occurrence of all console notifications, but you continue to receive all email alerts. This
setting is dependent upon your particular needs and you can modify the alert at any point. If you receive
too many notifications, consider limiting notifications to occur only after an alert state transition.
However, if you monitor a problematic SQL Server and want to know when a threshold is met, consider
monitoring all alert states.

Select from the following options regarding which alert statuses trigger notifications:

Show all alert statuses
Display notifications for all alert state changes.

Show Warning and Critical alerts
Display notifications only when an event triggers a Warning or Critical alert.

Show Critical alerts only
Display notifications only when an event triggers a Critical alert.

Selecting audible notifications

The options in the When should SQL Diagnostic Manager play sounds section allow you to toggle whether you want
to hear an audible notification along with the alert in SQL Diagnostic Manager whenever an event triggers a critical
alert. The default For all console notifications option helps to let you know of any notification within SQL
Diagnostic Manager. Select Only for critical notifications and SQL Diagnostic Manager plays the audible
notification only when an event triggers a critical alert.
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Set your SQL Diagnostic Manager Repository grooming schedule

The Grooming Options window allows you to schedule and configure SQL Diagnostic Manager Repository
grooming. Grooming is the process of deleting metrics stored in the SQL Diagnostic Manager Repository that are
older than a given date and time. It is important to groom data from your Repository to optimize the performance
of processes such as report generation and data collection.

@ VYou can limit the amount of data stored in the SQL Diagnostic Manager Repository by lowering the number
of days data is stored. This is particularly important when monitoring a large number of servers or when
storing Query information at a low threshold.

Access the Grooming Options window
To open the Grooming Options window, select Tools > Grooming Options from the toolbar menu.

In the Grooming Options window you can set an specific hour or determine after how many hours you want to
groom your data and aggregate queries.

Also, you can define when your data should be groomed to save repository space, under the following options (in
days):

+ Groom standard metrics and baselines older than

« Groom Sessions, Queries, Deadlocks, Waits, and History Browser data older than
+ Groom inactive Alerts older than

+ Aggregate query data into daily records after

+ Groom Change Log data older than

« Groom Prescriptive Analysis data older than

« Aggregate forecasting data to daily records after

« Groom forecasting data older than
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Grooming Opticns ? >

& [epending on the amount of data collected, grooming can be a performance intensive operation. It is
L f.-' recommended that grooming be scheduled for a time when the repository is less active. This time is in the
= Repositorny's time zone.

The current time on the repository is 11/23/2018 10:48:34 AM.

Data Grooming Aggregation
Delete old data and perform table and index Combine older data into daily rall-up
maintenance. records to save space.

(® Oncedaiyat |0300AM - (® Once daily st |02:00 AM =

() Every 4 hours ) Every 4 hours

when should data be groomed to save repository space?

& The amount of data collected and stored by SGLOM can be large depending on the number of SGL
/.-' Server instances being monitored and how often data is collected. Use the following options to tailor data
= retention to your needs.

Groom standard metrics and baselines older than 1095 2| days
Groom Sessions, Queries, Deadlocks, Waits, 1 = 4

and History Browser data older than = ays
Groom inactive Alerts older than N days
Aggregate query data into daily records after 14 12 days
Groom Change Log data older than 30 2| days
Groom Prescriptive Analysis data older than 90 4| days
Aggregate forecasting data to daily records after 1095 £5-| days
Groom forecasting data older than 1095 5| days

\what is the current grooming status?

Data Grooming Aggregation
Cumenthy anning |N|:: | Cumenthy nunning |No |
Last completed at [11/23/2018 3.00.00 AM | Last completedat |11/23/2018 2:00:01 AM |
Completion status |5uc:n::eeded | Completion status |5uu:u:eeded |
Refresh
Groom Mow Aggregate Mow Cancel

The current grooming status is shown at the bottom of the Grooming Options window, it displays the current status
of the grooming and the aggregation actions. It also displays the date and time of the latest operation, and the
current completion status. Click Refresh to get the updated information of these actions at any time.

Click the options Groom Now and Aggregate Now located at the bottom of the Grooming Options window, to
perform these actions instantly.
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Use custom counters to track metrics

SQL Diagnostic Manager, by default, displays a wide variety of the most common SQL Server and Operating System
performance metrics. In addition to providing these common metrics, custom counters provide the ability to add
additional performance metrics to the SQL Diagnostic Manager Console used for historical trending, on-demand
monitoring, and schedule refresh alerting.

© Import or export a custom counter

In the IDERA community site you can share or import custom counters created by other SQL Diagnostic
Manager users.

You can find a list of operating system counters by searching for "Windows Performance Counters" on
technet.microsoft.com.

You can add the following types of metrics:

« AllWindows System Counters, including all Perfmon and WMI counters

« Any SQL Server System Counter stored in the sysperfinfo system table

« Any numerical value you would like to return from a custom SQL script

+ VM and host server performance counters accessible through the host Server

@ In addition to providing all of the above counters, you can add any additional counters contained in a new
Windows or SQL Server Service Pack. This allows you the flexibility to monitor any metric that is important
to your enterprise.

Access the Custom Counters view

To open the Custom Counters view, click Administration > Custom Counters from the navigation pane.

Administration « Custom Counters
= 3 Administration l Home

& Applcation Seruriy

L Ll | L ]
2 Custom Counters Eﬁg 8 | ;__.If 6 ,% agsf . Group By Box
3 £l v AT ). . AN
5 (Changelog - - e E
Add  Edit Deleie et Lirk {lmport Export

B, Import/Export

| |
| S

Getting Started with Custom Counters

Create a custom counter
To add a custom counter:

1. Select Administration in the navigation pane.

2. Select Custom Counters.

3. Ifthis is your first time to access this page, click Click here to add a new custom counter now. /f you
have accessed this page before, click Add.

4. Click Next on the Add Custom Counter wizard Welcome page.

Select a counter type, and then click Next.

6. Select the counter you want to monitor, and then click Next.

o
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Select the counter calculation type and scale factor, and then click Next.

Type a name for the custom counter, select a Category, add a Description, and then click Next.
Configure your alert settings related to the new custom counter, and then click Next.

Click Finish.

© v e

Using custom SQL scripts

Use custom SQL scripts to monitor metrics that are not connected to system or SQL counters, under-utilized
SQL 2005 DMVs, or metrics that are very specific to your environment, such as row count for a production table.

O soL Diagnostic Manager does not scrub custom SQL batches for SQL Injection protection. Use caution
when entering custom SQL scripts as it is an advanced feature. The go command is not a Transact-
SQL statement and you cannot use this command in custom SQL batches. The go command is a batch
separator for Management Studio, Query Analyzer, sqlcmb, and osql.

Locate your custom counters

Custom counters appear in the following places in the SQL Diagnostic Manager Console:

Alert Configuration window

Your new custom counters appear in the Alert Configuration and the Default Alert Configuration
windows in the Custom category. You can edit the alert thresholds, and even decide whether you want
an alert associated with the new counter.

Server Details view

The Server Details view lists all the metrics monitored by SQL Diagnostic Manager, including all your new
custom counters. You can filter this view to display only your custom counters by selecting the Custom
Counters radio-button in the Filter ribbon. You can access this window by selecting details on the Server
view or by double-clicking Custom Counters in the Servers tree.

Custom Counters table

SQL Diagnostic Manager provides a list of all your custom counters in the Custom Counters table on the
Administration window. In addition to viewing a list of custom counters, you can add a new counter, edit
a counter, delete a counter, test a counter, or link a counter to a SQL Server instance for monitoring.
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Add a custom counter

Custom counters are Windows Operating System or SQL Server metrics that are not monitored, by default, by SQL
Diagnostic Manager. In addition to Windows Operating System and SQL Server metrics, you can enter T-SQL scripts
to monitor any variable in your environment or select from a list of virtualization performance counters if you have
monitored servers hosted on a virtual machine. Once added to the SQL Diagnostic Manager interface, you can
monitor the results, view historical trending of the metric, configure alerts and receive notifications on them, and
generate reports based on collected data.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.
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Select counter type

The Select Counter Type window of the Add Custom Counter wizard allows you to choose the method you want SQL

Diagnostic Manager to use when collecting the counter. SQL Diagnostic Manager offers the following counter types:
Windows System Counter

Select this option to pick from counters that include both those available in Windows System
Performance Monitor (PerfMon) and Windows Management Instrumentation (WMI) performance counter

types.
SQL Server System Counter

Select this option to pick from counters that are gathered via standard T-SQL from SQL Server.

Custom SQL Script

Select this option to enter a custom T-SQL script to monitor variables such as those which are not
connected to the operating system or SQL Server counters or metrics that are very specific to your
environment such as a row count on a particular production table. Note that your script must return a
single numeric value.

Virtual Machine Counter

Select this option to pick from counters collected using an API from VMware or Hyper-V.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.
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Select Windows system counter

The Select Windows System Counter window of the Add Custom Counter wizard allows you to select the counter
you want from a list populated from those currently available on an existing monitored SQL Server instance, or you
can enter the counter information manually.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.

Select a counter from the list

As you select from a populated list from those currently available on an existing monitored SQL Server instance, the
next drop-down list populates (filtered by your selection). This allows you to quickly find the specific counter you
want to add to SQL Diagnostic Manager.

1. Select whether you want to populate the list with counters that are contained in PerfMon, or populate it with
every WMI counter.

Pick the SQL Server instance to populate counter information from the drop-down list.

Select the object name from the drop-down list.

Select the name of the specific counter you want to add from the drop-down list.

Select the instance from the drop-down list. The instance name is used to distinguish objects of a given type.
For example, _Total refers to all instances, a drive letter such as C: for a specific disk drive, or the name of an
application.

ol wn

@ Click the Details button for information on the object name and counter name you have selected.

Manually add a counter

If you have the counter information available, you can enter the information quickly by simply pasting or typing the
Object Name, Counter Name, and Instance name into their associated fields. The counter information entered must
be the exact complicated name or the counter does not work correctly.

For example, to enter the Processor object name (as seen in PerfMon), use the following programmatic name entry
depending on the system configuration:

Win32_PerfFormattedData_PerfOS_Processor

@ You can find custom counter programmatic names on Microsoft TechNet.
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Enable SQL Diagnostic Manager Performance counters
Follow these steps to enable SQL Diagnostic Manager Performance Counters:

1. Gotothe SQLDM installation folder path: C:\Program Files\Idera\ldera SQLdiagnostic manager

2. Open SQLdmManagementService.exe or SQLdmCollectionService.exe as Administrator (depending on
which SQLDM Performance Counters you want to enable)

3. Edititand add the following parameter: publishPerformanceCounters="true” , restart the services.

Review the following examples:

SQLdmCollectionService.exe

<configuration>
<Idera.SQLdm>
<Services>

<CollectionService
instanceName="Default" managementServiceAddress="ServerName"
publishPerformanceCounters="true"/>

</Services>
</Idera.SQLdm>
</configuration>

SQLdmManagementService.exe

<configuration>
<Idera.SQLdm>
<Services>

<ManagementService instanceName="Default"
repositoryServer="SQLInstanceName\Name"

servicePort="5166" repositoryDatabase="SQLdmRepositoryName"
publishPerformanceCounters="true"/>

</Services>

</Idera.SQLdm>
</configuration>

& fyou no longer want to publish the SQLDM Performance Counters, set the parameter as follows
publishPerformanceCounters="false” or delete the property from the configuration and restart the services.

(® Review the available internal SQLDM PerfMon counters list for the SQLdmManagementService and
SQLdmCollectionService: Internal SQLDM perfmon counters.
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Add custom counter alerts
Follow these steps to add internal SQLDM performance custom counter alerts:

1. Go tothe Administration tab in the SQL Diagnostic Manager desktop and select Custom Counters.
Click Add to start configuring the custom counter.
In the Welcome screen of the Custom counter Wizard click Next.
Select the Windows System Counter type, and click Next.
Under the Select Windows System Counter screen, select the Select a counter from an existing monitored
SQL Server host (Recommended) and in the Select Counter check the Show only those counters available
in Windows System Performance Monitor (Perfmon) (Recommended) option.
a. Inthe SQL Server drop down list, select the SQL Server instance where you would like to add the
custom counter.
b. Inthe Object Name field, select the SQLdmCollectionService or SQLdmManagementService option to
retrieve the internal counters.
c. Choose the counter you preferred from the Counter Name drop down list and click Next. Review the
list of Internal SQLDM perfmon counters.
d. Select an instance or the instances if applied.
e. Click Next.

ol wn

6. Under the Customize Counter Value screen, choose the Calculation Type by selecting either the Use
collected value or the Use per second value since last collection (By default, the value for a custom counter
is interpreted as the value collected). Also, Customize the Scale Factor by selecting the value from the drop
down list.

a. After configuring the values Click Test... to open the Test Custom counter window.

b. Inthe Test custom Counter window, select the instances to test the custom counter that is being
configured, and click Test. You can review the result of the test under the Result column.

c. Click Done.

7. Under the Customize Counter Definition step, type a name for the counter. By default, these counters are
under the Custom Category but you can select an existing category or enter a category of your own. Click
Next.

8. Under the Configure Alert Settings screen, select how your counter value should be evaluated for alerting:
Higher values are worse than lower values or Lower values are worse than higher values .

a. Configure your Alert Thresholds, the values you provide for Informational, Warning, and Critical
Thresholds are used as defaults and can be customized for each monitored instance.

© When you click Advanced, you can generate choose to generate an alert or not when the value for the
custom counter fails to be collected.

b. Check the box to enable the counter alert by default when is linked to a monitored SQL Server. Click
Next.

9. In the Completing the Custom Counter Wizard screen, click Finish to complete the configuration of your
custom counter.

When you complete the Custom Counter configuration, the "Would you like to link your counter to monitored SQL
Server instances now?" message pops up, select Yes or No to continue:

« If you click Yes, the Link Custom Counter window opens. This window includes the Counter Summary
information and the Linked Servers, you can select a SQLDM tag or specific monitored SQL Server instances,
when you complete the configuration of the linked servers click OK.
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Internal SQLDM perfmon counters
SQLdmManagementService Counters
+ Active Workers
+ Avg. Task Time
» Blocking Statistics inserts/sec
» Blocking Statistics sec/insert
« Custom Statistics inserts/sec
« Custom Statistics sec/insert
« Database Statistics inserts/sec
« Database Stats sec/insert
« Deadlock inserts/sec
« Deadlock sec/insert
« Disk Statistics inserts/sec
« Disk Statistics sec/insert
« ESX Config Data Statistics inserts/sec
« ESX Config Data Statistics sec/insert
« ESX Statistics inserts/sec
« ESX Statistics sec/insert
«+ Lock Statistics inserts/sec
« Lock Statistics sec/insert
« Mirror Participants grooming ops/sec
« Mirror Participants grooming sec/op
» Mirror Preferred Config ops/sec
+ Mirror Preferred Config sec/op
« Mirror Replication Topology ops/sec
+ Mirror Replication Topology sec/op
+ Mirroring Statistics inserts/sec
« Mirroring Statistics sec/insert
« OS Statistics inserts/sec
« OS Statistics sec/insert
+ Query Monitor Statistics inserts/sec
« Query Monitor Statistics sec/insert
« Query Wait Statistics inserts/sec
« Query Wait Statistics sec/insert
+ Replication topology distributor inserts/sec
» Replication topology distributor sec/insert
» Replication topology inserts/sec
» Replication topology sec/insert
» Replication topology subscriber inserts/sec
» Replication topology subscriber sec/insert
« Server Statistics inserts/sec
« Server Stats sec/insert
« Session And Locks Statistics inserts/sec
« Session And Locks Statistics sec/insert
+ Task Queue Length
« Tasks Queued/sec
» Temp Database File inserts/sec
» Temp Database File sec/insert
» VM Config Data Statistics inserts/sec
» VM Config Data Statistics sec/insert
« VM Statistics inserts/sec
« VM Statistics sec/insert
« Wait Statistics Details inserts/sec
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« Wait Statistics Details written/sec
« Wait Statistics inserts/sec

« Wait Statistics written/sec

+ Wait Type Statistics inserts/sec

« Wait Type Statistics written/sec

+ Waiting Workers

SQLdmCollectionServiceSDefault

« #Monitores Servers

« #Servers in Maintenance Mode
« Active Workers

+ Avg.Task Time

+ Task Queue Length

« Tasks Queued/sec

+ WaitingWorkers

SQLdmCollectionService$SDefaultSPERINSTANCE
« #Alerts Raised
« #Databases
« #Dropped Scheduled Refreshes
« #Failed Collections
+ #Query Monitor Statements
« #Queued Scheduled Refreshes
« #Wait Statistic Statements
« Collection Run Time
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Select SQL Server system counters

The Select SQL Server System Counter window of the Add Custom Counter wizard allows you to manually enter
counter information or select counters from a list populated from those currently available on an existing
monitored SQL Server.

If you have the counter information available, you can enter the information quickly by simply pasting or typing the
Object Name, Counter Name, and Instance name into their associated fields. The counter information entered
must be exact or the counter does not work correctly.

To select a SQL Server system counter:

1. Select the appropriate SQL Server instance from the drop-down list.

2. Select the object name.

3. Select the name of the specific counter you want to add.

4. Select the instance, if applicable. The instance name is what distinguishes it from other similar objects.

If no counters appear in the drop-down list, either the counters are not installed or they are disabled, possibly by a
recent Windows Service Pack.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.

How to calculate this metric

For more information about the algorithm used to calculate a specific metric, see SQL Diagnostic Manager cannot
load the performance counters needed for the statistics view pane - Solution #00000133 IDERA Solution available at
the Customer Support Portal.

Understand why the SQL Server counter grows
Many SQL Server counter values start at zero when a server starts and then grow persistently from there, including
most of the values in the sysperfinfo system table.

For example, the Buffer Manager Page Lookups/Sec counter in the value collected mode always shows the total
number of page lookups since the server was first started, while when in the value per second mode, it shows the
number of lookups per second during the monitored period.

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 197


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw
http://wiki.idera.com/x/QAA1

SQL Diagnostic Manager for SQL Server

Provide custom SQL script

The Provide Custom SQL Script window of the Add Custom Counter wizard allows you to enter or paste a T-SQL
script for your custom counter. For more information about T-SQL scripts, see SQL Server Books Online.

Refer to the following tips when using custom SQL Scripts:

Dangerous or destructive T-SQL that is entered as a custom counter is executed as entered, which could
result in a negative impact on the linked monitored SQL Server instances.
The go command is not a Transact-SQL statement and you cannot use this command in custom SQL
batches. The go command is a batch separator for Management Studio, Query Analyzer, sqlcmd, and osql.
Custom counter scripts run at every scheduled refresh and on-demand on the Custom Counters view. For
best performance, custom scripts should run in under 30 seconds. If the script takes longer than two
minutes to execute, timeouts may occur.
Custom SQL scripts must return a single result set with a single numeric field. Additional fields or non-
numeric values result in an error.
Custom SQL scripts are displayed in Queries tab with "User Defined Counter" in their application name.
The following options are set by default for custom counter scripts. If you need to use a different value,
particularly another transaction isolation level, you should add the appropriate SET statement to the
beginning of the script.

* set transaction isolation level read uncommitted

« set lock_timeout 20000

e set dimplicit_transactions off

+ set language us_english

e set cursor_close_on_commit off

+ set query_governor_cost_limit 0

e set numeric_roundabort off

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.
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Select virtual machine system counter

The Select Virtual Machine System Counter window of the Add Custom Counter wizard allows you to select the
counter you want from a list populated by those counters currently available on an existing monitored SQL Server
host server, or you can enter the counter information manually.

@ You can select virtual machine counters for both the Hyper-V and VMware server virtualization platforms.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.

Select the counter from the list
As you select from a populated list from those currently available on an existing monitored SQL Server host, the
next drop-down list populates (filtered by your selection). This allows you to quickly find the specific counter you

want to add to SQL Diagnostic Manager.
Add Custom Counter [ I

Select Windows System Counter _;
Select the Windows System Counter you would like to monitar

® Select a counter from an exdsting monitored SOL Server host (Recommended)
() Manually enter counter corfiguration

Select Counter

(@ Show only those courters available in Windows System Peformance Manitor {Pefmon) (Recommended)

) Show all Windows Management Instrumentation (WMI) counters

SOL Sever: | SIDROCIDO! v|
Ohbject Name: | Physical Cisk b |
Counter Mame: | £ Select a counter = o
M < Select a counter >

Instance Name: |3 Dk Read Time

% Diske Time

i Disk Write Time

% Idle Time

Aurg. Disk Bytes/Fead

Awg. Disk Bytes/Transfer
Auvg. Disk BytesWWrite

Aurg. Disk Queus Length

Awg. Disk Read Queue Length
Avg. Disk sec/Read

Awg. Disk sec/Transfer

Auvg. Disk sec/Write

Aurg. Disk Wiite Queue Length
_|Current Disk Queue Length
Clisk Bytes/sec

ik Read Bytes/sec

Dk Reads/zec E
Disk Transfers/szec
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Pick the monitored SQL Server instance to populate counter information from the drop-down list.

Select the object name from the drop-down list.

Select the name of the specific counter you want to add from the drop-down list.

Select the instance (if applicable) from the drop-down list. The instance name is what distinguishes it from
other similar objects.

bk N =

Add a counter manually

If you have the counter information available, you can enter the information quickly by selecting Manually enter
counter configuration, and then simply pasting or typing the name of the object, counter, and SQL Server instance
into the associated fields. The counter information entered must be exact or the counter does not work correctly.
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Specify counter value

The Custom Counter Value window of the Add Custom Counter wizard allows you to select the type of calculation
used by your counter and set a scale factor so that your counter information displays values in their correct format.
While the Scale drop-down list displays the same scale factors available in PerfMon, you can also type in a custom
scale factor to use.
Custom Calculation Type
Choose to either have your counter display the value collected or calculate the value per second
between refreshes.
Customize Scale Factor

Select a custom scale to convert the value into a more manageable number.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.

Scale factor examples
The following table covers some conversion factors that allows you to precisely convert common units:

Collected Value Desired Value Scale Factor
Kilobyte Byte 1024
Megabyte Byte 1048576
Megabyte Kilobyte 1024
Gigabyte Kilobyte 1048576
Terabyte Megabyte 1048576
Terabyte Gigabyte 1024

Byte Kilobyte 0.0009765625
Byte Megabyte 0.000000953674316
Kilobyte Megabyte 0.0009765625
Kilobyte Gigabyte 0.0009765625
Megabyte Gigabyte 0.0009765625
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Collected Value

Megabyte

Gigabyte

Kilobyte

Megabyte

Gigabyte

SQL Server Page

SQL Server page

SQL Server Page

Kilobyte

Megabyte

Gigabyte

SQL Server Extent

SQL Server Extent

SQL Server Extent

Desired Value

Terabyte

Terabyte

SQL Server Page

SQL Server Page

SQL Server Page

Kilobyte

Megabyte

Gigabyte

SQL Server Extent

SQL Server Extent

SQL Server Extent

Kilobyte

Megabyte

Gigabyte

Scale Factor

0.000000953674316

0.0009765625

0.125

128

131072

0.007813

0.000007629395

0.015625

16

16384

64

0.0625

0.000061035156
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Specify counter definition

The Customize Counter Definition window of the Add Custom Counter wizard is where you name, assign to a
category, and enter a description of your new custom counter. The information entered on the Custom Counter
Definition window appears in various places in the SQL Diagnostic Manager interface.

© You cannot change the name or category of a counter once you create it.

Name

The name you give your new custom counter is the most important way to distinguish your custom
counters. You should give them a name that directly relates to the information monitored.

Category

The category you assign to your new custom counter is important for organizing your custom counters, if
you have many, on the Custom Counters window and on the Alert Configuration window.

Description

The description you give your custom counter is an important way of distinguishing your custom
counters if the name you give them does not provide enough of a difference.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.
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Configure alert settings for this counter

The Configure Alert Settings window of the Add Custom Counter wizard allows you to configure how SQL Diagnostic
Manager uses and monitors your new custom counter information.

Configure Alert Evaluation

This option allows you configure whether lower values are worse than higher values such as the percent
of free disk space on a drive, or higher values are worse than lower values such as the percentage of free
memory used.

Configure Alert Thresholds

The informational, warning, and critical thresholds you enter dictate the values that trigger alerts. Once
configured, you can change these values on the Alert Configuration window.

Access the Add Custom Counter wizard

You can open the Add Custom Counter wizard by clicking Administration > Custom Counters, and then clicking
Add in the Custom Counters view.

Configure a custom response when SQL Diagnostic Manager generates an alert
SQL Diagnostic Manager allows you to configure when and how alerts generate responses. You can select from the
following alert responses (providers):

+ Send an email to a person or group of people

+ Logan eventin the Windows Event Log

« Enable the Query Monitor

+ Execute a program or utility

+ Send an event to your Network Management tool
+ Execute a SQL Agent Job

« Execute a Script

To configure a custom response when an alert is generated, select Tools > Alert Actions and Responses from the
console toolbar.

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 204


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw

SQL Diagnostic Manager for SQL Server

Edit a custom counter

The Edit Custom Counter wizard allows you to edit your custom counter settings. To edit a custom counter, select
the counter from the list on the Custom Counters window and click the Edit button.

& You cannot change the custom counter name and category once you create a Counter.
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Delete a custom counter

Deleting a custom counter from SQL Diagnostic Manager removes it from the interface and stops collection. Select a
custom counter on the Custom Counters window and click Delete to remove it from SQL Diagnostic Manager.
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Import a custom counter

Custom counters are Windows Operating System or SQL Server metrics that are not monitored, by default, by SQL
Diagnostic Manager. You can import already created custom counters from the IDERA community site through the
Custom Counter Import Wizard. Once added to the SQL Diagnostic Manager interface, you can monitor the results,
view historical trending of the metric, configure alerts and receive notifications on them, and generate reports

based on collected data.

To import a custom counter:

1. Open the Custom Counter Import Wizard by clicking Administration > Custom Counters, and then
clicking Import in the Custom Counters view.

2 Import Custom Counter ? >

Welcome to the Custom Counter Import Wizard

The Custom Counter Import wizard helps to import already defined (or saved}
custom counters for monitoring by SCGL diagnostic manager.

a.‘

Back et Cancel

2. Onthe Welcome to the Custom Counter Import page, click Next.

© You can also access the Custom Counter import wizard by clicking Administration > Import/
Export from the navigation pane and selecting Custom Counter in the import column.

3. Onthe Select custom counters to import page, browse for custom counters' XML files to import.
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4. On the Summary of imported custom counters page, you can verify that the selected counters were
imported correctly or if there are any errors you can view details by clicking View validation errors or
review any steps by clicking Back.

5. Click Finish to import the valid custom counters and exit the wizard.

© Export a custom counter

For instructions on exporting a custom counter, see Export a custom counter.
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Export a custom counter

SQL Diagnostic Manager for SQL Server

Custom counters are Windows Operating System or SQL Server metrics that are not monitored, by default, by SQL
Diagnostic Manager. You can export and share already created custom counters in the IDERA community site
through the Actions group on the Home tab or through the Import/Export wizard.

To export a custom counter:

1.

2
3.
4

o

Select Administration in the navigation pane.
. Select Custom Counters.
Select the custom counter you wish to export from the list and click Export in the Actions group.

. Inthe Browse For Folder dialog box, indicate in which folder you want to save the custom counter XML

file.

In the "Selected custom counters exported to the selected directory" notification, click OK.

© Import a custom counter

For instructions on importing a custom counter, see Import a custom counter.

To export all your custom counters:

1. Select Administration > Import/Export and click Custom Counter in the export column.

2.

Import Export Wizard

The import/export wizard allows you to import or export alert templates, elert responses, custom reports and custom counters.

Import
| Alert Templafe
| Alert Response
| Custom Report

| Custom Counter

Export
Alert Template
Alert Response
Custom Report

Custom Counter

In the Browse For Folder dialog box, indicate in which folder you want to save the custom counters

XML files.
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3. Click OKin the "Custom counters exported to selected directory" notification.
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Test a custom counter

The Test Custom Counter window allows you to verify that the custom counter is what you want to collect on the
SQL Server instances you have linked it to and that the value returned is the value expected. A successful test
displays the value of the metric collected, while a failed test provides the associated failure details.

@ Common causes for failed custom counter tests include inaccurate counter information entered manually
and counters that do not exist on a particular SQL Server instance.
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Link custom counter to monitored instance

The Link Custom Counter window allows you to select the monitored SQL Server instances upon which you want
your custom counter to appear. Select Server tags from the Tags drop-down list or choose New tag from the list.

Use the Add and Remove buttons to select the SQL Server instances to link to your custom counter and click OK to
save your changes.

Automatically add a custom counter to a new registered SQL Server instance

Yes. By using links and tags, you can set SQL Diagnostic Manager to automatically add any custom counter to a
newly-registered SQL Server instance.

To set SQL Diagnostic Manager to automatically add a customer counter to a new registered SQL Server
instance:

1. Create a custom counter orimport a custom counter if the appropriate counter does not exist.

2. Create a tag if the appropriate tag does not exist.
3. Link a custom counter to a tag by selecting the custom counter, and then clicking Link. You can include

more than one custom counter per tag.
4. Select the tag you want to use, and then click OK. The custom counter is now associated with the tag.

5. Select the tag you just linked when adding a new SQL Server instance.
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Work with tags

Tags are customizable labels that allow you to organize and view your monitored resources in a manner best suited
to your needs. You can assign tags to monitored SQL Server instances, custom counters, and permissions.

By creating and assigning tags to different objects, you can better manage how SQL Diagnostic Manager presents
information. For example, you may create an "Accounting" tag for all SQL Server instances used by the Accounting

department. You could then copy alert configuration and assign custom counters and permissions to all the
instances labeled "Accounting."

Tags are also accessible to all users. This gives you greater freedom, allowing users to work with the same tags
across all SQL Diagnostic Manager consoles.
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Manage tags

The Manage tags window allows you to Add, Edit, and Remove Tags. For more information on tags and their
functionality, see Working with tags.

& Thiswindow is available only to SQL Diagnostic Manager Administrators.

The Manage Tags window shows a list of all existing tags. From here, you can:

+ Modify the list of servers, custom counters, and permissions associated with a tag.
« Create anew tag.
« Edit an existing tag.
+ Remove a tag (Removing a tag does not delete items associated with that tag).
Access the Manage Tags window
To access the Manage Tags window:

1. Select File.
2. Select Manage Tags.
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Add a new tag

The Add Tag window allows you to create and assign a tag while adding an instance. Tags are labels that allow you
to organize server instances into meaningful groups.

Tags are customizable for your needs. For example, you may want to view only server instances used by a particular
department, in a specific location, or by some other method, such as SQL Server version. You can assign multiple
tags to each instance so that the instance appears in several different groups.

You may select one or more existing tags from the list, or create new ones by clicking Add Tag.
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Edit atag
The Tag Properties window allows you to view and change the properties of an existing Tag. To access the Tag
Properties window, right-click a Tag and select Tag Properties.

The following information is available and editable in the Tag Properties window:

Servers
The Servers tab lists the SQL Server instances monitored by SQL Diagnostic Manager and allows you to
select or deselect the serversincluded in the tag.

Custom Counters
The Custom Counters tab allows you to choose the custom counters you want to include in your tag.

Application Security
The Application security tab allows you to select the application security permissions you want to apply

to your tag.
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User creation scripts

SQL Diagnostic Manager allows you to monitor SQL Server instances without SysAdmin rights. However, these
lowered permissions limit the availability of data.

The user creation scripts are detailed, as follows:

« Minimum permissions on premises
« Recommended permissions on premises

Minimum permissions on premises

SQL Diagnostic Manager now includes a SQL script to create new user with minimum permissions necessary for the
product to function

1.

2.

Use the Find/Replace function to locate and replace all references of 'SQLdmCollectionUser' with the SQL
user that is being used for monitoring the SQL Server instance.

Connect to the SQL Server that you want to monitor with Admin user and run this script to create the SQL
user with the minimum permissions required to view the data on most of the screens of the application.
Find the MinimumPermissionsOnPremises.sql script below:

File Modified

ﬂ MinimumPermissionsOnPremises.sql Aug 16,2018 by IDERA

Recommended permissions on premises

SQL Diagnostic Manager also includes a SQL script to create new user with minimum permissions necessary for the
product to function.

1.

2.

Use the Find/Replace function to locate and replace all references of 'SQLdmCollectionUser' with the SQL
user that is being used for monitoring the SQL Server instance.

Connect to the SQL Server that you want to monitor with Admin user and run this script to create the SQL
user with the recommended permissions to view the data on most of the screens of the application.

Find the RecommendedPermissionsOnPremises.sql script below:

File Modified

n RecommendedPermissionsOnPremises.sql Aug 16,2018 by IDERA

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 217


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw
http://wiki.idera.com/download/attachments/101056718/MinimumPermissionsOnPremises.sql?api=v2
http://wiki.idera.com/display/~whermosa
http://wiki.idera.com/download/attachments/101056718/RecommendedPermissionsOnPremises.sql?api=v2
http://wiki.idera.com/display/~whermosa

SQL Diagnostic Manager for SQL Server

Navigate the IDERA Dashboard

The IDERA Dashboard is a common technology framework designed to support the entire IDERA product suite. The
IDERA Dashboard allows users to get an overview of the status of their SQL Servers and hosted databases all in a
consolidated view, while providing users the means to drill into individual product dashboards for details. It also
includes widgets that consolidate data across the products and supports multiple copies of SQL Diagnostic
Manager installations. For more information, please review the Manage the IDERA Dashboard.

The Administration view of the IDERA Dashboard provides a central set of services related to specific actions,

register SQL Diagnostic Manager in the IDERA Dashboard review the Register SQL Diagnostic Manager in the IDERA
Dashboard.
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Register SQL Diagnostic Manager in the IDERA Dashboard

The IDERA Dashboard hosts IDERA products that register with the Dashboard. Click the Manage Products option in
the Administration view to open the respective window.

In the Manage Products window you can perform the following actions on registered products:

Edit a Product

To edit a product, select it from the Products list. The Dashboard displays the settings for the selected product on
the panel to the right. Make the necessary modifications and click Save.

MANAGE PRODUCTS

WMegiiter s Prodact

Product Version, Meglanered. oA Creceniials

2 Tetal Preducts 15 2 perpage 4 1 e

Delete a Product

To remove a product, select it from the Products list and click Delete on the panel to the right. A confirmation
dialog displays; click Yes to remove or No to cancel.

© Ifyou want to uninstall the IDERA Dashboard, make sure to delete all registered products before
uninstalling.

Migrate Product

Allows you to migrate the registered product to a different IDERA Dashboard. Select the product from the Products
list and click Migrate product.
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MIGRATE TO DIFFERENT IDERA DASHBOARD X

Host:

Port: 97937

Dashboard Administrator:

Usermame:

Password :

Fillin the requested information and click Migrate.

Register SQL Diagnostic Manager

Register SQL Diagnostic Manager in your IDERA Dashboard. Click Register a Product to display the configuration
settings.

When the Register a Product to IDERA Dashboard window displays, first select the product installation location
(Local or Remote) and fill out the information as follows:
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Local Remote
1. Inthe Product field enter the product name, 1. Enter the Host name or IP Address.
SQLdm (As it shows in the image below). 2. Inthe Host User Name and Host Password, enter
2. Inthe Display Name field enter any name you the requested information.
want. Choose a unique display name to help you 3. Inthe Product Information,type the Product
distinguish different instances of the same name: SQLdm.
product. 4. Inthe Display Name field enter any name you
3. Enterthe Port number used by SQLdm Rest want. Choose a unique display name to help you
Service. By default, the port number is 5170. distinguish different instances of the same
4. Under Product Administrator enter your product.
credentials. 5. Enter the Port number used by SQLdm Rest
5. Type all the requested information and click Regis Service. By default, the port number is 5170.
ter. 6. Under Product Administrator enter your

credentials, and click Register.

Register a Product o IDERA Dashboard

Product Install Location . "
Register a Product to IDERA Dashboard

Where is it installa: @ locsl () Remote
Product install Location
Product Information
Where isitinstalled: ! local @ HRemote
Py t S0Ldm b
Host {Machine or IP address):
Display Mame ; o
Por 5170 Haost User Name

Product Administrater Credentials Hast Password:

User Mame: WIZRZ Administrator Product Information

Pazsword: | sessssssss Product: SQLdm v
Display Name : @ dm
Port 5170

Product Administrator Credentials

User Mame: W1ZRZ\Administrator

Cancel Register

Pacsword 00000 essssssss

(® SQL Diagnostic Manager is unregistered from the IDERA Dashboard when you uninstall it.
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Navigate the web console dashboard

The SQLDM web console interface boasts an easy-to-navigate dashboard comprised of several views, sub-views,
tabs, and widgets that provide a complete synopsis of your SQL Diagnostic Manager environment. Click the image
to view full size.

F IDERAINFODEVwhermosa | &% Administration | [H Help

On the dashboard you can find the following sections:

+ Views by Status, Tags, or Critical Instances
« List, thumbnail and heatmap sub-views

« Top X Lists tab

+ Alertstab

+ Custom Dashboards tab

Additional options

Search

In the SQL Diagnostic Manager web console dashboard, you can search for a particular instance by
name. Use the percent (%) wildcard character if you do not remember the full name of the instance that
you are looking for.

Heatmap Calculation Configuration

The ﬁ icon, located next to the search instances option, allows you to configure the scale factors to
calculate the health index displayed in the heatmap.

Refresh

The Refresh button allows you to manually refresh displayed data.
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Use views to get an overview of your environment

In the Views section of the home tab you can see at a glance if there are any problems in your monitored SQL Server
instances and drill-down for details. Each view is expandable and information is grouped By Status, By Tags, or by
Most Critical Instances. SQL Diagnostic Manager displays this information in the panel to the right.

By Status
In the By Status view you can easily identify the status of your monitored SQL Server instances and take action.
Instances are grouped as follows:

« All Instances

. . Critical
. . Successful
. ﬂ Warning

. Maintenance Mode

If you select all instances with an OK status in the By Status view, the panel displays information only pertaining to
those instances.

By Tags

In the By Tags view, you can view the status of different tags or group of instances, and drill-down to details. For
additional information on tags, see Work with tags.

By Most Critical Instances

The Most Critical Instances view lists all the critical SQL servers in your environment and provides links to the single
instance dashboard so you can quickly review the issue. The instance with the largest number of alerts shows up at
the top of the list.

If you click any of the listed critical instances, the web console displays the single instance dashboard.
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Use sub-views to identify and diagnose issues

The web console's main dashboard is comprised of three main sub-views:

« List sub-view
o Thumbnail sub-view
« Heatmap sub-view

These sub-views display all data collected at the last refresh for all your monitored SQL Server instances. To access
any sub-view, click the appropriate button in the upper-right corner of the dashboard as shown in the following
image:

R
[ ||| e wir
[pmemessss | igan | | provmesass | s

List sub-view

The list sub-view offers a means to quickly identify the status of instances, as well as the possibility to navigate to
the single instance dashboard when clicking on a specific row.

ALL INSTANCES (3) Grouphby  -GrolpBy- ¥ — EEE Mm & o
i - Q
SwA | instance tiame. Hesith e [chu Me. Yo | omt.|boss [Qu. [veson smws [ agenesms | orcswus | avelel
000 B O (] ] [ (] 14,0.1000.1 Running A Running 52191
SIDROLTS] 4 ® srs0n A © @ o L] [ L] Funning UnableTaM...
SIDRDCTSTHNSOL2014 o aysom A ¢ ¢ o L] o o 12020008  Running UnablieToM..  UnableTaM...

The list sub-view provides you with the following SQL Server information:

SWA
Displays the SWA icon when the instance is registered in SQL Workload Analysis.

Instance Name

Displays the name of the monitored SQL Server instance.

Health

Displays the health index in percentage in a red square.
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Alert

Displays the current severity of the value of the instance.

CPU, Memory, I/O, Database, Logs, and Queries

Displays the overall health index icon for each option.

SQL Server Version

Displays the edition and version of SQL Server software used in this instance.

SQL Server Status

Displays the status of the SQL Server service such as running, stopped, and paused.

SQL Agent Status

Displays the status of the SQL Server Agent service such as running or stopped.

DTC Status

Displays the status of the Distributed Transaction Coordinator service such as running or stopped.

Available Memory (MB)

Indicates how much available memory is allocated for SQL Server.

Blocked Sessions

Displays blocked process sessions information on the SQL Server instance.

CPU Activity

Displays the percentage of CPU consumed by your SQL Server, virtual machine, and host server.

Disk Queue Length

Displays the average number of system requests that are waiting for disk access on the computer hosting the
SQL Server instance

Actions

Sort

Instances on the list sub-view are sorted by severity. To re-organize information, click a column header or
select the option to group by severity, tags, or SQLdmRepo (Group By).

Search Instance

Type the name of the instance you are looking for.

IDERA Website | Products | Buy | Support | Community | About Us | Resources | Legal 225


http://www.idera.com
http://www.idera.com/productssolutions/sqlserver
https://www.idera.com/buynow/onlinestore
http://idera.force.com
http://community.idera.com
http://www.idera.com/about/aboutus
http://www.idera.com/resourcecentral
http://wiki.idera.com/x/l4DJAw

Options

Choose the columns to display in the list view.

SQL Diagnostic Manager for SQL Server

The Dashboard console has a new alert grid and custom filters that help you organize the list columns in your most

convenient way. Click the 4 icon located next to the column name to expand the drop down menu. This menu
allows you to sort your criteria by Sort Ascending or Sort Descending, you can remove or add columns, lock and

unlock, and group the information by fields.
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Thumbnail sub-view

The thumbnail sub-view is the default view in the SQL Diagnostic Manager web console's dashboard and provides
you with a graphical replication of your monitored SQL servers. Access additional details in the single instance
dashboard by clicking on a thumbnail’s instance name or easily spot categories that have active alerts as marked by
a critical icon. Navigate to an instance’s specific category view in case it has active alerts by clicking on the marked
category icon. You can also launch the SQL Diagnostic Manager console directly from the thumbnail sub-view by

clicking the SQL Diagnostic Managericon L
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The thumbnail sub-view displays basic statistics about your SQL Servers:

SQL Server version

Displays the edition and version of SQL Server software used in this instance.

Response Time

Refers to the time it takes for a query to go from the SQL Diagnostic Manager Console to the SQL Server
instance and back.

User Sessions

Refers to the total number of SQL Server user sessions.

SQL CPU Usage

Refers to average percentage of SQL Server processor usage on the computer hosting the SQL Server instance.

SQL Memory Usage

Refers to amount of memory in use by the monitored SQL Server instance.

SQL Disk I/O

Refers to the number of physical reads and physical writes made by the SQL Server instance between
refreshes.

In addition, the thumbnail sub-view includes CPU, Memory, I/0, and Response Time sparkline graphs for a 1 hour-
view so that users can obtain an overview of key metrics quickly.
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SQL Diagnostic Manager for SQL Server
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